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Bio-Rad Tech support nordic:

Telefon: 00800 0024 6723 / +45 4452 1000

E-mail: techsupport.nordic@bio-rad.com
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support eller klikke på linket Contact us (Kontakt os) på www.bio-rad.com.

Meddelelse
Ingen dele af denne udgivelse må gengives, kopieres eller sendes i nogen form eller på nogen måde,
elektronisk eller mekanisk, herunder fotokopiering, optagelse eller lagring i søge- eller
registreringssystemer, uden skriftlig tilladelse fra Bio-Rad.

Bio-Rad forbeholder sig retten til at ændre sine produkter og tjenester når som helst. Denne vejledning
kan ændres uden varsel. Selvom den er udarbejdet for at sikre nøjagtig information, påtager Bio-Rad
sig intet ansvar for fejl eller udeladelser eller for eventuelle skader, der måtte opstå fra anvendelse
eller brug af denne information.

BIO-RAD er et varemærke tilhørende.

BIO-RAD, HARD-SHELL og MICROSEAL er varemærker tilhørende Bio-Rad i visse jurisdiktioner.

SYBR er et varemærke tilhørende Thermo Fisher Scientific Inc. Bio-Rad har licens til at sælge
reagenser indeholdende SYBR Green I til brug i realtid PCR, kun til forskningsformål.

EvaGreen er et varemærke tilhørende Biotium, Inc. Bio-Rad er licenseret af Biotium, Inc. til at sælge
reagenser, der indeholder EvaGreen farvestof til brug i realtid PCR, kun til forskningsformål.

Alle her anvendte varemærker tilhører deres respektive ejer.
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Tilsigtet anvendelse

Tilsigtet anvendelse
CFX96 Dx systemet og CFX96 DeepWell Dx systemet med CFX Manager Dx software er beregnet til
udførelse af fluorescensbaseret PCR til detektion og kvantifikation af nukleinsyresekvenser. Disse
systemer og den tilhørende software er beregnet til in vitro-diagnostisk brug af uddannet
laboratoriepersonale. Systemerne er beregnet til anvendelse med diagnostiske nukleinsyretest fra
tredjeparter, som er produceret og mærket til diagnostiske formål.

.

Symbolleksikon
Væsentlige ændringer er fremhævede!

Fabrikant Partinummer

Udløbsdato Til In Vitro-diagnostisk brug

Temperaturgrænse Katalognummer

Se brugsanvisningen Antal tests

Til brug med Serienummer

Kun receptpligtig brug Indeholder latex
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CE-mærkning – forordning (EU)
2017/746 IVDR

Oversættelser
Produktdokumenter kan leveres på flere sprog på elektroniske medier.
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Sikkerhed og overholdelse af lovgivningen
For sikker betjening af CFX96™Dx systemet eller CFX96 DeepWell Dx systemet med CFX Manager™
Dx softwaren, omtalt som CFX Dx systemet i dette dokument, anbefaler Bio-Rad på det kraftigste, at du
følger de sikkerhedsspecifikationer, der fremgår af dette afsnit og i resten af denne vejledning.

Vigtigt: CFX96 Dx og CFX96 DeepWell Dx systemerne er godkendt til brug som in vitro
diagnostiske (IVD) medicinske anordninger.

Advarselsmærkater om sikkerhed
Advarselsmærkater, som er placeret på instrumentet og i denne vejledning, advarer brugeren om
kilder til personskade eller fare. Tabel 1 definerer hver advarselsmærkat om sikkerhed.

Ikon Betydning

Advarsel om risiko for skade på kroppen eller udstyret
Betjening af CFX Dx systemet inden denne vejledning er blevet læst, kan udgøre en
risiko for personskade. For at opnå sikker brug må dette instrument ikke betjenes på
måder, som ikke er angivet i denne vejledning. Kun kvalificeret
laboratoriepersonale, som er uddannet i sikker brug af elektrisk udstyr, må betjene
dette instrument. Alle systemets komponenter skal altid håndteres med forsigtighed
og med rene, tørre hænder.

Advarsel om håndtering af biologisk farlige materialer
Ved håndtering af biologisk farlige prøver skal de anbefalede forsigtighedsregler og
retningslinjer overholdes, og eventuelle lokale retningslinjer, der er specifikke for
laboratoriet og stedet, skal følges.

Advarsel om risiko for forbrændinger
En termocykler genererer tilstrækkelig varme til at forårsage svære forbrændinger.
Brug altid sikkerhedsbriller eller anden øjenbeskyttelse under betjeningen. Lad altid
prøveblokken vende tilbage til inaktiv temperatur, inden låget åbnes og prøverne
tages ud. Sørg altid for maksimalt frirum for at undgå utilsigtede hudforbrændinger.

Tabel 1. Betydning af advarselsmærkater om sikkerhed
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Sikkerhed og overholdelse af lovgivningen

Ikon Betydning

Advarsel om risiko for eksplosion
Prøveblokkene kan blive så varme i løbet af normal drift, at de får væsker til at koge
og eksplodere.

Tabel 1. Betydning af advarselsmærkater om sikkerhed, fortsat

Specifikationer for sikker brug og overholdelse af
lovgivningen

Tabel 2 indeholder en liste over specifikationerne for sikker brug af Bio-Rads CFX Dx real-time PCR-
detektionssystemer. De medfølgende skærmede kabler skal anvendes med disse instrumenter for at
sikre overholdelse af FCC's klasse A-grænser.

Anvendelsesaspekt Betingelser for sikker brug

Nominel indgangseffekt 100-240 VAC, 50-60 Hz, maks. 850 W

Overspændingskategori II

Sikringer 10 A, 250 V, 5 x 20 mm, flink (antal 2 stk.)

Miljøforhold Kun til indendørs brug

Anvendelsestemperatur 15-31 °C

Opbevaringstemperatur -20 til 60 °C

Relativ luftfugtighed Op til 80 % (ikke-kondenserende)

Højde over havet Op til 2000 meter over havets overflade

Forureningsgrad 2

Tabel 2. Betingelser for sikker brug
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Farer

Overholdelse af lovgivningen
CFX Dx real-time PCR-detektionssystemet er blevet testet og fundet at være i overensstemmelse
med alle gældende krav i følgende standarder for sikkerhed og elektromagnetisme:

n IEC 61010-1:2010 (3. udg.), DS/EN 61010-1:2010 (3. udg.). Sikkerhedskrav til elektrisk måle-,
regulerings- og laboratorieudstyr - Del 1: Generelle krav

n IEC 61010-2-010:2014, DS/EN 61010-2-010:2014. Sikkerhedskrav til elektrisk udstyr til måling,
styring og laboratoriebrug. Del 2-010: Særlige krav til laboratorieudstyr til opvarmning af
materialer

n IEC 61010-2-081:2015, DS/EN 61010-2-081:2015. Sikkerhedskrav til elektrisk udstyr til måling,
styring og laboratoriebrug. Del 2-081: Særlige krav til automatisk og halvautomatisk
laboratorieudstyr til analyse og andre formål (omfatter Tillæg 1)

n IEC 61010-2-101:2015 (2. udg.). Sikkerhedskrav til elektrisk udstyr til måling, styring og
laboratoriebrug. Særlige krav til in vitro-diagnostisk (IVD) medicinsk udstyr

n IEC 61326-1:2012 (Klasse A), DS/EN 61326-1:2013 (Klasse A). Elektrisk udstyr til måling, styring
og laboratoriebrug. EMC-krav - Del 1: Generelle krav

n IEC 61326-2-6:2012, DS/EN 61326-2-6:2013 (Klasse A). Elektrisk udstyr til måling, styring og
laboratoriebrug. EMC-krav. Særlige krav til in vitro-diagnostisk (IVD) medicinsk udstyr

Vigtigt: Dette udstyr genererer, anvender og kan udstråle radiofrekvent energi og kan, hvis det
ikke installeres og anvendes i overensstemmelse med den medfølgende vejledning, forårsage
skadelig interferens med radiokommunikation. Anvendelse af systemerne i beboelsesområder vil
sandsynligvis forårsage skadelig interferens. I sådanne tilfælde vil det være brugerens ansvar at
korrigere dette for egen regning.

Farer
CFX Dx real-time PCR-detektionssystemet er konstrueret til sikker og effektiv drift, når det anvendes
som foreskrevet af producenten. Brug af CFX Dx real-time PCR-detektionssystemet eller de
tilhørende komponenter på en måde, der ikke er specificeret af producenten, kan forringe den
beskyttelse, der ellers ydes af instrumentet. [[[Undefined variable Global Variables.CompanyName]]]
er ikke ansvarlig for eventuelle personskader eller beskadigelser, som dette udstyr forvolder, hvis det
anvendes på en uspecificeret måde, eller for ændringer i instrumentet, der ikke er udført af Bio-Rad
eller en autoriseret agent. Service af CFX Dx real-time PCR-detektionssystemet må kun udføres af
kvalificeret personale fra Bio-Rad.
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Sikkerhed og overholdelse af lovgivningen

Biologiske farer
CFX Dx real-time PCR-detektionssystem er et produkt til laboratoriebrug. Ved tilstedeværelse af
biologisk farlige prøver skal følgende retningslinjer og eventuelle lokale retningslinjer, der er specifikke
for laboratoriet og stedet, imidlertid følges.

Bemærk: Der undslipper ikke biologisk farlige stoffer under den normale brug af dette instrument.

Generelle forholdsregler

n Bær altid laboratoriekittel, laboratoriehandsker og sikkerhedsbriller med sideskærm eller
øjenværn.

n Hold hænderne væk fra øjne, næse og mund.

n Beskyt alle sår og hudafskrabninger fuldstændigt, inden der arbejdes med potentielt smittefarlige
materialer.

n Vask hænderne omhyggeligt med sæbe og vand, når du har arbejdet med potentielt smittefarligt
materiale, inden du forlader laboratoriet.

n Tag armbåndsure og smykker af, inden du går i gang med arbejdet.

n Opbevar alle smittefarlige eller potentielt smittefarlige materialer i brudsikre, tætte beholdere.

n Tag den beskyttende beklædning af, inden du forlader laboratoriet.

n Du må ikke skrive, tage telefonen, tænde for lyset eller røre ved noget med din behandskede
hånd, som andre personer uden handsker kan komme til at røre ved.

n Skift hyppigt handsker. Fjern handskerne straks, når de er blevet synligt kontamineret.

n Materialer, der ikke kan dekontamineres korrekt, må ikke udsættes for potentielt infektiøse
materialer.

n Efter afslutning af en procedure, der involverer biologisk farlige materialer, skal arbejdsområdet
dekontamineres med et passende desinficeringsmiddel (for eksempel en 1:10 fortynding af
klorblegemiddel til husholdningsbrug).

IVD-specifikke forholdsregler

n Alle patientprøver udgør en potentiel biologisk fare og skal håndteres i overensstemmelse
hermed og under overholdelse af generelle forholdsregler.

n Der undslipper ikke biologisk farlige stoffer under den normale brug af dette instrument.
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Farer

Overfladedekontaminering

ADVARSEL! For at forhindre elektrisk stød skal instrumenter altid slukkes og
frakobles før dekontaminering.

Følgende områder kan rengøres med et hvilket som helst bakteriedræbende, virusdræbende eller
svampedræbende desinfektionsmiddel til hospitalsbrug:

n Udvendigt låg og kabinet

n Indvendig reaktionsblokoverflade og reaktionsblokbrønde

n Kontrolpanel og skærm

For yderligere oplysninger om at klargøre og anvende desinfektionsmidlet henvises til producentens
anvisninger. Skyl altid reaktionsblokken og reaktionsblokbrøndene flere gange med vand efter
anvendelse af desinfektionsmiddel. Aftør reaktionsblokken og reaktionsblokbrøndene grundigt efter
skylning med vand.

Vigtigt: Undgå at bruge slibe- eller skuremidler eller stærke alkaliske opløsninger. Disse stoffer
kan ridse overflader og beskadige reaktionsblokken og dermed medføre reduceret nøjagtighed i
forbindelse med termisk kontrol.

Bortskaffelse af biologisk farlige materialer

Bortskaf følgende potentielt kontaminerede materialer i overensstemmelse med lokale og nationale
laboratoriebestemmelser:

n Kliniske prøver

n Reagenser

n Brugte reaktionsbeholdere eller andre forbrugsartikler, der kan være kontaminerede

Kemiske farer
CFX Dx real-time PCR-detektionssystemet indeholder ingen potentielt farlige kemiske materialer.

Eksplosions- eller brandfare
CFX Dx real-time PCR-detektionssystemet udgør ikke nogen usædvanlig fare for så vidt angår brand
eller eksplosion, når det anvendes på korrekt vis som anvist af Bio-Rad Laboratories.
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Sikkerhed og overholdelse af lovgivningen

Elektriske farer
CFX Dx real-time PCR-detektionssystemet udgør ingen unormale elektriske farer for operatører, hvis
det installeres og anvendes korrekt uden fysiske modifikationer, og hvis det er tilsluttet til en strømkilde
med den korrekte specifikation.

Transport
Før flytning eller forsendelse af CFX Dx real-time PCR-detektionssystemet eller det tilhørende optiske
reaktionsmodul eller den tilhørende termocykler-base skal procedurerne for dekontaminering udføres.
Flyt eller send altid CFX Dx real-time PCR-detektionssystemet og optiske reaktionsmoduler i separate
beholdere med det medfølgende emballeringsmateriale, som beskytter instrumentet mod skader.
Kontakt det lokale Bio-Rad-kontor, hvis du mangler passende beholdere.

Batteri
CFX Dx systemets termocykler anvender et 3 V litiummetal-knapcellebatteri og en 4,8 V genopladelig
nikkelmetalhydrid-batteripakke til at sikre opretholdelsen af tidsindstillinger og kørselsdata i tilfælde af,
at vekselstrømforsyningen svigter. Hvis tids- og/eller kørselsdata ikke forbliver indstillet, efter der er
blevet slukket for enheden, kan det være et tegn på, at batterierne er ved at løbe tør. Kontakt teknisk
support hos Bio-Rad for at få hjælp, hvis dette skulle forekomme.

Forsøg ikke selv at skifte batterierne. Kontakt teknisk support hos Bio-Rad.

Bortskaffelse
CFX Dx real-time PCR-detektionssystemet indeholder elektriske materialer. Disse må ikke bortskaffes
som usorteret affald og skal indsamles separat i henhold til EU-direktiv 2012/19/EU om affald af
elektrisk og elektronisk udstyr – WEEE-direktivet. Kontakt den lokale Bio-Rad-repræsentant
vedrørende landespecifikke anvisninger inden bortskaffelse.

Garanti
CFX Dx real-time PCR-detektionssystemet og dets tilknyttede tilbehør er dækket af en
standardgaranti fra Bio-Rad. Kontakt den lokale Bio-Rad-afdeling for at få nærmere oplysninger om
garantien.
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Kapitel 1 Indledning
Bio-Rads CFX Dx real-time PCR-amplifikationssystem til in vitro-diagnosticering (IVD) omfatter de
nyeste teknologiske fremskridt og muliggør PCR-kvantifikation med standardkurve,
genekspressionsanalyse, alleldiskrimination og endepunktsanalyse.

CFX Dx systemerne består af to hardwaremoduler og software:

n CFX96™Dx eller CFX96 DeepWell Dx optisk reaktionsmodul (ORM)

n C1000™Dx termocykler

n CFXManager™ Dx software

Ved brug sammen med CFX Manager Dx softwaren kan du

n generere øjeblikkelige resultater med Startup Wizard (Guiden Opstart)

n indtaste eller redigere brøndoplysninger før, under eller efter en kørsel

n fortolke komplekse data og fortolke et genekspressionsstudie ved hjælp af værktøjer som
PrimePCR™ kontrolanalyse og værktøjet til valg af referencegen

n udfærdige omfattende rapporter over dine real-time PCR-data

CFX Dx PCR-detektionssystemer
Tabel 3 indeholder en liste over Bio-Rads IVD PCR-produkter, som leveres med CFX Dx systemer.

Bemærk: Et CFX Dx system leveres med CFX Manager Dx softwaren, C1000 Dx termocykler og
enten CFX96 Dx eller CFX96 DeepWell Dx optisk reaktionsmodul.

Katalognr. Beskrivelse

1845097-IVD CFX96 Dx ORM *

1844095-IVD CFX96 DeepWell Dx ORM

1841000-IVD C1000 Dx termocykler

12007917 CFX Manager Dx software v3.1

Tabel 3. CFX IVD PCR-detektionssystemer

* Optisk reaktionsmodul
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Kapitel 1 Indledning

Få mere at vide
Dette dokument forklarer sikker opsætning og betjening af CFX96 Dx og CFX96 DeepWell Dx real-
time PCR-detektionssystemerne, som bærer CE IVD-mærket. I dette dokument omtales disse
systemer som CFX Dx system. Hertil kommer, at dokumentet forklarer, hvordan CFX Manager Dx
software anvendes sammen med CFX Dx system.

Tip: Klik på Bio-Rad-logoet i det øverste højre hjørne på ethvert at vinduerne i CFX Manager Dx
software for at åbne Bio-Rads websted. På hjemmesiden er der også links til tekniske
bemærkninger, manualer, produktoplysninger og teknisk support. Den indeholder desuden et
stort antal tekniske ressourcer vedrørende mange forskellige metoder og applikationer med
relation til PCR, real-time PCR og genekspression.
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Kapitel 2 Opsætning af C1000 Dx termocykleren
Dette kapitel forklarer opsætningen af CFX Dx systemets C1000 Dx termocykler på din institution.

Tip: Inden opsætningen af termocykleren skal du gøre dig bekendt med både termocykleren og
dens optiske reaktionsmodul, porte og tilbehør.

Krav til installationsstedet
Tabellerne i dette afsnit angiver de krav til lokale, miljø og strøm, som er nødvendige for problemfri
installation og brug af CFX Dx system termocykleren.

Bemærk: Installer CFX Dx system termocykleren på en flad, tør overflade med tilstrækkeligt luft
omkring, så den kan køre optimalt.

Pladskrav til bordet

Element Specifikation

Indgangseffekt Op til 850 W, maksimum

Frekvens 50-60 Hz, enkelt fase

USB-porte 5 A, 1 B

Dimensioner B: 33 cm, 13"

D: 46, 18"

H: 36 cm, 14"

Vægt 21 kg, 47 lb

Tabel 4. Krav til bordplads for CFX Dx system termocykler
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Kapitel 2 Opsætning af C1000 Dx termocykleren

Miljøkrav

Parameter Område Område for luftfugtighed

Driftsbetingelser 15-31 °C

59-87,8 °F

0-80 % RH, ikke-
kondenserende

Opbevaringsbetingelser 15-31 °C

59-87,8 °F

0-80 % RH, ikke-
kondenserende

Tabel 5. Miljøkrav til CFX Dx systemets termocykler

Strømkrav
Strømmen til CFX Dx system termocykleren skal være stabil og inden for specifikationerne for at sikre
korrekt drift. Det strømkabel, der tilsluttes til strømindgangsporten, skal være normeret til 7 A eller
derover.

Element Specifikation

Lysnetindgangsspænding 100-240 VAC; 50-60 Hz, enkelt fase

Maks. strømforbrug < 850 watt

Antal strømudtag Mindst 2 strømudtag:

n 1 udtag til termocykleren

n 1 udtag til den computer, som kører CFX Manager Dx-
softwaren

Tabel 6. Strømkrav for CFX Dx system
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Systemoversigt

Systemoversigt
Illustrationerne i dette afsnit viser hovedkomponenterne i C1000 Dx termocykler-basen.

Set forfra

1. Optisk reaktionsmodul – omfatter et optisk system til indsamling af fluorescensdata og en
termocyklerblok. CFX Dx real-time PCR-detektionssystemer understøtter enten et
CFX96™Dx eller et CFX96 DeepWell Dx modul.

2. Status-LED – viser, om blokken er i brug.

3. Låg-knap – åbner eller lukker låget til det optiske reaktionsmodul og forsegler
reaktionskammeret.

4. C1000™ Dx termocykler-base – leverer systemspænding og kommunikation og
indeholder CFX96 Dx og CFX96 DeepWell optiske reaktionsmoduler.

5. Frontpanelskærm og knapper – giver mulighed for at betjene systemet i separat tilstand.
Vigtigt: For at sikre dataintegritet i forbindelse med et IVD-genstudie understøtter CFX
Manager Dx softwaren ikke data, som er genereret af termocykleren i separat tilstand.

6. Opvarmet, indvendigt låg – opretholder lågets temperatur for at undgå kondens og
fordampning.

7. Prøve/reaktionsblok – rummer reaktionsbeholderen, herunder rør og mikroplader.

FORKLARING
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Kapitel 2 Opsætning af C1000 Dx termocykleren

Set bagfra

1. Ethernet-port – forbinder C1000 Dx termocykleren med netværket.

2. USB-porte (Type B) – forbinder C1000 Dx termocykleren med en computer, der kører CFX
Manager Dx softwaren.

3. USB-porte (Type A) – overfør data til og fra et USB-flashdrev.
Vigtigt: For at sikre dataintegritet i forbindelse med et IVD-genstudie understøtter CFX
Manager Dx softwaren ikke data, som er genereret af termocykleren i separat tilstand.

4. Seriel testport – kun til brug i forbindelse med servicetest.

5. Køleventilatorer – afkøler termocykleren.
Vigtigt: Undgå at blokere køleventilatorerne. For optimal drift skal det sikres, at der
kan cirkulere luft bag termocykler-basen.

6. Strømindgang – vekselstrøm. Brug det medfølgende strømkabel.

7. Tænd/sluk-knap – vippekontakt til at tænde/slukke termocykleren.

8. Sikringer – se Specifikationer for sikker brug og overholdelse af lovgivningen på side 14 for
sikringsspecifikationer.

FORKLARING
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Optiske reaktionsmoduler

Optiske reaktionsmoduler
C1000 Dx termocykler er kompatibel med følgende Bio-Rad optiske reaktionsmoduler til real-time
PCR.

n CFX96 Dx optisk reaktionsmodul

n CFX96 DeepWell Dx optisk reaktionsmodul

Det valgte CFX Dx optiske reaktionsmodul og termocykleren leveres i separate kasser. CFX Manager
Dx softwaren leveres sammen med det optiske reaktionsmodul.

Vigtigt: Det optiske reaktionsmodul kalibreres med den termocykler-base, det leveres sammen
med. Det optiske reaktionsmodul må derfor ikke anvendes sammen med en anden termocykler-
base, lige som termocykler-basen ikke må anvendes sammen med andre optiske
reaktionsmoduler.

Begge optiske reaktionsmoduler indeholder et fuldt justerbart opvarmet låg, der er i stand til at køre
pålideligt med et bredt udvalg af reaktionsbeholdere. Det optiske reaktionsmodul indeholder
køleventilatorer til hurtig opvarmning og afkøling.

Hvert enkelt CFX Dx optiske reaktionsmodul omfatter følgende komponenter:

n Opvarmet, indvendigt låg – opretholder lågets temperatur for at undgå kondens og
fordampning.

n Prøve/reaktionsblok – rummer reaktionsbeholderne, herunder rør og mikroplader.

n Låg-knap – åbner og lukker låget og forsegler reaktionen.

n Status-LED – når den lyser, angiver det, at blokken er i brug.

Anbefalede prøvevolumener
Når C1000 Dx termocykleren bruges, bestemmes det maksimale prøvevolumen af den type
reaktionsmodul, der bruges. Tabel 7 angiver de anbefalede volumener, der skal bruges med de
enkelte reaktionsmoduler.

Antal brønde Antal blokke
Anbefalet prøvevolumen, µl

(Øvre grænse)

96 brønde 1 10-50

96 dybe brønde 1 10-125

Tabel 7. Størrelse og volumengrænse for reaktionsmoduler
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Kapitel 2 Opsætning af C1000 Dx termocykleren

Installation af C1000 Dx termocykler
C1000 Dx termocykler-basen leveres i en separat pakke og ikke sammen med det optiske
reaktionsmodul. Pakken indeholder:

n C1000 Dx termocykler-base

n Strømkabel

n 1 USB-kabel

Sådan installeres C1000 Dx termocykleren:

1. Udpak og opsæt C1000 Dx termocykler-basen.

2. Tilslut reaktionsmodulet til basen.

3. Fjern forsendelsesskruen.

Dette afsnit forklarer i detaljer, hvordan disse opgaver udføres.

Udpakning og opsætning af C1000 Dx termocykler
Vigtigt: Inden du betjener termocykleren, skal du læse oplysningerne i Sikkerhed og
overholdelse af lovgivningen på side 13 og Advarselsmærkater om sikkerhed på side 13.

Tip: Under opsætningen skal du sikre, at der er tilstrækkelig plads nær termocykleren til en
computer, der skal køre CFX Manager Dx softwaren.

Sådan pakkes termocykler-basen ud og sættes op

1. Find pakken, der indeholder termocykler-basen.

2. Fjern basen fra indpakningsmaterialet.

Tip: Gem indpakningsmaterialet til fremtidig brug. Hvis en del mangler eller er beskadiget,
skal du kontakte det lokale Bio-Rad-kontor.

3. Anbring termocykler-basen på en flad, tør overflade med tilstrækkelig afkølet luftstrøm til, at den
kan køre korrekt.

4. Find strømkablet i forsendelsespakken og sæt den ene ende i strømindgangsporten bag på
termocykleren.

Vigtigt: Tænd ikke for instrumentet på dette tidspunkt.

5. Tilslut IVD-reaktionsmodulet til basen. Fortsæt med Påsætning af det optiske reaktionsmodul på
side 27.
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Installation af C1000 Dx termocykler

Påsætning af det optiske reaktionsmodul
Bio-Rad leverer det optiske reaktionsmodul CFX96 Dx eller CFX96 DeepWell sammen med C1000
Dx termocykler-basen (men i en separat kasse). Pak forsigtigt det optiske reaktionsmodul ud, og
kontrollér, at strøm- og USB-kablerne findes i kassen.

Vigtigt: Det optiske reaktionsmodul kalibreres med den termocykler-base, det leveres sammen
med. Det optiske reaktionsmodul må derfor ikke anvendes sammen med en anden termocykler-
base.

Sørg for, at C1000 Dx termocykler-basen står på en flad, tør overflade med tilstrækkelig cirkulation af
kølig luft til, at den kan køre korrekt.

Sådan sættes reaktionsmodulet på termocykler-basen

1. Anbring C1000 Dx termocykleren et passende sted med låsearmen nedad.

2. Løft det optiske reaktionsmodul ved at bruge håndtagene over ventilationsrillerne i siderne,
anbring modulet i rummet til C1000 Dx reaktionsmodulet, og sørg for, at der er ca. 2 cm plads
foran. Når det optiske modul er i rummet, bør det dække Bio-Rad-logoet foran rummet.

3. Træk op i låsearmen, indtil den flugter med siderne af modulrummet. Denne handling flytter
modulet fremad og låser det på plads.
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Kapitel 2 Opsætning af C1000 Dx termocykleren

4. Kontrollér, at modulet sidder fuldt ud og jævnt i C1000 Dx termocykler-basen. Der må ikke være
frigang mellem modulet og basen.

5. Sæt strømkablet i bag på C1000 Dx termocykler-basen og i en stikkontakt, og tryk derefter på
tænd/sluk-kontakten på bagpanelet på C1000 Dx termocykler for at starte systemet.

Fjernelse af forsendelsesskruen
Vigtigt: Bio-Rads optiske reaktionsmodul leveres med en rød forsendelsesskrue isat det
indvendige låg for at stabilisere det optiske reaktionsmodul under transport. Du skal fjerne
forsendelsesskruen, før du kan betjene det optiske reaktionsmodul.

Sådan fjernes forsendelsesskruen

1. C1000 Dx termocykler registrerer, at der er isat en forsendelsesskrue i det optiske
reaktionsmodul og viser en meddelelse om, hvordan skruen fjernes.
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Installation af C1000 Dx termocykler

2. Følg instruktionerne for at fjerne forsendelsesskruen. Det følgende diagram viser placeringen af
forsendelsesskruen.

Bemærk: Du skal isætte skruen igen, hvis det skulle blive nødvendigt at returnere
reaktionsmodulet. Gem skruet et sikkert og tilgængeligt sted.

Isætning af prøveplader
For at sikre ensartet opvarmning og afkøling af prøver skal pladerne være i fuldstændig kontakt med
reaktionsblokken. For at sikre tilstrækkelig kontakt skal du gøre følgende:

n Kontrollér, at blokken er ren inden indsætning af prøver.

n Tryk de individuelle rør, rørstrips eller mikroplader ind i blokbrøndene med fast hånd.

n Når der anvendes et eller nogle få rør, skal du anvende rørholderen (katalognr.1849000 eller
1849001) eller isætte mindst ét tomt rør i hvert hjørne af blokken for at sikre, at låget udøver et
jævnt tryk på de enkelte rør.
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Kapitel 2 Opsætning af C1000 Dx termocykleren

Isætning af plader i det optiske reaktionsmodul

Vigtigt: Ved kørsel af CFX Dx system skal rørstrips altid afbalanceres eller der skal sættes
hætter på hjørnebrøndene for at sikre, at det opvarmede låg påfører et jævnt tryk på tværs af
blokken.

Sådan isættes pladerne i det optiske reaktionsmodul

1. For at åbne det motoriserede låg skal du gøre et af følgende:

n Klik på Open Lid (Åbn låget) i ruden Detected Instruments (Registrerede instrumenter) i CFX
Manager Dx softwaren.

n Klik på Open Lid (Åbn låget) på fanen Start Run (Start kørsel) i softwaren.

n Tryk på knappen til låget på fronten af instrumentet.

2. Placer mikropladen, individuelle rør eller rørstrips med forseglede låg på blokken.

Vigtigt: Kontrollér, at rørene er fuldstændigt forseglede for at undgå lækage.

Tip: For optimale resultater isættes der et prøvevolumen på 10-25 µl på CFX Dx system.

3. For at sikre en nøjagtig dataanalyse skal det kontrolleres, at orienteringen af reaktionerne på
blokken er præcis den samme som orienteringen af brøndenes indhold på fanen Plate (Plade) i
CFX Manager Dx softwaren.

Tip: Du kan redigere brøndenes indhold ved hjælp af CFX Manager Dx softwaren før, under
eller efter kørslen.

4. For at lukke det motoriserede låg skal du gøre et af følgende:

n Tryk på knappen til låget på instrumentet.

n Klik på Close Lid (Luk låget) i ruden Detected Instruments (Registrerede instrumenter) i
softwaren.

n Klik på Close Lid (Luk låget) på fanen Start Run (Start kørsel) i softwaren.

Vigtigt: Sørg for, at der ikke er noget, som blokerer låget, når det lukker. Selv om der er en
sikkerhedsmekanisme, som forhindrer låget i at lukke, hvis der registreres en obstruktion, må
du aldrig placere noget, der kan komme i vejen for låget, før dette lukkes.
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PCR-plastik og reagensforbrugsvarer

For at finde og bestille anbefalede plastikforbrugsvarer til CFX Dx systemet skal du gå til Bio-Rads
websted. Du kan åbne dette websted fra menupunktet Help > PCR Plastic Consumables Web Site
(Hjælp > Websted for PCR-plastikforbrugsvarer) i CFX Manager Dx softwaren. Derudover henvises til
Plastics Selector (Plastikvælger) og Reagents Selector (Reagensvælger) for nemmere at finde og
bestille plastikforbrugsvarer og reagenser til dine specifikke hardware- og PCR-behov.

Registrering af tilsluttede instrumenter
Under installationen installerer CFX Manager Dx software automatisk instrumentets drivere på den
computer, der kører CFX Manager Dx software. CFX Manager Dx registrerer tilsluttede instrumenter,
når softwaren startes.

Vigtigt: Du skal frakoble C1000 Dx termocykleren fra CFX Manager Dx computeren, før du
installerer softwaren. Det er ikke nødvendigt at slukke for termocykleren under installation af
softwaren.

Sådan registreres tilsluttede instrumenter

1. Hvis det ikke allerede er gjort, skal den firkantede (han) ende af det medfølgende USB type B-
kabel tilsluttes til USB type B-porten, der findes bag på -basen.

2. Indsæt den anden ende (port) i en USB-port på CFX Manager Dx computeren.

3. Hvis termocykleren ikke allerede kører, skal du trykke på tænd/sluk-knappen bag på instrumentet
for at tænde det.

4. Start CFX Manager Dx software.

Softwaren registrerer automatisk det tilsluttede instrument og viser dets navn i ruden Detected
Instruments (Registrerede instrumenter) i startvinduet.

Bemærk: Hvis instrumentet ikke vises i ruden Detected Instruments (Registrerede instrumenter),
skal du kontrollere, at USB-kablet er isat korrekt. For at geninstallere driverne skal du vælge Tools
> Reinstall Instrument Drivers (Værktøjer > Geninstaller instrumentdrivere) i startvinduet i CFX
Manager Dx software.
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Kapitel 2 Opsætning af C1000 Dx termocykleren

Fjernelse af reaktionsmodulet
Vigtigt: Sluk for C1000 Dx termocykleren, inden reaktionsmodulet fjernes (se Nedlukning af
C1000 Dx termocykleren på side 32). Kølefinnerne i reaktionsmodulet kan være meget varme lige
efter kørsel af en protokol eller inkubation. Kontrollér, at finnerne af afkølede, inden
reaktionsmodulet fjernes.

Sådan fjernes det optiske reaktionsmodul fra termocykler-basen

1. Tryk låsestangen på bagsiden af termocykler-basen ned for at oplåse og frigøre det optiske
reaktionsmodul.

2. Løft forsigtigt det optiske reaktionsmodul ud af rummet med grebene på hver side.

3. Sæt det optiske reaktionsmodul på en ren, flad overflade, hvor det ikke kan stødes, ridses eller
falde på gulvet.

Nedlukning af C1000 Dx termocykleren
Sådan lukkes termocykleren ned

1. Tryk på knappen til at åbne låget foran på CFX optisk reaktionsmodul efter kørslen for at få
adgang til de prøver, der er sat i blokken.

2. Tag prøverne ud af blokken, og tryk på knappen til at lukke låget for at lukke det.

3. Tryk på tænd/sluk-knappen på bagpanelet på C1000 Dx termocykleren for at slukke for systemet.
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Kapitel 3 Installation af CFX Manager Dx
softwaren

Dette kapitel forklarer, hvordan CFX Manager™ Dx softwaren installeres.

CFX Manager Dx software er nødvendig for at kunne analysere real-time PCR-data fra CFX96™Dx
og CFX96 DeepWell Dx systemerne. Du kan også bruge softwaren til at styre disse systemer i
software-styret tilstand.

For oplysninger om installation af CFX Dx system termocykleren og det optiske reaktionsmodul
henvises til Opsætning af C1000 Dx termocykleren på side 21.
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Kapitel 3 Installation af CFX Manager Dx softwaren

Systemkrav
Tabel 8 indeholder en liste med minimums- og anbefalede systemkrav for den computer, der kører
CFX Manager Dx software (kaldet CFX Manager Dx computeren).

System Minimum Anbefalet

Operativsystem Microsoft Windows 7 SP1
Pro

Et af følgende:

n Microsoft Windows 7 SP2 Pro (32- og 64-
bit)

n Microsoft Windows 10 Pro (kun 64-bit)

n Microsoft Windows 10 Enterprise (kun
64-bit)

Vigtigt: Sikker bootstart skal være deaktiveret både på Microsoft Windows 10 Pro og Enterprise.

Porte 2 USB 2.0
højhastighedsporte

2 USB 2.0 højhastighedsporte

Harddiskplads 128 GB 128 GB

Processorhastighed 2,4 GHz, Dual Core 2,4 GHz, Quad Core

RAM 4 GB RAM 8 GB RAM

Skærmopløsning 1024 x 768 med true-color-
tilstand

1280 x 1024 med true-color-tilstand

PDF-læser Adobe PDF Reader eller Windows PDF
Reader fra en af de understøttede Microsoft
Office Suites:

n 2007

n 2010

n 2013

Tabel 8. Krav til computeren for CFX Manager Dx software
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Installation af CFX Manager Dx softwaren
Vigtigt: Du skal frakoble alle tilsluttede instrumenter fra CFX Manager Dx computeren, før du
installerer og opgraderer softwaren. Det er ikke nødvendigt at slukke for termocykleren under
installation af softwaren. Kontrollér, at alle kørsler er gemt, og at der ikke kører nogen
eksperimenter.

Bemærk: Hvis CFX Manager Dx software installeres på Windows 10, skal du kontrollere, at
Sikker bootstart er deaktiveret inden installationen.

Sådan installeres CFX Manager Dx software

1. Om nødvendigt frakobles alle tilsluttede instrumenter fra computeren.

Find og frakobl instrumentets USB-kabel fra CFX Manager Dx computeren. Den ende, der er
tilsluttet til instrumentet, behøver ikke at blive frakoblet.

2. Log på CFX Manager Dx computeren med administratorrettigheder.

3. Læg CFX Manager Dx software-cd'en i computerens cd-drev.

4. Softwarens velkomstside vises normalt automatisk. Dobbeltklik på Install Software (Installer
software) på softwarens velkomstside.

Bemærk: Hvis velkomstsiden ikke åbnes automatisk, skal du navigere til cd-drevet, åbne
mappen CFX_Manager og dobbeltklikke på setup.exe for at starte guiden til installation af
softwaren.

Tip: I installationsguiden skal du klikke på knappen Documentation (Dokumentation) for at
finde kopier af versionsnoter, instrumentvejledninger og anden dokumentation, der kan
søges i.

5. Følg instruktionerne på skærmen for at fuldføre installationen. Efter installationen vises ikonet for
CFX Manager på computerens skrivebord.

6. Cd’en kan skubbes ud, når installationen er færdig.

Registrering af tilsluttede instrumenter
Under installationen installerer CFX Manager Dx softwareinstallationsprogrammet automatisk
instrumentets drivere på CFX Manager Dx computeren. CFX Manager Dx registrerer tilsluttede
instrumenter, når softwaren startes.

Sådan registreres tilsluttede instrumenter

1. Hvis det ikke allerede er gjort, skal den firkantede ende (han) af det medfølgende USB-kabel
(type B) sættes i USB-porten (type B) bag på instrumentets base.
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2. Indsæt den anden ende (port) i en USB-port på CFX Manager Dx computeren.

3. Hvis instrumentet ikke allerede kører, skal du trykke på tænd/sluk-knappen bag på instrumentet
for at tænde det.

4. Start CFX Manager Dx.

Softwaren registrerer automatisk det tilsluttede instrument og viser dets navn i ruden Detected
Instruments (Registrerede instrumenter) i startvinduet.

Bemærk: Hvis instrumentet ikke vises i ruden Detected Instruments (Registrerede instrumenter),
skal du kontrollere, at USB-kablet er isat korrekt. For at geninstallere driverne skal du vælge Tools
> Reinstall Instrument Drivers (Værktøjer > Geninstaller instrumentdrivere) i startvinduet i CFX
Manager Dx.

Softwarefiler
Tabel 9 indeholder en liste over filtyperne i CFX Manager Dx software.

Filtype Filtypenavn Detaljer

Protokol .prcl Indeholder detaljerede oplysninger om protokollens
opsætning til udførelse af en PCR-kørsel.

Plade .pltd Indeholder detaljerede oplysninger om pladens
opsætning til udførelse af en PCR-kørsel.

Data .pcrd Indeholder resultaterne af en eksperimentkørsel og
PCR-analyse.

PrimePCR™ kørsel .csv Indeholder protokol og pladelayout til PrimePCR-
plader.

Genstudie .mgxd Indeholder resultaterne fra flere PCR-kørsler og
genekspressionsanalyser.

LIMS .plrn Indeholder oplysninger om pladeopsætningen og
protokollen, der er nødvendige for at kunne køre en
LIMS-kompatibel kørsel.

Tabel 9. Filtyper i CFX Manager Dx software
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Anbefalede foranstaltninger omkring internetsikkerhed
Bio-Rad anbefaler at implementere foranstaltninger vedrørende internetsikkerhed i samarbejde med
it-afdelingen for den computer, der bruges med CFX96 Dx systemet. For eksempel:

n Installer og konfigurer passende antivirus- og firewallapplikationer.

Vigtigt: Konfigurer virusscanning til at køre uden for arbejdstiden, eller når instrumentet ikke
bruges. Hvis der startes en virusscanning, mens CFX Manager Dx kører et eksperiment, kan
det annullere kørslen, og dataene kan gå tabt.

n CFXManager Dx software har ikke en timeout-funktion for inaktiv bruger. Implementer
sikkerhedsforanstaltninger for brugeradgang ved brug af Windows eller tredjepartssoftware
(implementer for eksempel en pauseskærm, der kræver login).

n Sikkerhed omkring flytbare medier:

o Brug adgangskoder og kryptering på din USB-enhed for at beskytte dataene.

o Deaktiver funktioner for automatisk eksekvering og afspilning for alle flytbare medieenheder.

o Håndhæv scanning af USB-enheder, når der tilsluttes et USB-drev.

n Brug et sikkerhedskopieringsværktøj for at gøre gendannelse af data lettere.
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Kapitel 4 Arbejdsområdet
CFXManager™ Dx software indeholder en grænseflade til opsætning af plader, udvikling af PCR-
protokoller, kørsel af disse på CFX Dx instrumenter og analyse af data fra PCR-kørsler.

CFX Manager Dx softwaren indeholder fem primære arbejdsområder:

n Startvinduet

n Startup Wizard (Guiden Opstart)

n Vinduet Protocol Editor (Protokoleditor)

n Vinduet Plate Editor (Pladeeditor)

n Vinduet Data Analysis (Dataanalyse)

Dette kapitel indeholder en kort beskrivelse og en visning af hvert arbejdsområde.
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Startvinduet
CFXManager Dx software åbner i startvinduet og viser Startup Wizard (Guiden Opstart), og her kan
du opsætte et eksperiment, foretage eller gentage en kørsel eller analysere en eksisterende kørsel. I
startvinduet kan du desuden se applikations- og instrumentlogfiler, oprette og administrere brugere
samt få adgang til adskillige nyttige redskaber. Der står flere oplysninger i Kapitel 5, Startvinduet.
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Startup Wizard (Guiden Opstart)
Brug Startup Wizard (Guiden Opstart) til hurtig opsætning og kørsel af brugerdefinerede
eksperimenter, eller vælg og kør et PrimePCR™ eksperiment. Du kan også bruge denne guide til at
gentage en kørsel eller analysere kørselsdata.
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Vinduet Protocol Editor (Protokoleditor)
I Protocol Editor (Protokoleditor) kan du oprette, åbne, gennemgå og redigere en protokol. Du kan
også ændre lågets temperatur for den åbne protokol. Funktionerne i Protocol Editor (Protokoleditor) er
nærmere beskrevet i Kapitel 6, Oprettelse af protokoller.
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Vinduet Plate Editor (Pladeeditor)
I Plate Editor (Pladeeditor) kan du oprette, åbne, gennemgå og redigere en plade. Funktionerne i Plate
Editor (Pladeeditor) er nærmere beskrevet i Kapitel 7, Klargøring af plader.
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Vinduet Data Analysis (Dataanalyse)
I vinduet Data Analysis (Dataanalyse) er der mulighed for at se og sammenligne kørselsdata, foretage
statistiske analyser, eksportere data og oprette rapporter, der er klar til offentliggørelse. Funktionen
Data Analysis (Dataanalyse) er nærmere beskrevet i Kapitel 9, Oversigt over dataanalyse. Se
desuden Kapitel 10, Detaljerede oplysninger om dataanalyse.
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CFXManager™ Dx softwaren indeholder en grænseflade til udvikling af PCR-protokoller, kørsel af
dem på CFX Dx systemer og analyse af PCR-kørte data.

Dette kapitel indeholder en introduktion til CFX Manager Dx software og en beskrivelse af de
funktioner, som er tilgængelige fra startvinduet.
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Startvinduet
CFXManager Dx åbner i startvinduet og viser Startup Wizard (Guiden Opstart), og her kan du
opsætte en kørsel, foretage eller gentage en kørsel eller analysere en eksisterende kørsel. I
startvinduet kan du desuden se applikations- og instrumentlogfiler, oprette og administrere brugere
samt få adgang til adskillige nyttige redskaber.

1. Softwarens titellinje viser navnet på softwaren og den bruger, der er logget på.

2. Menulinjen giver hurtig adgang til kommandoerne i menuerne File (Fil), View (Vis), User
(Bruger), Run (Kørsel), Tools (Værktøjer), Window (Vindue) og Help (Hjælp).

3. Kommandoerne på værktøjslinjen giver hurtig adgang til menupunkterne.

4. Venstre rude viser de instrumenter, der er forbundet til CFX Manager Dx computeren, og
indeholder knapper, som anvendes til betjening af låget og visning af instrumenternes
status.

5. Hovedruden viser arbejdsvinduet. Standardarbejdsvinduet på startskærmen er Startup
Wizard (Guiden Opstart).

6. Statuslinjen viser navne på de tilsluttede instrumenter og den bruger, der er logget på.

FORKLARING
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Kommandoer i menuen File (Fil)
New (Ny) – åbner en dialogboks, hvorfra du kan vælge at oprette en ny protokol, en ny plade eller et nyt
genstudie.

Open (Åbn) – åbner en dialogboks, hvorfra du kan vælge at navigere til og åbne en eksisterende
protokol, en eksisterende plade, en eksisterende datafil, et eksisterende genstudie eller en
eksisterende LIMS-fil eller PrimePCR™ kørselsfil.

Recent Data Files (Seneste datafiler) – viser en liste over senest åbnede PCR-filer.

Repeat a Run (Gentag en kørsel) – åbner Windows Stifinder på placeringen af gemte PCR-filer, hvor
du kan finde en kørsel, der skal gentages.

Exit (Afslut) – lukker CFX Manager Dx.

Kommandoer i menuen View (Vis)
Application Log (Applikationslogfil) – viser en logfil over softwarebrug fra den første installation til
dags dato.

Run Reports (Kør rapporter) – viser en liste over kørte rapporter.

Startup Wizard (Guiden Opstart) – viser Startup Wizard (Guiden Opstart) i hovedvinduet.

Run Setup (Kørselsopsætning) – viser vinduet Run Setup (Kørselsopsætning) i hovedvinduet.

Instrument Summary (Instrumentoversigt) – viser vinduet Instrument Summary (Instrumentoversigt)
i hovedvinduet.

Detected Instruments (Registrerede instrumenter) – skifter mellem at vise og skjule tilsluttede
instrumenter i venstre rude. Softwaren viser som standard tilsluttede instrumenter i venstre rude.

Toolbar (Værktøjslinje) – skifter mellem at vise og skjule værktøjslinjen øverst på skærmen.
Softwaren viser som standard værktøjslinjen.

Statuslinje – skifter mellem at vise og skjule statuslinjen nederst på skærmen. Softwaren viser som
standard statuslinjen.

Show (Vis) – åbner en dialogboks, hvorfra du kan

n se eller blokere statuslogfilen.

n åbne og se CFX Manager Dx datamappen.

n åbne og se brugerens datamappe.

n åbne og se LIMS-filmappen.
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n åbne og se PrimePCR-mappen.

n se kørselshistorikken.

n se egenskaber for alle tilsluttede instrumenter.

Kommandoer i menuen User (Bruger)
Select User (Vælg bruger) – åbner skærmen Login, hvor du kan vælge en bruger fra rullelisten User
Name (Brugernavn) og logge på applikationen.

Change Password (Skift adgangskode) – åbner dialogboksen Change Password (Skift
adgangskode), hvor brugerne kan ændre deres adgangskode til CFX Manager Dx software.

User Preferences (Brugerpræferencer) – åbner dialogboksen User Preferences
(Brugerpræferencer), hvor brugerne kan ændre standardindstillingerne for

n Afsendelse og modtagelse af e-mailbesked ved afslutningen af kørslen

n Lagring af datafiler

n Oprettelse af protokoller via Protocol Editor (Protokoleditor) eller Protocol AutoWriter
(Automatisk protokolskriver)

n Oprettelse af plader

n Analyse af data

n Udførelse af genekspressionsanalyse

n Bestemmelse af datakvalitet

n Eksport af CFX Dx instrumentdata

User Administration (Brugeradministration) – åbner dialogboksen User Administration
(Brugeradministration), hvor administratorerne kan oprette brugere, ændre rolletilladelser og tildele
roller til brugere.

Bio-Rad Service Login – kun til brug for Bio-Rad teknisk servicepersonale. Undlad at bruge denne
kommando.
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Kommandoer i menuen Run (Kør)
User-defined Run (Brugerdefineret kørsel) – åbner vinduet Run Setup (Kørselsopsætning), i hvilket
det er muligt at indstille en brugerdefineret protokol og plade og derefter køre et PCR-eksperiment på
udvalgte instrumenter.

PrimePCR Run (PrimePCR-kørsel) – åbner fanen Start Run (Start kørsel) i vinduet Run Setup
(Kørselsopsætning) med standard-PrimePCR-protokollen og -pladelayoutet indlæst baseret på det
valgte instrument.

End-Point Only Run (Kun endepunktskørsel) – åbner fanen Start Run (Start kørsel) i vinduet Run
Setup (Kørselsopsætning) med standardendepunktsprotokollen og -pladelayoutet indlæst baseret på
det valgte instrument.

Qualification Run (Kvalificeringskørsel) – åbner fanen Start Run (Start kørsel) i vinduet Run Setup
(Kørselsopsætning) med standardkvalificeringsprotokollen og -pladelayoutet i Bio-Rad indlæst for det
valgte instrument.

Kommandoer i menuen Tools (Værktøjer)
Master Mix Calculator (Mastermix-beregner) – åbner Master Mix Calculator (Mastermix-beregner),
hvor du kan oprette en reaktionsblanding og udskrive beregningerne.

Protocol AutoWriter (Automatisk protokolskriver) – åbner dialogboksen Protocol AutoWriter
(Automatisk protokolskriver), hvor du nemt kan oprette en ny protokol.

Ta Calculator (Ta-beregner) – åbner Ta Calculator (Ta-beregner), hvor du nemt kan beregne
hybridiseringstemperaturen for primerne.

Dye Calibration Wizard (Guide til farvestofkalibrering) – åbner Dye Calibration Wizard (Guide til
farvestofkalibrering), hvor du kan kalibrere et instrument til en ny fluorofor.

Reinstall Instrument Drivers (Geninstaller instrumentdrivere) – geninstallerer de drivere, som
kontrollerer kommunikationen med Bio-Rads real-time PCR-systemer.

Zip Data and Log Files (Zip data- og logfiler) – åbner en dialogboks, hvor du kan vælge filer, der skal
pakkes og gemmes i en zippet fil, som kan gemmes eller sendes via e-mail.

Batch Analysis (Batchanalyse) – åbner dialogboksen Batch Analysis (Batchanalyse), hvor du kan
indstille parametre til analyse af mere end én datafil ad gangen.

Options (Valgmuligheder) – åbner en dialogboks, hvor du kan

n Konfigurere indstillingerne for e-mailserveren.

n Konfigurere eksportindstillinger for LIMS og andre datafiler.
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Kommandoer i menuen Help (Hjælp)
Tip: Menuen Help (Hjælp) er tilgængelig på menulinjen i alle vinduer i CFX Manager Dx software.

Open Operation Manual (Åbn driftsvejledning) – åbner en PDF med denne vejledning.

Gene Expression Gateway Web Site – åbner Bio-Rads hjemmeside for CFX Dx system.

PCR Reagents Web Site – åbner Bio-Rads websted for PCR-reagenser, hvor du kan bestille PCR-
reagenser, supermixes, farvestoffer og kits.

PCR Plastic Consumables Web Site – åbner Bio-Rads websted for PCR Plastics and
Consumables, hvor du kan bestille PCR-plader, pladeforseglinger, rør og hætter og andet tilbehør i
plastik.

Software Web Site – åbner Bio-Rads websted for PCR Analysis softwaren, hvor du kan bestille
opdaterede version af Bio-Rads CFX Manager Dx software.

About (Om) – viser oplysninger om copyright og version for CFX Manager Dx.

Kommandoer på værktøjslinjen

– åbner Windows Stifinder, hvor du kan navigere til og åbne en datafil eller en genstudiefil.

– åbner Master Mix Calculator (Mastermix-beregner).

– åbner vinduet Run Setup (Kørselsopsætning).

– åbner vinduet Run Setup (Kørselsopsætning) med standard-PrimePCR-protokollen og -
pladelayoutet indlæst baseret på det valgte instrument.

– åbner Startup Wizard (Guiden Opstart).
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Startup Wizard (Guiden Opstart)
Når CFX Manager Dx starter, viser arbejdsruden Startup Wizard (Guiden Opstart). I Startup Wizard
(Guiden Opstart) kan du

n Vælge et instrument fra listen med registrerede instrumenter og opsætte en brugerdefineret eller
PrimePCR-kørsel.

n Åbne og gentage en kørsel.

n Åbne en datafil for at analysere resultater fra en enkelt kørsel eller en genstudiefil med resultater
fra flere genekspressionskørsler.

Disse opgaver er nærmere beskrevet i de efterfølgende kapitler.

Statuslinje
I venstre side af statuslinjen nederst i hovedvinduet i softwaren vises aktuel status for registrerede
instrumenter. I højre side af statuslinjen vises navnet på den aktuelle bruger samt dato og klokkeslæt.
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Ruden Detected Instruments (Registrerede instrumenter)
I ruden Detected Instruments (Registrerede instrumenter) vises alle instrumenter, som er forbundet til CFX
Manager Dx computeren. Hvert instrument vises som standard som et ikon og dets serienummer vises som
dets navn.

For eksempel viser følgende billede fire registrerede instrumenter:

n To C1000™ termocyklere med CFX96™DeepWell reaktionsmoduler (CFX96DW1 og
CFX96DW2)

n To C1000™ termocyklere med CFX96™ reaktionsmoduler (CFX96l01 og CFX96l02)

Følgende kan gøres i denne rude:

n Se egenskaber og kalibrerede farvestoffer for et valgt instrument.

Der findes flere oplysninger om instrumentegenskaber i Visning af egenskaberne for et
instrument på side 56.

n Se status for et tilsluttet instrument.

n Åbne det motoriserede låg på det valgte instrument.

n Lukke det motoriserede låg på det valgte instrument.

n Se status for alle tilsluttede instrumenter.
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Sådan vises status for et tilsluttet instrument

u Vælg det ønskede instrument i ruden Detected Instruments (Registrerede instrumenter), og gør
et af følgende:

n Klik på View Status (Vis status) i sektionen Selected Instrument (Valgt instrument).

n Højreklik, og vælg View Status (Vis status) i den menu, som vises.

Dialogboksen Run Details (Kørselsdetaljer) åbner og viser fanen Run Status (Kørselsstatus).
Status for det valgte instrument vises neden for ruden med kørslens status, for eksempel:

Sådan åbnes eller lukkes låget på et instrument

u Vælg det ønskede instrument i ruden Detected Instruments (Registrerede instrumenter), og gør
et af følgende:

n Klik på Open Lid (Åbn låget) eller Close Lid (Luk låget) i sektionen Selected Instrument (Valgt
instrument).

n Højreklik, og vælg den relevante handling i den menu, som vises.

n Åbn dialogboksen Run Details (Kørselsdetaljer), vælg fanen Run Status (Kørselsstatus), og
klik på Open Lid (Åbn låget) eller Close Lid (Luk låget).

Sådan vises status for alle registrerede instrumenter

u Gør et af følgende:

n Klik på View Summary (Vis oversigt) i sektionen All Instruments (Alle instrumenter) i ruden
Detected Instruments (Registrerede instrumenter).

n Vælg View > Instrument Summary (Vis > Instrumentoversigt) på menulinjen.
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Dialogboksen Instrument Summary (Instrumentoversigt) vises:

Tip: Hvis systemet kun registrerer ét tilsluttet instrument, vises sektionen All Instruments
(Alle instrumenter) ikke i ruden Detected Instruments (Registrerede instrumenter). Vælg
View > Instrument Summary (Vis > Instrumentoversigt) for at se instrumentoversigten for et
enkelt instrument.
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Betjeningselementer i værktøjslinjen Instrument Summary (Instrumentoversigt)

Tabel 10 indeholder en liste over betjeningselementer og funktioner i værktøjslinjen Instrument
Summary (Instrumentoversigt).

Knap Knapnavn Funktion

Create a new Run (Opret
en ny kørsel)

Opretter en kørsel på den valgte blok
ved at åbne vinduet Run Setup
(Kørselsopsætning).

Stop Stopper den igangværende kørsel på
valgte blokke.

Pause Sætter den igangværende kørsel på
valgte blokke på pause.

Resume (Genoptag) Genoptager kørslen på valgte blokke.

Flash Block Indicator
(Lad blokindikator blinke)

Blinker med LED-indikatoren på låget af
de valgte blokke.

Open Lid (Åbn låget) Åbner den valgte bloks motoriserede
låg.

Close Lid (Luk låget) Lukker den valgte bloks motoriserede
låg.

Hide Selected Blocks
(Skjul valgte blokke)

Skjuler de valgte blokke på listen
Instrument Summary
(Instrumentoversigt).

Show All Blocks (Vis alle
blokke)

Viser de valgte blokke på listen
Instrument Summary
(Instrumentoversigt).

Show (Vis) Vælger, hvilke blokke der skal vises på
listen. Vælg en af mulighederne for at
vise alle registrerede blokke, alle
inaktive blokke, blokke der kører med
den aktuelle bruger, eller alle
igangværende blokke

Tabel 10. Betjeningselementer i værktøjslinjen Instrument Summary (Instrumentoversigt)

Driftsvejledning | 55



Kapitel 5 Startvinduet

Visning af egenskaberne for et instrument
I ruden Detected Instruments (Registrerede instrumenter) kan du se detaljerede oplysninger om et
valgt instrument, herunder instruments egenskaber, status for forsendelsesskruen og en liste over
kalibrerede farvestoffer (fluoroforer).

Sådan vises instrumentegenskaber

u Højreklik på det ønskede instrument i ruden Detected Instruments (Registrerede instrumenter),
og vælg Properties (Egenskaber) i den viste menu.

Fanen Properties (Egenskaber)

Fanen Properties (Egenskaber) viser tekniske oplysninger om det valgte instrument, herunder model,
serienumre på komponenter og firmwareversioner. Instrumentets standardnavn (serienummeret)
vises mange steder, herunder i ruden Detected Instruments (Registrerede instrumenter) og i
overskriftslinjen i dialogboksen Instrument Properties (Instrumentegenskaber). Du kan omdøbe
instrumentet for lettere at identificere det.
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Sådan omdøbes et instrument

u Skriv et navn i feltet Rename (Omdøb) øverst på fanen Properties (Egenskaber) på fanen
Instrument Properties (Instrumentegenskaber), og klik på Rename (Omdøb).

Det nye navn vises i rækken Nickname (Kaldenavn) på fanen Properties (Egenskaber) samt på
overskriftslinjen i Instrument Properties (Instrumentegenskaber) og i ruden Detected Instruments
(Registrerede instrumenter).

Fanen Shipping Screw (Forsendelsesskrue)

På fanen Shipping Screw (Forsendelsesskrue) vises den aktuelle status for forsendelsesskruen til det
valgte instrument (Removed (Fjernet) eller Installed (Installeret)). Fanen indeholder også instruktioner
til installation eller fjernelse af den røde forsendelsesskrue.

Tip: Hvis softwaren registrerer forsendelsesskruen, vises fanen Shipping Screw
(Forsendelsesskrue) automatisk i dialogboksen Instrument Properties (Instrumentegenskaber).
Følg instruktionerne for at fjerne skruen.

Bemærk: Du skal fjerne forsendelsesskruen, før du kan bruge instrumentet. Du kan finde flere
oplysninger i Fjernelse af forsendelsesskruen på side 28.
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Fanen Calibrated Dyes (Kalibrerede farvestoffer)

Fanen Calibrated Dyes (Kalibrerede farvestoffer) viser de kalibrerede fluoroforer og plader for det
valgte instrument.

For at se detaljerede oplysninger om en kalibrering skal du klikke på Info-knappen i kolonnen Details
(Detaljer).
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Indstilling af brugerpræferencer
Tip: Det er ikke nødvendigt at udføre disse trin for at kunne bruge CFX Manager Dx software. Det
er ikke et problem at springe dette afsnit over eller udføre disse opgaver på et andet tidspunkt.

I CFX Manager Dx er det muligt at tilpasse arbejdsmiljøet. Hvis stedets systemadministrator har
oprettet softwarebrugere, kan den enkelte bruger tilpasse sit arbejdsmiljø. Hvis
systemadministratoren ikke har oprettet brugere, vil ændringer af præferencer gælde for alle, som
logger på CFX Manager Dx. (For oplysninger om oprettelse af brugere i CFX Manager Dx henvises til
Appendiks B, Administration af brugere og roller på CFX Manager Dx).

For eksempel kan du gøre følgende i menuen Users > User Preferences (Brugere >
Brugerpræferencer):

n Opsætte e-mailbeskeder ved afslutning af kørslen.

n Ændre standardindstillingerne for

o Den placering, hvor filer gemmes

o Kørselsopsætningsfiler

o Præfiks til filnavn

n Indstille de standardparametre, der skal bruges ved oprettelse af en ny protokol og plade.

n Indstille standardparametre for dataanalyse og genekspression.

n Tilpasse standardkvalitetskontrolparametrene.

n Tilpasse dataparametrene for dataeksport.

I menuen Tools (Værktøjer) kan du gøre følgende:

n Oprette en mastermix.

n Kalibrere farvestoffer til et specifikt instrument.

Bemærk: Mastermix og farvestofkalibrering er tilgængelige for enhver, som logger på CFX
Manager Dx.

Dette afsnit forklarer i detaljer, hvordan disse opgaver udføres.

Opsætning af e-mailbeskeder

Du kan oprette forbindelse mellem CFX Manager Dx og en udgående e-mailserver for at sende
e-mailbeskeder ved kørslens afslutning til en liste med brugere. Du kan også vedhæfte en datafil og
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en analyserapport til listen over brugere. For yderligere oplysninger om forbindelsen mellem CFX
Manager Dx og din SMTP-server henvises til Oprettelse af forbindelse mellem CFXManager Dx og en
SMTP-server på side 61.

Bemærk: En brugers mulighed for at få adgang til e-mailopsætningsfunktionen afhænger af den
brugergruppe og de tilladelser, brugeren har fået tildelt af administratoren. Se Administration af
brugere på side 261 for nærmere oplysninger om administration af brugere og disses roller.

Sådan opsættes e-mailbeskeder

1. Vælg Users > User Preferences (Brugere > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

Dialogen User Preferences (Brugerpræferencer) vises med fanen Email (E-mail).

Bemærk: Systemet giver besked, hvis det registrerer, at der ikke er konfigureret en gyldig
SMTP-server for CFX Manager Dx. Klik på Configure Outgoing Email (Konfigurer udgående
e-mail) for at åbne dialogboksen Options (Valgmuligheder) og konfigurere SMTP-serveren til
e-mail. Se Oprettelse af forbindelse mellem CFX Manager Dx og en SMTP-server på side 61
for yderligere oplysninger.

2. Indtast e-mailadressen til hver af de personer, der skal have besked, når kørslen er gennemført, i
tekstfeltet To (Til). Alle modtagerne får en e-mail, så snart kørslen er gennemført.

Bemærk: Du skal angive hver enkelt e-mailadresse på en separat linje. Tryk på Enter eller
Return efter hver adresse.

3. (Valgfrit) Indtast e-mailadressen til hver af de personer, der skal have en kopi af
e-mailbeskederne, når kørslen er gennemført, i tekstfeltet cc.

4. (Valgfrit) Alle modtagere får som standard en kopi af datafilen som vedhæftet fil. Fjern
markeringen af dette afkrydsningsfelt, hvis der ikke skal vedhæftes en kopi af datafilen.
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5. (Valgfrit) Vælg Attach Analysis Report (Vedhæft analyserapport) for at vedhæfte en PDF med
analyserapporten til e-mailen.

6. Klik på OK for at gemmeændringerne og lukke dialogboksen User Preferences
(Brugerpræferencer).

Sådan redigeres en modtagers e-mailadresse

u Rediger e-mailadressen efter behov, og klik på OK.

Sådan fjernes en e-mailmodtager

1. Vælg e-mailmodtageren, og tryk på tasten Delete (Slet).

2. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan nulstilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.

Oprettelse af forbindelse mellem CFX Manager Dx og en SMTP-server

Vigtigt: Visse kommercielle webmail-tjenesteudbydere (f.eks. Yahoo! og Gmail) har øget
e-mailsikkerhed. Hvis du bruger disse konti, skal du aktivere indstillingen Allow less secure
apps (Tillad mindre sikre apps) i kontoindstillingerne for den relevante konto for at aktivere
afsendelse af e-mail i CFX Manager Dx. Se sikkerhedsoplysningerne for din webmail-
tjenesteudbyder for at få flere oplysninger.

Du skal oprette forbindelse mellem CFXManager Dx og din e-mailserver, før softwaren kan sende en
e-mailbesked.

Sådan oprettes der forbindelse mellem CFX Manager Dx og en e-mailserver

1. Gør et af følgende:

n Vælg User > User Preferences (Bruger > Brugerpræferencer), og klik på Configure Outgoing
Email (Konfigurer udgående e-mail) på fanen Email (E-mail).

n Vælg Tools > Options (Værktøjer > Valgmuligheder).
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Dialogboksen Options (Valgmuligheder) vises med fanen Email (E-mail).

2. Angiv følgende oplysninger for din virksomhed:

n SMTP Server Name (SMTP-servernavn) – navnet på den udgående e-mailserver i din
virksomhed.

n Port – din SMTP-servers portnummer. Dette er normalt 25.

n Use SSL (Brug SSL) – mulighed for anvendelse af Secure Sockets Layer (SSL). Visse
SMTP-servere kræver denne indstilling. Fjern markeringen i afkrydsningsfeltet, hvis det ikke
kræves af din virksomhed.

n Use Default “From” Address (Brug standard "Fra"-adresse) – navnet på e-mailserveren i
din virksomhed. Visse SMTP-servere kræver, at alle sendte e-mails har en "fra"-adresse,
som er fra et bestemt domæne, f.eks. navn@dinvirksomhed.com. Hvis dette er tilfældet, skal
du fjerne markeringen i afkrydsningsfeltet og angive en gyldig e-mailadresse.

n Authentication Required (Godkendelse kræves) – hvis websitet kræver kontogodkendelse,
skal dette afkrydsningsfelt være markeret.

n User Name (Brugernavn) – navnet på den godkendte konto. Dette kræves kun, hvis
Authentication Required (Godkendelse kræves) er valgt.

n Password (Adgangskode) – adgangskoden til den godkendte konto. Dette kræves kun, hvis
Authentication Required (Godkendelse kræves) er valgt.

3. For at verificere at indstillingerne for SMTP-serveren er korrekte, skal du angive en gyldig e-
mailadresse i tekstfeltet Test Email Address (Test e-mailadresse) og klikke på Test Email (Test e-
mail).
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Bemærk: Visse SMTP-servere tillader ikke vedhæftede filer, og andre tillader vedhæftede
filer op til en bestemt størrelse. Hvis du vil sende datafiler og/eller rapporter via e-mail ved
hjælp af CFX Manager Dx, skal du vælge Test Attachment (Test vedhæftet fil) og indstille
Attachment Size in MB (Størrelse på vedhæftet fil i MB) til 5 megabyte (MB) eller mere.

4. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Ændring af standardindstillinger for filer

På fanen Files (Filer) i dialogboksen User Preferences (Brugerpræferencer) kan du ændre følgende:

n Standardplaceringen, hvor filer gemmes i CFX Manager Dx

n Standardfiler til kørselsopsætning

n Standardparametre for filnavngivning

Sådan ændres standardindstillingerne for filer

1. Vælg Users > User Preferences (Brugere > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen Files (Filer) i dialogboksen User Preferences (Brugerpræferencer).
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3. Naviger til og vælg en standardmappe, hvor nye filer skal gemmes, i sektionen Default Folder for
File Creation (Standardmappe til filoprettelse). Du kan vælge en forskellig placering for hver
filtype:

n Protocol (Protokol)

n Plate (Plade)

n Data File (Datafil)

n Gene Study (Genstudie)

4. I sektionen File Selection for Run Setup (Filvalg til kørselsopsætning) skal du navigere til og
vælge de protokol- og pladefiler for targets (målsekvenser), som skal vises, når vinduet
Experiment Setup (Eksperimentopsætning) åbnes.

5. Definer præfiks og/eller suffiks for datafiler i sektionen Data File (Datafil). Vælg en ny værdi på
rullelisten for hver enkelt del. Det er desuden muligt at angive tilpassede præfiks- og
suffiksværdier i tekstfelterne Prefix (Præfiks) og Suffix (Suffiks).

CFX Manager Dx viser en forhåndsvisning af filnavnet neden for valgfelterne.

6. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan nulstilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.
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Indstilling af standardparametre for protokoller

Sådan indstilles standardparametre for protokoller for Protocol Editor (Protokoleditor)
og Protocol AutoWriter (Automatisk protokolskriver)

1. Vælg Users > User Preferences (Brugere > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen Protocol (Protokol) i dialogboksen User Preferences (Brugerpræferencer).

3. Angiv værdierne for følgende indstillinger, som vises i Protocol Editor (Protokoleditor), i sektionen
Protocol Editor (Protokoleditor):

n Sample volume (Prøvevolumen) – volumenet for hver af prøverne i brøndene (i µl).

n Lid Shutoff temperature (Lågets slukketemperatur) – den temperatur i ºC ved hvilken
varmelegemet i låget slukker under en kørsel.

4. Angiv værdierne for følgende indstillinger, som vises i Protocol AutoWriter (Automatisk
protokolskriver), i sektionen Protocol AutoWriter (Automatisk protokolskriver):

n Annealing temperature (Hybridiseringstemperatur) – temperaturen i ºC til eksperimenter,
der bruger iProof™ DNA-polymerase, iTaq™DNA-polymerase elle andre polymeraser.

n Amplicon length (Amplikonlængde) – længden af amplikonet i bp.

5. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan nulstilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.
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Indstilling af standardparametre for plader

Ændringer, der foretages på fanen Plate (Plade), er tilgængelige for alle brugere af softwaren.
Ændringer, der foretages under opsætningen af pladen, bliver tilgængelige for brugerne, når de er
blevet gemt og pladefilen lukket.

I dialogboksen User Preferences (Brugerpræferencer) kan du gøre følgende:

n Indstille standardpladeparametre.

n Tilføje nye navne på målsekvenser (targets) og prøver i de respektive biblioteker.

n Slette navne på målsekvenser (targets) og prøver fra de respektive biblioteker.

Sådan indstilles standardparametre for plader

1. Vælg Users > User Preferences (Brugere > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen Plate (Plade) i dialogboksen User Preferences (Brugerpræferencer).
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3. Angiv værdierne for følgende indstillinger for en ny pladefil. Disse værdier vises i vinduet Plate
Editor (Pladeeditor):

n Plate Type (Pladetype)

n Plate size (Pladestørrelse)

n Units (Enheder) – koncentrationen i udgangsskabelonen for brønde, som indeholder
standarder.

CFX Manager Dx bruger disse enheder til at oprette en standardkurve under Quantification
(Kvantifikation) på fanen Data Analysis (Dataanalyse).

n Scientific notation (Videnskabelig notation) – når dette er valgt, viser CFX Manager Dx
koncentrationsenhederne i videnskabelig notation.

n Scan mode (Scanningstilstand) – antallet eller typen af kanaler, der skal scannes under en
kørsel.

n Fluorophores (Fluoroforer) – de standardfluoroforer, der vises i betjeningselementerne for
brøndisætning i Plate Editor (Pladeeditor).

n Libraries (Biblioteker) – de navne på målsekvenser (targets) og prøver, der typisk anvendes
i eksperimenterne:

o Target names (Navne på målsekvenser) – navnene på målgener og -sekvenser.

o Sample names (Prøvenavne) – navnene på eksperimentprøver eller identificerende
kendetegn for prøverne (f.eks. Mouse1, Mouse2, Mouse3).

4. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Sådan tilføjes et nyt navn på en målsekvens (target) eller en prøve

u Indtast navnet på målsekvensen (target) eller prøven i det relevante felt under Libraries
(Biblioteker), og klik på OK.

Sådan slettes et navn på en målsekvens (target) eller en prøve

u Vælg navnet i det relevante felt under Libraries (Biblioteker), og tryk på tasten Delete og derefter
på OK.

Vigtigt: Navne, du fjerner fra biblioteket, fjernes fra softwaren og er ikke længere tilgængelige for
brugerne. For at gendanne standardnavnene i CFX Manager Dx skal du klikke på Restore
Defaults (Gendan standardindstillinger). Alle præferencer for alle faner kan nulstilles til de
oprindelige fabriksindstillinger ved at klikke på Restore Defaults (Gendan standarder) i
dialogboksen User Preferences (Brugerpræferencer). Vær forsigtig, når du sletter standardnavne
i CFX Manager Dx, og når du klikker på denne knap.
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Indstilling af standardparametre for dataanalyse

Sådan indstilles standardparametre for dataanalyse

1. Vælg Users > User Preferences (Brugere > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen Data Analysis (Dataanalyse) i dialogboksen User Preferences (Brugerpræferencer).

3. Vælg den tilstand, der skal bruges til at analysere data (enten Fluorophore (Fluorofor) eller Target
(Målsekvens)), i sektionen Analysis Mode (Analysetilstand).

4. Indstil standardparametrene for nedenstående valgmuligheder i sektionen PCR Quantitation
(PCR-kvantifikation):

n Baseline Setting (Baselineindstilling) – den baselinemetode, der skal anvendes i
analysetilstand.

n Cq Determination Mode (Cq-bestemmelsestilstand) – den tilstand i hvilken Cq-værdierne
beregnes for hver enkel fluorescenskurvelinje (enten Regression (Regression) eller Single
Threshold (Enkelt tærskel)).
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n Threshold Calc. Mode (Tærskelberegningstilstand) – endepunktsmålmængden.

Standard er Auto (Automatisk). Det betyder, at softwaren automatisk beregner
endepunktsmålet. For at indstille en specifik tærskel skal du fjerne markeringen i
afkrydsningsfeltet Auto (Automatisk) og indtaste den ønskede endepunktsmængde beregnet
i relative fluorescensenheder (RFU). Maksimumværdien er 65.000,00 RFU'er. Datafilerne for
efterfølgende kørsler vil anvende denne tærskelindstilling.

n Baseline Calc. Mode (Baselineberegningstilstand)– baselineværdien for alle kurvelinjer.

Standard er Auto (Automatisk). Det betyder, at softwaren automatisk beregner baseline for
alle kurvelinjer. For at indstille en specifik baselineværdi skal du fjerne markeringen i
afkrydsningsfeltet Auto (Automatisk) og indtaste minimum- og maksimumværdier for
cyklusområdet (1 til 9999). Datafilerne for efterfølgende kørsler vil anvende dette
cyklusområde.

n Log View (Logvisning) – bestemmer, hvordan softwaren viser amplifikationsdataene:

o On (Til) – amplifikationsdataene vises i en semilogaritmisk graf.

o Off (Fra) (standardindstilling) – amplifikationsdataene vises i en lineær graf.

5. Vælg antallet af slutcyklusser til gennemsnitsberegning under udførelse af
endepunktsberegningerne i sektionen End Point (Endepunkt):

n PCR – antallet af slutcyklusser til gennemsnitsberegning af kvantifikationsdata (standard er
5).

n End Point Only run (Kun endepunktskørsel) – antallet af slutcyklusser til
gennemsnitsberegning af endepunktsdata (standard er 2).

6. Vælg den Peak Type (Kurvetoptype), der skal detekteres, i sektionen Melt Curve (Smeltekurve)
(enten Positive (Positiv) eller Negative (Negativ)).

7. Vælg, hvordan brøndbetegnelserne skal vises, i sektionenWell Selector (Brøndvælger) (efter
Sample Type (Prøvetype), Target Name (Navn på målsekvens) ellert Sample Name
(Prøvenavn)).

8. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan nulstilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.
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Indstilling af standardparametre for genekspressionsdatafiler

Sådan indstilles standardparametrene for en ny genekspressionsdatafil

1. Vælg Users > User Preferences (Brugere > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen Gene Expression (Genekspression) i dialogboksen User Preferences
(Brugerpræferencer).

3. Angiv værdierne for følgende indstillinger:

n Relative to (I forhold til) – indtegner genekspressionsdataene i forhold til en kontrol
(startende ved 1) eller i forhold til nul:

o Zero (Nul) – softwaren ignorerer kontrollen. Dette er standard, hvis der ikke er tildelt en
kontrolprøve i vinduet Experiment Settings (Eksperimentindstillinger).

o Control (Kontrol) – softwaren beregner dataene i forhold til den kontrolprøve, som er
tildelt i vinduet Experiment Setup (Eksperimentopsætning).

n X-axis (X-akse) – indtegner prøven eller målsekvensen (target) på x-aksen.

n Y-axis (Y-akse) – indtegner lineær skala, log2- eller log10-skala på y-aksen.
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n Scaling (Skalering) – skaleringsindstillingen for grafen (standardindstillingen er Unscaled
(Ikke skaleret)):

o Highest (Højeste) – softwaren skalerer grafen efter det højeste datapunkt.

o Lowest (Laveste) – softwaren skalerer grafen efter det laveste datapunkt.

o Unscaled (Ikke skaleret) – softwaren viser dataene uden skalering i grafen.

n Mode (Tilstand) – analysetilstanden, enten relativ mængde (∆Cq) eller normaliseret
ekspression (∆∆Cq).

n Error Bar (Fejllinje) – datavariabilitet vist som enten standardafvigelse (Std. Dev.) eller
middelfejlen på middelværdien (Std. Error Mean).

n Error Bar Multiplier (Multiplikator for fejllinjer) – standardafvigelsesmultiplikator, der bruges
til at indtegne fejllinjerne (standarden er 1).

Du kan øge multiplikatoren til 2 eller 3.

n Sample Types to Exclude (Prøvetyper, der skal udelades) – de prøvetyper, der skal
udelades fra analysen.

Du kan vælge at udelade to eller flere prøver fra analysen. For at udelade alle prøvetyper
skal du fjerne markeringen i afkrydsningsfelterne for alle markerede prøvetyper.

4. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan nulstilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.

Tilpasning af regler for kvalitetskontrol

I CFX Manager Dx er det muligt at indstille regler for kvalitetskontrol, der anvendes på data i vinduet
Data Analysis (Dataanalyse). Softwaren validerer dataene iht. de indstillede regler.

Bemærk: Som standard er alle regler for kvalitetskontrol aktiveret.

Tip: Du kan nemt udelade brønde, der ikke består en kvalitetskontrolparameter, fra analysen i
kvalitetskontrolmodulet i vinduet Data Analysis (Dataanalyse).
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Sådan tilpasses regler for kvalitetskontrol

1. Vælg Users > User Preferences (Brugere > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen QC (Kvalitetskontrol) i dialogboksen User Preferences (Brugerpræferencer).

hvor:

n NTC – ingen skabelonkontrol

n NRT – ingen revers transkriptasekontrol

n Efficiency (Effektivitet) – reaktionseffektivitet

n Std Curve R^2 (Standardkurve R^2) – R-kvadratværdi for standardkurven

n Replicate group Cq Std Dev (Replikatgruppe Cq standardafvigelse) – standardafvigelse
beregnet for hver replikatgruppe

3. Gør et af følgende for hver kvalitetskontrolregel:

n For at bruge standardværdien skal du ikke gøre noget.

n For at ændre værdien skal du klikke på det tilhørende tekstfelt Value (Værdi), indtaste en ny
værdi og trykke på tasten Enter.

n For at deaktivere reglen skal du fjerne markeringen i afkrydsningsfeltet Use (Brug).

4. Klik på OK for at gemmeændringerne og lukke dialogboksen.
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Vigtigt: Alle præferencer for alle faner kan nulstilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.

Tilpasning af parametre for dataeksport

Du kan eksportere CFX Manager Dx data i følgende formater:

n Tekst (.txt)

n CSV (.csv)

n Excel 2007 (.xlsx)

n Excel 2003 (.xls)

n XML (.xml)

n HTML (.html)

Du kan specificere typen af data, som skal eksporteres, og tilpasse det eksporterede data-output.

Sådan tilpasses parametre for dataeksport

1. Vælg Users > User Preferences (Brugere > Brugerpræferencer) for at åbne dialogboksen User
Preferences (Brugerpræferencer).

2. Vælg fanen Custom Export (Tilpasset eksport) i dialogboksen User Preferences
(Brugerpræferencer).
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3. Vælg et format, som dataene skal eksporteres i, på rullelisten Export Format (Eksportformat).

4. Markér eller fjern markeringen i afkrydsningsfelterne for den type af data, der skal eksporteres, i
sektionen Data to Export (Data som skal eksporteres). De valgte elementer vises i listefeltet
Exported Columns (Eksporterede kolonner).

Bemærk: Kørselsoplysningerne er som standard inkluderet i overskriften. Fjern markeringen
i dette afkrydsningsfelt, hvis kørselsoplysningerne ikke skal medtages.

5. Du kan ændre outputvisningsrækkefølge for de valgte elementer.

Fremhæv elementet i listefeltet Exported Columns (Eksporterede kolonner), og klik på
pileknapperne til venstre for listen for at flytte det op eller ned.

6. Kolonnenavnene for outputtet af de valgte elementer kan eventuelt ændres:

a. Klik på Customize Column Names (Tilpas kolonnenavne).

Dialogboksen Column Name Customizer (Tilpasning af kolonnenavne) vises.

b. Skriv et nyt navn i feltet Custom Name (Tilpasset navn) for hvert standardkolonnenavn, som
skal ændres.
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c. Gør et af følgende:

n Klik på OK for at gemmeændringerne og vende tilbage til fanen Custom Export
(Tilpasset eksport). Det nye navn vises i parentes ved siden af standardkolonnenavnet i
listefeltet Exported Columns (Eksporterede kolonner).

n Klik på Cancel (Annuller) for at rydde ændringerne og vende tilbage til fanen Custom
Export (Tilpasset eksport).

7. Klik på OK for at gemmeændringerne og lukke dialogboksen.

Vigtigt: Alle præferencer for alle faner kan nulstilles til de oprindelige fabriksindstillinger ved at
klikke på Restore Defaults (Gendan standarder) i dialogboksen User Preferences
(Brugerpræferencer). Vær forsigtig, når du klikker på denne knap.

Oprettelse af et reaktions-mastermix
Brug CFX Manager Dxs Master Mix Calculator (Mastermix-beregner) til nemt at beregne det
påkrævede volumen af hver komponent i mastermixet. Du kan udskrive beregningstabellen for
mastermix på standardprinteren og gemme beregningerne for hver målsekvens (target) til senere
brug.

Sådan oprettes et reaktions-mastermix ved brug af Master Mix Calculator (Mastermix-
beregner)

1. For at åbne Master Mix Calculator (Mastermix-beregner) skal du gøre et af følgende:

n Vælg Tools > Master Mix Calculator (Værktøjer > Mastermix-beregner).

n Klik på Master Mix Calculator (Mastermix-beregner) i værktøjslinjen.

Master Mix Calculator (Mastermix-beregner) vises.
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2. Vælg en detektionsmetode i sektionen Reaction (Reaktion):

n SYBR®Green/EvaGreen

n Probes (Prober)

3. Klik på Create New (Opret ny) i sektionen Target (Målsekvens) for at oprette en ny målsekvens
(target). Der vises et nyt navn på målsekvensen (target) på rullelisten med målsekvenser.

4. (Valgfrit) Sådan ændres navnet på standardmålsekvensen (target):

a. Fremhæv navnet på målsekvensen (target) på rullelisten med målsekvenser.

b. Skriv et nyt navn i feltet Target (Målsekvens).

c. Tryk på Enter-tasten.

5. Juster start- og slutkoncentrationerne for forward primer og revers primer samt eventuelle prober.

6. I sektionen Master Mix Setup (Opsætning af mastermix) justeres værdierne for

n Number of reactions (Antal reaktioner) der skal køres
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n Reaction volume per well (Reaktionsvolumen pr. brønd)

n Template volume (Skabelonvolumen) pr. brønd

n Supermix concentration (Supermix-koncentration) pr. brønd

n Excess reaction volume (Overskydende reaktionsvolumen) pr. brønd

7. (Valgfrit) Udfør trin 2-6 for så mange målsekvenser (targets), som der er behov for.

8. Vælg den målsekvens (target), der skal beregnes, i sektionen Choose Target to Calculate (Vælg
målsekvens der skal beregnes).

Tip: Du kan beregne kun én, flere eller alle målsekvenser (targets) på én gang.

De beregnede volumener af de påkrævede komponenter for hver valgt målsekvens (target) vises
i mastermix-tabellen.

9. Klik på Set as Default (Angiv som standard) for at indstille de mængder, der blev angivet i
sektionen Target (Målsekvens) og Master Mix Setup (Opsætning af mastermix), som nye
standardværdier.

10. Klik på OK for at gemme indholdet af dialogboksen Master Mix Calculator (Mastermix-beregner).

Sådan udskrives tabellen over mastermix-beregninger

u For at udskrive en tabel over mastermix-beregninger skal du klikke på Print (Udskriv).

Beregningstabellen udskrives på standardprinteren.

Sådan gemmes tabellen over mastermix-beregninger som en PDF

u Skift standardprinteren ud med en PDF-driver, og klik på Print (Udskriv) på Master Mix Calculator
(Mastermix-beregner).

Sådan slettes målsekvenser (targets)

u Vælg målsekvensen (target) i rullelisten med målsekvenser, og klik på Remove (Fjern).

Vigtigt: Hvis en målsekvens (target) fjernes fra listen med målsekvenser, fjernes det også
fra de mastermix-beregninger, det anvendes i. Vær forsigtig, når du sletter en målsekvens.
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Kalibrering af nye farvestoffer
CFX96™Dx systemerne leveres kalibreret fra fabrikken for almindeligt anvendte fluoroforer i plader
med hvide og klare brønde. Tabel 11 indeholder en liste over de fluoroforer og kanaler, som hvert enkelt
instrument er kalibreret til.

Bemærk: CFX96 systemerne indeholder desuden en kanal, der er beregnet til FRET-kemi.
Denne kanal kræver ikke kalibrering for specifikke farvestoffer.

Fluoroforer Kanal Excitering, nm Detektion, nm

FAM, SYBR® Green I 1 450-490 515-530

VIC, HEX, CAL Fluor Gold 540, Cal
Fluor Orange 560

2 515-535 560-580

ROX, Texas Red, CAL Fluor Red 610,
TEX 615

3 560-590 610-650

CY5, Quasar 670 4 620-650 675-690

Quasar 705, Cy5.5 5 672-684 705-730

Tabel 11. Fabrikskalibrerede fluoroforer og kanaler

Sådan kalibreres nye farvestoffer på CFX systemer

1. Vælg det ønskede instrument i startvinduet i ruden Detected Instruments (Registrerede
instrumenter).

2. Vælg Tools > Calibration Wizard (Værktøjer > Guiden Kalibrering) for at åbne guiden Dye
Calibration (Farvestofkalibrering).
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Fluoroforer, der allerede er blevet kalibreret på det ønskede instrument, vises i tabellen
Calibrated Fluorophores (Kalibrerede fluoroforer).

3. Vælg den fluorofor, der skal kalibreres, på rullelisten i sektionen Calibrate New or Existing
Fluorophores (Kalibrer nye eller eksisterende fluoroforer).

Hvis navnet på fluoroforen ikke findes på listen, skal du indtaste navnet i tekstfeltet for at tilføje det
til listen.

4. Vælg en plate type (pladetype) for fluoroforen.

Hvis pladetypen ikke findes på listen, skal du indtaste navnet i tekstfeltet for at tilføje det til listen.

5. Vælg en channel (kanal) for fluoroforen.

6. Vælg en plate column (pladekolonne) for fluoroforen.

7. (Valgfrit) Indtast en farve, der skal tilknyttes til fluoroforen.

8. Klik på Add to Plate (Tilføj til plade) for at tilføje fluoroforen.

9. (Valgfrit) Gentag trin 3-8 for at tilføje alle de fluoroforer, du planlægger at kalibrere for pladen.

10. Klik på View Plate (Vis plade), når du er færdig med at tilføje fluoroforer, for at åbne vinduet Pure
Dye Plate Display (Rent farvestof-pladedisplay).

Brug dette vindue som guide i forbindelse med påføring af farvestoffer på pladen.

11. Klargør en plade med 96 brønde til farvestofkalibrering:

a. Pipettér farvestofopløsning ned i hver af brøndene i henhold til det mønster, der vises i Pure
Dye Plate Display (Rent farvestof-pladedisplay).

b. For hver fluorofor fyldes fire brønde med 50 µl (plade med 96 brønde) 300 nM
farvestofopløsning. Bemærk, at mindst halvdelen af pladen indeholder blindbrønde.

c. Forsegl pladen med den forseglingsmetode, du vil anvende til analysen.

12. Placer kalibreringspladen i blokken, og luk låget.

13. Klik på Calibrate (Kalibrer) i guiden Dye Calibration (Farvestofkalibrering), og klik derefter på OK
for at bekræfte, at pladen befinder sig i blokken.

14. Når CFX Manager Dx software afslutter kalibreringskørslen, vises der en dialogboks. Klik på Yes
(Ja) for at afslutte kalibreringen og åbne Dye Calibration Viewer (Farvestofkalibreringsfremviser).

15. Klik på OK for at lukke vinduet.
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En protokol er et sæt af trin, der udføres i en specifik rækkefølge. I CFX Manager™ Dx softwaren er
alle trinnene forbundet med valgmuligheder på instrumentet. For eksempel instruerer trinnene
instrumentet i at kontrollere blokkens og lågets temperatur, anvende en temperaturforskel hen over
blokken, tage en pladeaflæsning eller udføre en smeltekurveanalyse. Hver valgmulighed er angivet for
forskellige plade- og kørselstyper.

CFX Manager Dx indeholder to muligheder for oprettelse af protokoller: Protocol Editor
(Protokoleditor) og Protocol AutoWriter (Automatisk protokolskriver).

Protocol Editor (Protokoleditor) indeholder følgende funktioner:

n Standardbetjeningselementer for protokoller til hurtig oprettelse af protokoller

n Mulighed for hurtigt at beregne en gradient for det valgte antal rækker

n Mulighed for hurtigt at beregne kørselstid for den valgte pladetype

n Mulighed for at redigere protokoltrin

n Mulighed for at gemme protokoller med henblik på genanvendelse

n Mulighed for at udskrive protokollen til en standardprinter

Protocol AutoWriter (Automatisk protokolskriver) genererer automatisk en tilpasset PCR-protokol med
hot-start, første denaturering, hybridisering og forlængelsestrin ved brug af de angivne parametre. Du
kan derefter se en grafisk repræsentation af den foreslåede protokol og redigere, køre eller gemme
protokollen.
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Vinduet Protocol Editor (Protokoleditor)
Brug Protocol Editor (Protokoleditor) til at oprette, gennemgå og redigere en protokol. Som standard
åbnes Protocol Editor (Protokoleditor) med visning af en generisk 2-trins real-time-protokol for en
plade med 96 brønde.

1. Menulinjen giver hurtig adgang til menuerne File (Fil), Settings (Indstillinger) og Tools
(Værktøjer).

2. Værktøjslinjen giver hurtig adgang til at gemme og udskrive protokoller, bestemme hvor et
trin skal indsættes, angive prøvevolumen og se estimeret protokolkørselstid.

3. Hovedvinduet viser en grafisk gengivelse af protokollen.

4. Den nederste rude viser protokoloversigten.

5. Den venstre rude viser betjeningselementerne for protokollen, som du kan tilføje for at
tilpasse protokollen.

FORKLARING

Kommandoer i menuen File (Fil)
Save (Gem) – gemmer den aktuelle protokol.

Save As (Gem som) – gemmer den aktuelle protokol med et nyt navn og i en ny placering.

Close (Luk) – lukker Protocol Editor (Protokoleditor).
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Kommandoer i menuen Settings (Indstillinger)
Lid Settings (Lågindstillinger) – åbner dialogboksen Lid Setting (Lågindstillinger), hvor du kan ændre
eller indstille lågets temperatur.

Kommandoer i menuen Tools (Værktøjer)
Gradient Calculator (Gradientberegner) – åbner en dialogboks, hvor du kan vælge bloktypen til et
gradienttrin. Standard er 96 brønde.

Run time Calculator (Kørselstidsberegner) – åbner en dialogboks, hvor du kan vælge pladetypen og
scanningstilstand med henblik på at beregne den estimerede kørselstid i vinduet Run Setup
(Kørselsopsætning). Standard er 96 brønde, alle kanaler.

Kommandoer på værktøjslinjen

– gemmer den aktuelle protokolfil.

– udskriver det valgte vindue.

– brug denne kommando til at vælge, hvor du vil indsætte trin i forhold til det
aktuelt valgte trin.

– brug denne kommando til at angive et prøvevolumen i µl.
Prøvevolumenerne er forskellige afhængigt at bloktypen:

n For en blok med 96 dybe brønde er området 0-125 µl.

n For en blok med 96 brønde er området 0-50 µl.

– viser den estimerede kørselstid baseret på protokoltrin, rampehastighed og
den valgte bloktype.

– viser Hjælp-oplysninger om protokoller.

Driftsvejledning | 83



Kapitel 6 Oprettelse af protokoller

Betjeningselementer for protokolredigering
Venstre rude i vinduet Protocol Editor (Protokoleditor) indeholder betjeningselementer, som du kan
bruge til at oprette protokoller.

Hvert af disse betjeningselementer består af et sæt af parametre, som repræsenterer et trin i
protokollen. Du kan redigere de enkelte parametre og tilføje eller fjerne dem for at tilpasse protokollen.
Dette afsnit beskriver valgmulighederne for de enkelte betjeningselementer.

n Insert Step (Indsæt trin) – indsætter et trin før eller efter det valgte
trin. Du kan redigere værdierne for temperatur og holdetid enten i den
grafiske visning af protokollen eller i protokoloversigten.

n Insert Gradient (Indsæt gradient) – indsætter et gradienttrin baseret
på typen af den brøndblok, der blev valgt i gradientberegneren. Du
kan redigere gradientområdet i ruden Gradient, som vises, når der
indsættes et gradienttrin.

n Insert GOTO (Indsæt GÅ TIL) – indsætter et cyklustrin (en løkke),
som giver besked til softwaren om at gentage specifikke trin i
rækkefølge et angivet antal gange. Gentagelserne begynder, så snart
den første cyklus er gennemført. For eksempel kan du bede

softwaren om at udføre 39 repetitioner af trin 2-4. Efter den sidste repetition vil softwaren således
have gennemført trin 2-4 i alt 40 gange. Du kan redigere retur til-trinnet (GOTO – GÅ TIL) og
antallet af cyklusser enten i den grafiske visning eller i protokoloversigten.

n Insert Melt Curve (Indsæt smeltekurve) – indsætter et smeltekurveaflæsningstrin.

n Insert Plate Read to Step (Indsæt pladeaflæsning i trinnet) – tilføjer en
pladeaflæsningskommando til det valgte trin. En pladeaflæsning måler mængden af fluorescens
ved afslutningen af en cyklus. Pladeaflæsningstrinnet er normalt det sidste trin i en GOTO-løkke.

Tip: Når du tilføjer en pladeaflæsningskommando til et trin, ændres knappen til Remove
Plate Read (Fjern pladeaflæsning), når trinnet vælges.

n Remove Plate Read (Fjern pladeaflæsning) – fjerner en pladeaflæsningskommando fra det
valgte trin.

Tip: Når der fjernes en pladeaflæsningskommando fra et trin, ændres knappen til Add Plate
Read (Tilføj pladeaflæsning), når trinnet vælges.

n Step Options (Valgmuligheder for trin) – åbner dialogboksen Step Options (Valgmuligheder for
trin) og viser de tilgængelige valgmuligheder for det valgte trin. Se Step Options (Valgmuligheder
for trin) på side 85 for nærmere oplysninger om valgmulighederne for trin.

Tip: Du kan også åbne Step Options (Valgmuligheder for trin) ved at højreklikke på trinnet i
den grafiske visning.
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n Delete Step (Slet trin) – sletter det valgte trin fra protokollen.

Step Options (Valgmuligheder for trin)

Åbn dialogboksen Step Options (Valgmuligheder for trin) for at vise de valgmuligheder, der kan
tilføjes, ændres eller slettes fra et trin.

n Plate Read (Pladeaflæsning) – når feltet er markeret, tilføjes der en pladeaflæsning til trinnet.

n Temperature (Temperatur) – indstiller måltemperaturen for det valgte trin.

n Gradient – indstiller gradientområdet for trinnet. Området er 1-24 °C.

Bemærk: En gradient kører med den laveste temperatur forrest på blokken (række H på
billedet) og den højeste temperatur bagest på blokken (række A på billedet).

n Increment (Forøgelse) – antallet af grader, som temperaturen på det valgte trin skal øges (eller
reduceres) med. Dette gradtal lægges til måltemperaturen med hver cyklus. Området er ±0,1-
10 °C.

Bemærk: For at reducere temperaturen skal du sættes et minustegn (-) foran den numeriske
værdi (for eksempel -5 °C).

n Ramp Rate (Rampehastighed) – rampehastigheden for det valgte trin. Området afhænger af
blokkens størrelse.

n Time (Tid) – holdetiden for det valgte trin.

n Extend (Forlængelse) – den tid (i sekunder), som det valgte trin skal forlænges eller forkortes
med. Denne valgmulighed lægges til holdetiden i hver cyklus. Området er 1-60 sek.

n Beep (Bip) – når feltet er markeret, lyder der et bip ved afslutningen af trinnet.
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Tip: Hvis du indtaster en værdi, der ligger uden for det tilladte område, ændrer softwaren
denne værdi til den, der ligger tættest på inden for området.
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Oprettelse af en protokol i Protocol Editor (Protokoleditor)
Du kan oprette brugerdefinerede protokolfiler med Protocol Editor (Protokoleditor). Du kan også
redigere og gemme tidligere gemte protokolfiler eller eksempler på protokolfiler, der leveres sammen
med CFX Manager Dx software.

For at oprette en ny protokolfil skal du gøre følgende:

n Åbn en protokolfil i Protocol Editor (Protokoleditor).

Tip: Du kan åbne en ny eller eksisterende protokol i Protocol Editor (Protokoleditor).

n Opsæt den nye protokol.

n Tilføj trin til protokollen fra ruden med protokollens kontroller.

n Rediger trinnenes egenskaber.

n Gem protokollen.

Tip: For oplysninger om oprettelse af en ny protokol ud fra en tidligere gemt protokolfil eller et
eksempel på en protokolfil henvises til Åbning af en eksisterende protokol i Protocol Editor
(Protokoleditor) på side 88.

Åbning af en ny protokolfil i Protocol Editor (Protokoleditor)
I CFX Manager Dx kan du åbne en ny protokolfil på forskellige måder:

n Fra startvinduet

n Fra dialogboksen Startup Wizard (Guiden Opstart)

n Fra dialogboksen Run Setup (Kørselsopsætning)

Sådan åbnes en ny protokolfil fra startvinduet

u Vælg File > New > Protocol (Fil > Ny > Protokol).

Vinduet Protocol Editor (Protokoleditor) åbnes med standardprotokolfilen.

Tip: For information om indstilling af standardprotokollen henvises til Ændring af
standardindstillinger for filer på side 63.
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Sådan åbnes en ny protokolfil fra Startup Wizard (Guiden Opstart)

1. Gør et af følgende i startvinduet for at åbne Startup Wizard (Guiden Opstart), hvis den ikke
allerede er åben:

n Vælg View > Startup Wizard (Vis > Guiden Opstart).

n Klik på Startup Wizard (Guiden Opstart) på værktøjslinjen.

Som standard viser Startup Wizard (Guiden Opstart) fanen Run setup (Kørselsopsætning), når
instrumenttypen CFX96™ er valgt.

2. Om nødvendigt vælges instrumenttypen på rullelisten.

3. Klik på User-defined (Brugerdefineret) som kørselstype.

Dialogboksen Run Setup (Kørselsopsætning) åbner med fanen Protocol (Protokol) og viser
standard-protokolfilen.

4. Klik på Create New (Opret ny).

Vinduet Protocol Editor (Protokoleditor) åbner og viser standard-real-time-protokollen.

Sådan åbnes en ny protokol fra dialogboksen Run Setup (Kørselsopsætning)

1. Gør et af følgende i startvinduet for at åbne dialogboksen Run Setup (Kørselsopsætning):

n Vælg Run > User-defined Run (Kør > Brugerdefineret kørsel).

n Klik på User-defined Run (Brugerdefineret kørsel) på værktøjslinjen.

Dialogboksen Run Setup (Kørselsopsætning) åbner med fanen Protocol (Protokol) og viser
standard-protokolfilen.

2. Klik på Create New (Opret ny).

Vinduet Protocol Editor (Protokoleditor) åbner og viser standard-real-time-protokollen.

Åbning af en eksisterende protokol i Protocol Editor
(Protokoleditor)
CFXManager Dx leveres med eksempler på protokolfiler, som du kan redigere og gemme som
brugerdefinerede nye protokoller. Du kan også oprette en ny protokol fra en eksisterende
brugerdefineret protokol.
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Sådan åbnes et eksempel på en protokolfil

1. Vælg File > Open > Protocol (Fil > Åbn > Protokol) i startvinduet.

Windows Stifinder åbner som standard på placeringen for mappen med eksempler på filer i CFX
Manager Dx.

2. Åbn mappen med eksempler på filer. Følgende mapper vises:

n ConventionalProtocols (Konventionelle protokoller) – indeholder eksempler på protokolfiler
til traditionel PCR-analyse.

n DataFiles (Datafiler) – indeholder eksempler på datafiler, som du kan bruge til at udforske
funktionerne i CFX Manager Dx.

n MeltCalibration (Smeltekalibrering) – indeholder eksempler på protokolfiler, som du kan
bruge med softwaren til præcisionssmelteanalyse i Bio-Rad.

n Plates (Plader) – indeholder eksempler på pladefiler.

n RealTimeProtocols (Realtidsprotokoller) – indeholder eksempler på protokolfiler til real-time
PCR-analyse.

3. Åbn protokolmappen for den type kørsel, du vil udføre, enten ConventionalProtocols
(Konventionelle protokoller) eller RealTimeProtocols (Realtidsprotokoller).

4. Vælg den ønskede protokol, og klik på Open (Åbn).

Eksemplet på protokollen åbnes i vinduet Protocol Editor (Protokoleditor).

5. Vælg File > Save As (Fil > Gem som), og gem protokollen med et nyt navn eller i en ny mappe.

Sådan åbnes en eksisterende protokol

1. Gør et af følgende i startvinduet:

n Vælg File > Open > Protocol (Fil > Åbn > Protokol), naviger til og vælg den ønskede protokol,
og klik derefter på Open (Åbn).

n Åbn Startup Wizard (Guiden Opstart), og gør et af følgende:

o For at redigere den viste protokol skal du klikke på Edit Selected (Rediger valgte).

o For at redigere en anden eksisterende protokol skal du klikke på Select Existing (Vælg
eksisterende) og navigere til den ønskede fil.

Protokollen åbnes i vinduet Protocol Editor (Protokoleditor).

2. Vælg File > Save As (Fil > Gem som), og gem protokollen med et nyt navn eller i en ny mappe.
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Opsætning af en ny protokol
Tip: Hvis protokolfilen allerede indeholder de påkrævede parametre (hvis du for eksempel
redigerer en eksisterende pladefil), kan du springe dette afsnit over. Gå videre til Tilføjelse af trin i
en protokol på side 91.

Nye protokolfiler skal indeholde følgende parametre:

n Block type (Bloktype)

n Scan mode (Scanningstilstand) for den valgte bloktype

n Lid temperature (Lågets temperatur)

n Sample Volume (Prøvevolumen)

Opsætning af bloktypen

CFXManager Dx beregner automatisk temperaturstigninger for gradienttrin baseret på bloktypen.

Bemærk: Den pladetype, der er angivet i Protocol Editor (Protokoleditor), skal være den samme
som pladen i reaktionsmodulet.

Sådan angives bloktypen

u Vælg Tools (Værktøjer) > Gradient Calculator (Gradientberegner) i vinduet Protocol Editor
(Protokoleditor), og vælg den relevante pladetype på den rulleliste, som vises.

Valg af Scan Mode (Scanningstilstand) for den valgte Block Type (Bloktype)

For at bestemme protokollens kørselstid skal du vælge den ønskede bloktype og scanningstilstand.

Sådan vælges bloktype og scanningstilstand

u Vælg Tools > Run time Calculator (Værktøjer > Beregner af kørselstid) i vinduet Protocol Editor
(Protokoleditor), og vælg den relevante pladetype og scanningstilstand på den viste rulleliste.

Tilpasning af lågets temperatur

CFXManager Dx indstiller lågets standardtemperatur til 105,0 °C.

Du kan ændre standardindstillingerne eller slukke lågvarmeren, afhængigt af hvad der er behov for til
protokollen.

Tip: Lågets standardtemperatur kan ændres i dialogboksen User Preferences
(Brugerpræferencer). Se Indstilling af standardparametre for protokoller på side 65.
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Sådan tilpasses lågets temperatur

1. Vælg Settings > Lid Settings (Indstillinger > Lågindstillinger) i vinduet Plate Editor (Pladeeditor).

Dialogboksen Lid Settings (Lågindstillinger) åbnes.

2. Gør et af følgende:

n Vælg User Defined (Brugerdefineret), og indtast en temperaturværdi i tekstfeltet.

n Vælg Turn Off Lid Heater (Sluk lågvarmer).

3. Klik på OK for at acceptere ændringerne og lukke dialogboksen

Indstilling af Sample Volume (Prøvevolumen)

CFXManager Dx indstiller som standard prøvevolumen for hver brønd til 25 µl. CFX Dx system-
området er imidlertid 0-125 µl.

Instrumentet anvender én af to temperaturkontroltilstande til at fastlægge, hvornår prøven når
måltemperaturen i en protokol:

n Calculated mode (Beregnet tilstand) – når prøvevolumenet er indstillet til et volumen, der er
korrekt for blokken, beregner instrumentet prøvetemperaturen baseret på prøvevolumenet. Dette
er standardtilstanden.

n Block mode (Bloktilstand) – når prøvevolumenet er indstillet til nul (0) µl, registrerer instrumentet
prøvetemperaturen som den samme som den målte bloktemperatur.

Sådan indstilles prøvevolumenet for en specifik blok

u Skriv den korrekte værdi i tekstfeltet Sample Volume (Prøvevolumen) på værktøjslinjen i vinduet
Plate Editor (Pladeeditor).

Tip: Standardprøvevolumenet kan ændres i dialogboksen User Preferences
(Brugerpræferencer). SeÆndring af standardindstillinger for filer på side 63.

Tilføjelse af trin i en protokol
Sådan tilføjes et trin i en protokol

1. Åbn protokollen i vinduet Protocol Editor (Protokoleditor).

2. Find det sted, hvor det nye trin skal indsættes. Vælg Before (Før) eller After (Efter) på rullelisten
Step (Trin) på værktøjslinjen.

3. På grafen skal du vælge det trin, som du vil indsætte det nye trin før eller efter.

4. Klik på Insert Step (Indsæt trin) i venstre rude.
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5. Hvis du vil ændre temperaturen eller holdetiden, skal du klikke på standardværdien i grafen eller
protokoloversigten og indtaste en ny værdi.

6. (Valgfrit) I venstre rude kan du klikke på Step Options (Valgmuligheder for trin) for at få vist
dialogboksen Step Options (Valgmuligheder for trin) og redigere de tilgængelige indstillinger for
det valgte trin.

Tip: Du kan åbne dialogboksen Step Options (Valgmuligheder for trin) i genvejsmenuen i
enten grafruden eller i ruden med protokoloversigten.

7. Klik på OK, og klik derefter på Yes (Ja) for at gemme protokolændringerne.

Dialogboksen Save As (Gem som) vises

8. Skriv navnet på den nye protokolfil i dialogboksen Save As (Gem som), og klik på Save (Gem).

Indsættelse af et gradienttrin
Sådan indsættes et gradienttrin

1. Kontrollér, at pladestørrelsen for gradienten er den samme som bloktypen for instrumentet, 96-
brønds.

2. Vælg pladestørrelsen for gradienten, hvis det ikke allerede er gjort:

Vælg Tools > Gradient Calculator (Værktøjer > Gradientberegner), og vælg den relevante
brøndtype på rullelisten.

3. På Værktøjslinjen vælges enten Before (Før) eller After (Efter) på rullelisten Insert Step (Indsæt
trin).

4. I grafen eller oversigtsruden skal du vælge det trin, som gradienttrinnet skal indsættes før eller
efter.
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5. Klik på Insert Gradient (Indsæt gradient) i venstre rude. Det nye gradient-trin fremhæves i grafen
og oversigtsruden, for eksempel:

Hver rækkes temperatur i gradienten vises i tabellen Gradient i højre rude.

6. For at redigere gradientens temperaturområde skal du gøre et af følgende:

n Klik på standardtemperaturen i grafen eller oversigtsruden, og indtast en ny temperatur.

n Klik på Step Options (Valgmuligheder for trin) for at indtaste gradientområdet i vinduet Step
Options (Valgmuligheder for trin).

n Ændr værdien Range (Område) i tabellen Gradient.

7. For at redigere holdetiden skal du klikke på standardtiden i grafik- eller tekstvisningen og indtaste
en ny tid.

8. Klik på OK og derefter på Yes (Ja) for at gemmeændringerne.
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Indsættelse af en forekomst af trinnet GOTO (GÅ TIL)
Bemærk: Du kan ikke indsætte en forekomst af trinnet GOTO (GÅ TIL) i et GOTO-sæt. Du kan
ikke oprette indlejrede GOTO-løkker.

Sådan indsættes en forekomst af trinnet GOTO (GÅ TIL)

1. Vælg Before (Før) eller After (Efter) på rullelisten Insert Step (Indsæt trin) på værktøjslinjen.

2. På grafen skal du vælge det trin, som du vil indsætte det nye trin GOTO (GÅ TIL) før eller efter.

3. Klik på Insert GOTO (Indsæt GÅ TIL) i venstre rude.

4. For at redigere nummeret for trinnet GOTO (GÅ TIL) eller antallet af gentagelse af GOTO (GÅ
TIL) skal du vælge standardnummeret i grafen eller oversigtsruden og indtaste en ny værdi.

5. Klik på OK og derefter på Yes (Ja) for at gemmeændringerne.

Indsættelse af et smeltekurvetrin
Tip: Du kan ikke indsætte et smeltekurvetrin i en GOTO-løkke.

Bemærk: Smeltekurvetrinnet omfatter en 30-sekunders pause i begyndelsen af trinnet, som ikke
er vist i protokollen.
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Sådan indsættes et smeltekurvetrin

1. Vælg Before (Før) eller After (Efter) på rullelisten Insert Step (Indsæt trin) på værktøjslinjen.

2. På grafen skal du vælge det trin, som du vil indsætte smeltekurvetrinnet før eller efter.

3. Klik på Insert Melt Curve (Indsæt smeltekurve) i venstre rude. Det nye smeltekurvetrin fremhæves
i grafen og oversigtsruden, for eksempel:

4. For at redigere smeltetemperaturområde eller stigningstid skal du vælge standardtallet i grafen
eller oversigtsruden og indtaste en ny værdi.

5. Klik på OK og derefter på Yes (Ja) for at gemmeændringerne.
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Tilføjelse eller fjernelse af trinnet Plate Read (Pladeaflæsning)
Tip: Når du tilføjer en pladeaflæsningskommando til et trin, ændres knappen til Remove Plate
Read (Fjern pladeaflæsning), når trinnet vælges.

Sådan tilføjes en pladeaflæsning til et trin

1. Vælg Before (Før) eller After (Efter) på rullelisten Insert Step (Indsæt trin) på værktøjslinjen.

2. På grafen skal du vælge det trin, som pladeaflæsningstrinnet skal indsættes før eller efter.

3. Klik på Add Plate Read (Tilføj pladeaflæsning) i venstre rude for at tilføje en pladeaflæsning til det
valgte trin.

4. Klik på OK og derefter på Yes (Ja) for at gemmeændringerne.

Sådan fjernes en pladeaflæsning fra et trin

u På grafen skal du vælge det trin, som indeholder pladeaflæsningen, og klikke på Remove Plate
Read (Fjern pladeaflæsning) i venstre rude.

Ændring af Step Options (Valgmuligheder for trin)
Sådan ændres valgmuligheder for trin for et valgt trin

1. Vælg det ønskede trin i grafen eller oversigtsruden.

2. I den venstre rude skal du klikke på Step Options (Valgmuligheder for trin) for at åbne
dialogboksen Step Options (Valgmuligheder for trin).

Alternativt kan du højreklikke på det ønskede trin i en af ruderne. Vælg derefter Step Options
(Valgmuligheder for trin) i den viste menu.

3. Sådan tilføjes, ændres eller fjernes valgmuligheder:

n Indtast en værdi i det relevante tekstfelt.

n Rediger en værdi i det specifikke tekstfelt.

n Markér eller fjern markeringen i et afkrydsningsfelt.

4. Klik på OK for at gemmeændringerne og lukke dialogboksen Step Options (Valgmuligheder for
trin).

5. Klik på OK og derefter på Yes (Ja) for at gemme protokollen.
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Sletning af et trin
Sådan slettes et trin i protokollen

1. Vælg trinnet i grafen eller oversigtsruden.

2. Klik på Delete Step (Slet trin) i venstre rude for at slette det valgte trin.

3. Klik på OK og derefter på Yes (Ja) for at gemme protokollen.

Kopiering, eksport eller udskrivning af en protokol
Sådan kopieres en protokol

u Højreklik på protokoloversigten, og vælg Copy Protocol (Kopiér protokol).

Protokoloversigten kan indsættes i en .txt-, .xls-, .doc- eller .ppt-fil.

Sådan eksporteres en protokol

1. Højreklik på protokoloversigten, og vælg Export Protocol (Eksportér protokol).

Dialogboksen Save As (Gem som) vises.

2. (Valgfrit) Naviger til en mappe i Windows Stifinder, hvor protokolfilen skal gemmes.

3. Skriv et navn til den eksporterede protokolfil i File Name (Filnavn).

4. Klik på Save (Gem).

Sådan udskrives en protokol

u Højreklik på protokoloversigten, og vælg Print (Udskriv).

Protokoloversigten kan udskrives på standardprinteren.
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Oprettelse af en protokol med Protocol AutoWriter
(Automatisk protokolskriver)

Vigtigt: Bio-Rad giver ingen garanti for, at kørsel af en protokol, som er oprettet med Protocol
AutoWriter (Automatisk protokolskriver), altid vil resultere i et real-time PCR-produkt.

Protocol AutoWriter (Automatisk protokolskriver) i CFX Manager Dx genererer cyklusprotokoller
automatisk baseret på følgende inputparametre:

n Amplicon length (Amplikonlængde) – PCR-produktets forventede længde

n Annealing temperature (Hydbridiseringstemperatur) – reaktionens Ta for de anvendte primere

Hvis Ta er ukendt, kan du bruge Ta calculator (Ta-beregner) til at beregne det automatisk baseret
på primersekvenserne.

Bemærk: Ta tilpasses fra oplysningerne om primersmeltetemperaturen (Tm), som er baseret
på det valgte enzym og protokolhastigheden.

n Enzyme type (Enzymtype) – DNA-polymeraseenzymet (iTaq™, iProof™ DNA-polymerase eller
Other (Andet))

Hvis du bruger et andet enzym end iTag eller iProof DNA-polymerase, kan du angive yderligere
oplysninger, herunder gradientområde, hot-start-aktiveringstid (i sek.) og endelig forlængelsestid
(i sek.).

n Run speed (Kørselshastighed) – reaktionshastigheden (standard, hurtig eller ultrahurtig)

Protocol AutoWriter (Automatisk protokolskriver) optimerer protokollen afhængigt af den valgte
hastighedsindstilling. Den samlede kørselstid bestemmes af antallet af trin og cyklusser,
inkubationstiden for hvert trin og den tid, det tager at nå ensartethed ved måltemperaturen.

På baggrund af de indtastede parametre og standard-PCR-retningslinjer genererer Protocol
AutoWriter (Automatisk protokolskriver) automatisk en tilpasset PCR-protokol med hot-start, første
denaturering, hybridisering og yderligere trin. Du kan derefter se en grafisk repræsentation af den
foreslåede protokol og redigere, køre eller gemme protokollen.
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Sådan oprettes en ny protokol med Protocol AutoWriter (Automatisk protokolskriver) i
CFX Manager Dx

1. Vælg Tools > Protocol AutoWriter (Værktøjer > Automatisk protokolskriver) i startvinduet.

Dialogboksen Protocol AutoWriter (Automatisk protokolskriver) åbnes.

2. Gør følgende i sektionen Enter Target Values/Enzyme (Angiv målværdier/enzym):

n Indtast hybridiseringstemperaturen (Ta) for primerne, hvis den kendes.

Tip: Se Brug af Ta Calculator (Ta-beregner) på side 100 for flere oplysninger.

Bemærk: For oplysninger om de beregninger, der anvendes i Ta calculator (Ta-
beregner), henvises til Breslauer et al. 1986.

n Angiv amplikonlængden i basepar (bp).

n Vælg en enzymtype på listen over muligheder (iTaq™DNA polymerase, iProof™ DNA
polymerase eller Other (Andet)).

Tip: Hvis du vælger Other (Andet) som enzymtype, aktiveres parametrene i sektionen
Additional Parameters (Optional) (Yderligere parametre (valgfrit)).
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3. Hvis du vælger Other (Andet) som enzymtype, kan du tilføje en eller alle af følgende parametre i
protokollen:

n Gradient range (Gradientområde)

n Hot start activation temperature (Hot-start-aktiveringstemperatur)

n Final extension time (Endelig forlængelsestid)

4. I sektionen Type kan du flytte skyderen for at vælge en protokolhastighed (Standard, Fast (Hurtig)
eller Ultrafast (Ultrahurtig)). CFX Manager Dx tilpasser den totale kørselstid.

5. Vælg den PCR-type, der skal udføres (Real-time PCR (Realtids-PCR) er standard).

Med Real-time PCR (Realtids-PCR) tilføjer CFX Manager Dx et pladeaflæsningstrin til indsamling
af fluorescensdata.

6. Gennemgå protokollen i sektionen Preview (Forhåndsvisning). Du kan foretage ændringer efter
behov.

7. Gør et af følgende:

n Klik på OK for at gemme den nye protokol. Efter lagring åbnes protokollen i Startup Wizard
(Guiden Opstart). Klik på Edit Selected (Rediger valgte) for at foretage ændringer i
protokollen. Det kan for eksempel være nødvendigt at ændre lågets temperatur og
prøvevolumenet.

n Klik på Cancel (Annuller) for at lukke vinduet uden at gemme protokollen.

Brug af Ta Calculator (Ta-beregner)
Hvis hybridiseringstemperaturen for primeren er ukendt, kan du bruge Ta Calculator (Ta-beregner) til
at beregne værdien. Du kan bruge værdien i Protocol AutoWriter (Automatisk protokolskriver)) eller i
Protocol Editor (Protokoleditor) til at oprette din protokol.
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Om Ta Calculator (Ta-beregner)
Ta Calculator (Ta-beregner) beregner Tm-værdien for hver primer såvel som Ta-værdien for
protokollen ved standardhastighed.

Ta for protokollen er baseret på de gennemsnitlige primer Tm-værdier, hvor følgende regler er
anvendt:

n Hvis differencen mellem primer Tm-værdierne er under >4 °C, er Ta = (den mindste af de to primer
Tm-værdier + 2) – 4 °C

n Hvis forskellen mellem Tm-værdierne er ≤4 °C, er Ta = (gennemsnit af primer Tm-værdierne) –
4 °C

Basepar-tællemetode

For hver primer bruger Ta-beregneren basepar-tællemetoden for sekvenser på 14 eller færre basepar
(bp).

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

hvor w, x, y og z er tallene for disse baser for henholdsvis A, T, G og C i sekvensen.

Nærmeste nabo-metode

For sekvenser, der er længere end 14 bp, bruges nærmeste nabo-metoden. I nærmeste nabo-
metoden er beregningerne af smeltetemperaturen baseret på termodynamiske forhold mellem entropi
(orden eller et mål for tilfældighed i oligonukleotidet), entalpi (varme afgivet eller absorberet af
oligonukleotidet), fri energi og temperatur.

∆H = ∆G + T* ∆S

hvor:

n ∆H = entalpiværdi, cal/mol*K

n T = temperatur, Kelvin

n ∆S = entropiværdi, cal/mol*K

n ∆G = Gibbs frie energi i cal/mol*K

Ændringen i entropi og entalpi beregnes direkte ved at addere værdierne for nukleotidpar vist i Tabel
12 (Breslauer et al. 1986).
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Forholdet mellem den frie energi og koncentrationen af reaktanter og produkter i ligevægt gives af:

∆G = R*T*ln ((DNA * Primer)/(DNA + Primer))

hvor R er gaskonstanten (1,986 cal/mol*K).

Udskiftning af G i de to ligninger og opløsning for T giver

T = ∆H/(∆S + R*Ln((DNA * Primer)/(DNA + Primer)))

når det antages, at koncentrationen af DNA og DNA-primerkomplekset er lig med hinanden.

Det er blevet bestemt empirisk, at der er en ændring på 5 kcal fri energi (3,4 kcal) (Sugimoto et al.
1996) under transitionen fra enkeltstrenget til B-formet DNA. Dette er antageligt helix-initieringsenergi.
Endelig giver tilføjelse af en justering for salt den ligning, som bruges af Ta-beregneren:

T = (∆H – 5(kcal/K*mol))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (saltmolaritet)

Der er ikke behov for en justeringskonstant for saltkoncentrationen, da de forskellige parametre blev
bestemt ved for 1 M NaCl, og loggen10 på 1 er nul.

De termodynamiske beregninger antager, at hybridisering sker ved pH 7,0. Tm-beregningerne
antager, at sekvenserne ikke er symmetriske og indeholder mindst et G eller C.

Den oligonukleotide sekvens skal være mindst 14 baser lang for at kunne give rimelige Tm-værdier.
Mindre end 14 baser bruger basepar-tællemetoden (se Tabel 12 nedenfor).

Interaktion ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

Tabel 12. Breslauer-interaktionskonstanter
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Interaktion ∆H ∆S ∆G

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

Tabel 12. Breslauer-interaktionskonstanter, fortsat

Driftsvejledning | 103



Kapitel 6 Oprettelse af protokoller

Brug af Ta Calculator (Ta-beregner)

Sådan anvendes Ta Calculator (Ta-beregner)

1. For at åbne Ta Calculator (Ta-beregner) skal du gøre et af følgende:

n Klik på Ta Calculator (Ta-beregner) i Protocol AutoWriter (Automatisk protokolskriver).

n Vælg Tools > Ta Calculator (Værktøjer > Ta-beregner) i startvinduet.

Dialogboksen Ta Calculator (Ta-beregner) vises.

2. Skriv eller indsæt forward primer-sekvensen i tekstfeltet Forward Primer.

Tip: Du kan desuden bruge knapperne A, T, G og C i venstre side af dialogboksen til at
indtaste sekvensen.

3. Skriv eller indsæt reverse primer-sekvensen i tekstfeltet Reverse Primer.
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4. Klik på Calculate (Beregn).

Ta Calculator (Ta-beregner) beregner og viser Tm for hver primer og de gennemsnitlige Tm- og Ta-
værdier, for eksempel:

Hvis primer-Tm-værdierne er mere end 4 °C fra hinanden, anvender Protocol AutoWriter
(Automatisk protokolskriver) den laveste primer-Tm-værdi + 2 °C som udgangspunkt for
beregning af Ta-værdien, hvilket kan ændres yderligere ved at modificere enzym- og
reaktionshastighed.

Ta Calculator (Ta-beregner) genererer en hybridiseringstemperatur for standardhastighed med
iTaq DNA-polymerase. Når der bruges et andet enzym, justerer hastighedsindstillingerne
automatisk Ta.

5. Gør et af følgende:

n Klik på OK, hvis Ta Calculator (Ta-beregner) blev åbnet fra Protocol AutoWriter (Automatisk
protokolskriver). Du vender tilbage til Protocol AutoWriter (Automatisk protokolskriver).
Hybridiseringstemperaturen modificeres automatisk.

n Hvis Ta Calculator (Ta-beregner) blev åbnet fra menuen Tools (Værktøjer), skal du registrere
beregningerne og klikke på Cancel (Annuller) for at lukke beregneren.
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En pladefil indeholder oplysninger om kørselsparametre som for eksempel scanningstilstand,
fluoroforer og brøndenes indhold. Efter kørslen linker CFX Manager™ Dx softwaren brøndenes
indhold til de fluorescensdata, der blev indsamlet under kørslen, og igangsætter den tilsvarende
analyse i vinduet Data Analysis (Dataanalyse). For eksempel anvendes brønde, der indeholder
standardprøvetype, til at generere en standardkurve.

CFX Manager Dx software tilbyder to muligheder til oprettelse af plader: Plate Editor (Pladeeditor) til
real-time PCR-kørsler og Setup Wizard (Guiden Opsætning) til normaliseret genekspressionsanalyse.

Plate Editor (Pladeeditor) indeholder følgende funktioner:

n Standardfluoroforer og prøvetyper til tildeling til pladebrønde

n Mulighed for at indstille referencemålsekvens (target) og kontrolprøve til genekspressionsanalyse

n Mulighed for at redigere pladens opsætning før, under og efter en kørsel

n Mulighed for at gemme pladefilen til genanvendelse

n Mulighed for at udskrive pladefilen på en standardprinter

Setup Wizard (Guiden Opsætning) fører brugeren gennem de trin, der skal til for at oprette et
pladelayout til normaliseret genekspressionsanalyse. Setup Wizard (Guiden Opsætning) kan bruges
før, under og efter en kørsel.
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Vinduet Plate Editor (Pladeeditor)
Du kan bruge Plate Editor (Pladeeditor) til at oprette brugerdefinerede plader eller til at redigere
eksisterende plader.

1. Menulinjen giver hurtig adgang til menuen File (Fil) og Settings (Indstillinger) samt til
valgmuligheder i værktøjerne til pladeredigering.

2. Værktøjslinjen giver hurtig adgang til vigtige pladeisætningsfunktioner.

3. Hovedvinduet viser oversigt og valgmuligheder for plader, efterhånden som de anvendes.

4. Den højre rude viser valgmuligheder, som du kan bruge til at tilpasse pladen.

5. Den nederste rude viser pladetype og giver hurtig adgang til visningsindstillinger.

FORKLARING
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Kommandoer i menuen File (Fil)
Save (Gem) – gemmer pladedatafilen på den placering, der er angivet på fanen File (Fil) i
dialogboksen User Preferences (Brugerpræferencer). SeÆndring af standardindstillinger for filer på
side 63 for yderligere oplysninger. Dette menupunkt er kun tilgængeligt, når der oprettes en ny
pladefil.

Save As (Gem som) – gemmer den aktuelle pladedatafil med et nyt navn., du angiver. Dette
menupunkt er kun tilgængeligt, når der oprettes en ny pladefil.

Extract Plate (Ekstraher plade) – åbner en dialogboks, hvor du kan ekstrahere/gemme pladefilen
(.pltd). Dette menupunkt er kun tilgængeligt, når der vises eller redigeres en eksisterende pladefil.

Print (Udskriv) – udskriver den åbne pladedatafil.

Close (Luk) – lukker Plate Editor (Pladeeditor).

Kommandoer i menuen Settings (Indstillinger)
Plate Size (Pladestørrelse) – giver mulighed for at vælge pladestørrelse for kørslen.

Bemærk: CFX Dx system kan kun bruge en plade med 96 brønde.

Plate Type (Pladetype) – giver dig mulighed for at vælge den type af brønde i pladen, som indeholder
dine prøver, enten BRWhite (BR Hvid) eller BR Clear (BR Klar). For at opnå en nøjagtig dataanalyse
skal den valgte pladetype være den samme som den pladetype, der anvendes i kørslen.

Number Convention (Nummerkonvention) – giver dig mulighed for at vælge eller fravælge visning af
enheder i videnskabelig notation. Standarden er visning af enheder i videnskabelig notation.

Units (Enheder) – giver dig mulighed for at vælge de enheder, der skal vises i regnearkene ved
udførelse af kvantifikation af ukendte kontra en standardkurve.

Kommandoer i menuen Editing Tools (Redigeringsværktøjer)
Setup Wizard (Guiden Opsætning) – åbner Setup Wizard (Guiden Opsætning), hvor der kan
defineres layout- og analyseparametre for den aktuelle plade. Du kan bruge Setup Wizard (Guiden
Opsætning) før, under og efter en kørsel.

Spreadsheet View/Importer (Visning/import af regneark) – åbner dialogboksen View (Vis), der viser
pladens layout som en skabelon i regnearksformat. Du kan bruge denne dialogboks til at eksportere
eller importere pladeskabelondata i .csv-format.

Flip Plate (Vend plade) – vender pladens indhold 180o.
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Kommandoer på værktøjslinjen

Gemmer den aktuelle pladefil.

Viser en rulleliste, hvor du kan forøge eller formindske forstørrelsen af
pladevisningen.

Viser en rulleliste, hvor du kan vælge en scanningstilstand, som instruerer
instrumentet i, hvilke kanaler det skal indsamle fluorescensdata fra under en
kørsel.

Åbner Well Groups Manager (Brøndgruppeadministrator), som kan bruges
til at oprette brøndgrupper for den aktuelle plade.

Viser en dialogboks, hvor du kan vælge farver og symboler for
amplifikationskurvelinjerne.

Åbner dialogboksen View (Vis), der viser pladens layout som en ska-
belon i regnearksformat. Du kan bruge denne dialogboks til at ekspor-
tere eller importere pladeskabelondata i .csv-format.

Viser de nødvendige trin til opsætning af en plade og fyldning af brøn-
dene.
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Oprettelse af en pladefil med Plate Editor (Pladeeditor)
Der kan oprettes brugerdefinerede pladefiler med Plate Editor (Pladeeditor). Du kan også redigere og
gemme tidligere gemte pladefiler eller eksempler på pladefiler, der leveres sammen med CFX
Manager Dx software.

For at oprette en ny pladefil skal du gøre følgende:

n Åben en pladefil i Plate Editor (Pladeeditor).

n Vælg pladetypen.

Bemærk: Pladetypen for pladefilen skal være den samme som pladen i reaktionsmodulet.

n Vælg den scanningstilstand, der skal bruges i protokollen.

n Vælg den fluorofor, der skal bruges i pladen.

n Vælg prøvetype, målsekvenser (targets) og prøver.

n Vælg replikater, hvis relevant.

n Gem pladens layout.

Tip: For oplysninger om at oprette en ny plade fra tidligere gemte eller eksempler på pladefiler
henvises til Åbning af en eksisterende pladefil i Plate Editor (Pladeeditor) på side 113.

Åbning af en ny pladefil i Plate Editor (Pladeeditor)
I CFX Manager Dx software kan du åbne en ny pladefil på forskellige måder:

n Fra startvinduet

n Fra dialogboksen Startup Wizard (Guiden Opstart)

n Fra dialogboksen Run Setup (Kørselsopsætning)

Sådan åbnes en ny pladefil fra startvinduet

u Vælg File > New > Plate (Fil > Ny > Plade).

Vinduet Plate Editor (Pladeeditor) åbner og viser standardpladefilen for det valgte instrument.

Tip: For information om indstilling af standardpladefilen henvises til Ændring af
standardindstillinger for filer på side 63.
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Sådan åbnes en ny pladefil fra Startup Wizard (Guiden Opstart)

1. Gør et af følgende i startvinduet for at åbne Startup Wizard (Guiden Opstart), hvis den ikke
allerede er åben:

n Vælg View > Startup Wizard (Vis > Guiden Opstart).

n Klik på Startup Wizard (Guiden Opstart) på værktøjslinjen.

Som standard viser Startup Wizard (Guiden Opstart) fanen Run setup (Kørselsopsætning), når
instrumentet CFX96™ er valgt.

2. Om nødvendigt vælges instrumenttypen på rullelisten.

3. For at oprette en ny plade skal du klikke på User-defined (Brugerdefineret) som kørselstype.

Dialogboksen Run Setup (Kørselsopsætning) åbner med fanen Protocol (Protokol).

4. Klik på fanen Plate (Plade) og klik på Create New (Opret ny).

Vinduet Plate Editor (Pladeeditor) åbner og viser standardpladelayoutet for det valgte instrument.

Sådan åbnes en ny pladefil fra dialogboksen Run Setup (Kørselsopsætning)

1. Gør et af følgende i startvinduet for at åbne dialogboksen Run Setup (Kørselsopsætning):

n Vælg Run > User-defined Run (Kør > Brugerdefineret kørsel).

n Klik på User-defined Run (Brugerdefineret kørsel) på værktøjslinjen.

Dialogboksen Run Setup (Kørselsopsætning) åbner med fanen Protocol (Protokol).

2. For at oprette en ny plade skal du klikke på fanen Plate (Plade) og klikke på Create New (Opret
ny).

Vinduet Plate Editor (Pladeeditor) åbner og viser standardpladelayoutet for det valgte instrument.
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Åbning af en eksisterende pladefil i Plate Editor (Pladeeditor)
CFXManager Dx software leveres med eksempler på pladefiler, som du kan redigere og gemme som
en ny plade. Du kan også oprette en ny pladefil fra en tidligere gemt pladefil.

Sådan åbnes et eksempel på en pladefil

1. Vælg File > Open > Plate (Fil > Åbn > Plade).

Windows Stifinder åbner med placeringen af mappen med CFX Manager Dx prøvefiler.

2. Åbn mappen Sample (Prøver) og åbn derefter mappen Plates (Plader).

3. Vælg den ønskede plade, og klik på Open (Åbn).

Eksemplet på pladefilen åbnes i vinduet Plate Editor (Pladeeditor).

4. Vælg File > Save As (Fil > Gem som), og gem pladefilen med et nyt navn eller i en ny mappe.

Sådan åbnes en tidligere gemt pladefil

1. I startvinduet skal du vælge File > Open > Plate (Fil > Åbn > Plade), navigere til og vælge den
ønskede plade og klikke på Open (Åbn).

Den ønskede plade åbnes i vinduet Plate Editor (Pladeeditor).

2. Vælg File > Save As (Fil > Gem som), og gem pladefilen med et nyt navn eller i en ny mappe.
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Opsætning af en ny pladefil
Tip: Hvis pladefilen allerede indeholder de påkrævede parametre (hvis du for eksempel redigerer
en prøve eller en eksisterende pladefil), kan du springe dette afsnit over. Fortsæt til Tildeling af
valgfri parametre til pladefilen på side 120.

Nye pladefiler kræver følgende parametre:

n Pladestørrelse

n Pladetype

n Scanningstilstand

n En fluorofor (farve)

n En prøvetype

Valg af pladestørrelse og -type

Vigtigt: Der skal vælges en pladestørrelse under pladeopsætningen. Pladestørrelsen kan ikke
ændres under eller efter en kørsel.

Softwaren anvender pladestørrelsen og -typen på alle brønde under kørslen. Kontrollér, at den valgte
pladestørrelse er den samme som den plade, der vil blive brugt i kørslen.

Bio-Rads CFX96- og CFX96 DeepWell instrumenter er fabrikskalibrerede til mange fluorescerende
farvestof- og pladekombinationer. Kalibreringen er specifik for instrumentet, farvestoffet og
pladetypen. Kontrollér, at den fluorofor, som skal anvendes, er kalibreret til den valgte pladetype.

Valg af scanningstilstand

CFX96 og CFX96 DeepWell systemerne exciterer og detekterer fluoroforer i fem kanaler. Alle
systemerne bruger flere scanningstilstande for dataoptagelse til at indsamle fluorescensdata under en
kørsel.

CFX Manager Dx software har tre scanningstilstande:

n All Channels (Alle kanaler)

o Scanner kanal 1 til og med 5 på CFX96 og CFX96 DeepWell systemerne
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n SYBR® /FAM

o Scanner kun kanal 1

o Udfører en hurtig scanning

n FRET

o Scanner kun FRET-kanalen

o Udfører en hurtig scanning

Valg af fluoroforer

Vigtigt: Før kørslen påbegyndes, verificerer CFX Manager Dx software, at de fluoroforer, der
blev specificeret på pladen, er kalibreret på det pågældende instrument. Du kan ikke køre plader,
hvis de indeholder fluoroforer, der ikke er blevet kalibreret på instrumentet.

Du skal indlæse mindst én fluorofor i pladelayoutet før kørslen. Du kan tilføje så mange fluoroforer,
som der er behov for på dette tidspunkt, men pladen skal indeholde mindst én fluorofor. De valgte
fluoroforer vises som valgmuligheder for målsekvenser (targets) under Target Names (Navne på
målsekvenser).

Du kan bruge dialogboksen Select Fluorophores (Vælg fluoroforer) til at indlæse fluoroforer (eller
pladefarvestoffer) i betjeningselementerne for brøndisætning i Plate Editor (Pladeeditor). De
fluoroforer, der vises i dialogboksen Select Fluorophores (Vælg fluoroforer), afhænger af den valgte
scanningstilstand:

n All Channels (Alle kanaler)

Alle tilgængelig fluoroforer vises.

Tip: Du kan tilføje så mange fluoroforer, som der er behov for, men du kan kun anvende én
fluorofor pr. kanal i hver brønd.

n SYBR®/FAM

Kun fluoroforerne i kanal 1 vises.

n FRET

Kun fluoroforen i kanal 6 vises.

Tip: FRET-fluoroforen i kanal 6 vises kun, når FRET er den valgte scanningstilstand. Den er
ikke tilgængelig i scanningstilstanden All Channels (Alle kanaler).

Bemærk: Du kan ikke tilføje eller fjerne fluoroforer direkte i dialogboksen Select Fluorophore
(Vælg fluorofor). Du skal kalibrere nye fluoroforer på instrumentet ved hjælp af Calibration Wizard
(Guiden Kalibrering). Efter kalibrering tilføjes den nye fluorofor automatisk til denne liste.
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Valg af prøvetyper

Vigtigt: Du skal vælge mindst én prøvetype, der skal tildeles til brøndene på pladen før kørslen.

CFX Manager Dx software giver mulighed for at vælge mellem fem prøvetyper:

n Unknown (Ukendt)

n Standard

n NTC (ingen skabelonkontrol)

n Positive Control (Positiv kontrol)

n Negative Control (Negativ kontrol)

n NRT (ingen revers transkriptase)

Du tildeler prøvetyperne til pladebrøndene.

Opsætning af en ny plade

Sådan opsættes en ny plade

1. Åbn en ny plade i vinduet Plate Editor (Pladeeditor).

2. For at indstille pladestørrelsen skal du vælge Settings > Plate Size (Indstillinger > Pladestørrelse)
og vælge den ønskede pladestørrelse i rullemenuen.

3. For at indstille pladetypen skal du vælge Settings > Plate Type (Indstillinger > Pladetype) og
vælge enten BRWhite (BR Hvid) eller BR Clear (BR Klar) i rullemenuen.

4. Du kan også ændre nummerkonventionen og de viste enheder i menuen Settings (Indstillinger):

n For at ændre talkonventionen skal du vælge Settings > Nummer Convention (Indstillinger >
Talkonvention) og vælge Scientific Notation (Videnskabelig notation).

Tip: Scientific Notation (Videnskabelig notation) er valgt som standard. I dette tilfælde vil
valg af Scientific Notation (Videnskabelig notation) rydde standarden og indstille
nummerkonventionen til standardformat.

n For at ændre visningsenhederne skal du vælge Settings > Units (Indstillinger > Enheder) og
vælge en ny enhedsværdi.

5. For at indstille scanningstilstand skal du vælge den ønskede scanningstilstand på rullelisten Scan
Mode (Scanningstilstand) i værktøjslinjen i vinduet Plate Editor (Pladeeditor).
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6. Vælg de nødvendige fluoroforer til pladen:

a. I højre rude klikkes på Select Fluorophores (Vælg fluoroforer).

Dialogboksen Select Fluorophores (Vælg fluoroforer) åbnes. Her vises de fluoroforer, der er
tilgængelige for den scanningstilstand, du valgte i Trin 5, for eksempel:

b. For at vælge en fluorofor skal du klikke på dens afkrydsningsfelt Selected (Valgt).

Tip: For at fjerne en fluorofor fra listen skal du fjerne markeringen i det relevante
afkrydsningsfelt Selected (Valgt).

c. For at ændre visningsfarven for fluoroforen skal du klikke i dens felt Color (Farve).

Bemærk: Den valgte farve repræsenterer fluoroforen i vinduet Plate Editor (Pladeeditor)
såvel som i diagrammerne for Data Analysis (Dataanalyse).

d. Vælg den ønskede farve i dialogboksen Color (Farve), eller klik på Define Custom Colors
(Definer brugerdefinerede farver) og opret en ny farve, der skal repræsentere fluoroforen.

e. Klik på OK for at gemmeændringerne og lukke dialogboksen Select Fluorophores (Vælg
fluoroforer).
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7. Du skal vælge mindst en brønd, der kan sættes en prøvetype i. Brønd A1 er valgt som standard.

I ruden Plate (Plade) gøres et af følgende:

n For at indlæse flere brønde, der støder op til hinanden, skal du klikke på en brønd og trække
til den sidste brønd.

n For at indlæse flere brønde, der ikke støder op til hinanden, skal du holde Ctrl-tasten nede og
klikke på de enkelte brønde.

n For at isætte en hel kolonne med samme prøvetype skal du klikke på kolonnens nummer.

n For at isætte en hel række skal du klikke på rækkens nummer.

n For at isætte hele pladen skal du klikke i øverste venstre hjørne af pladen.

For eksempel:

8. Tildel en prøvetype til den eller de valgte brønde i rullemenuen Sample Type (Prøvetype).

9. Tildel mindst en fluorofor til alle brønde, der indeholder en prøvetype. Du kan tildele mere end én
fluorofor til en brønd eller gruppe af brønde.
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Bemærk: Du kan kun tildele én fluorofor pr. kanal. Du kan ikke tildele mere end én fluorofor
fra samme kanal til den samme brønd.

Tip: Du kan tilknytte en målsekvens (target) til fluoroforen, eller du kan tildele fluoroforen
alene til brønden på dette tidspunkt og tilknytte en målsekvens (target) til fluoroforen, når du
har kørt eksperimentet.

n Hvis du kun vil tildele en fluorofor til de valgte brønde, skal du markere afkrydsningsfeltet
Load (Indlæs) i sektionen Target Names (Navne på målsekvenser) i højre rude for den
specifikke fluorofor.

n For at tilknytte en målsekvens (target) til en fluorofor skal du vælge et navn på en målsekvens
(target) på rullelisten for den specifikke fluorofor i sektionen Target Names (Navne på
målsekvenser). Softwaren markerer automatisk afkrydsningsfeltet Load (Indlæs).

10. For brønde, der indeholder prøvetypen Standard, skal der indlæses en koncentration. Hver brønd
kan have forskellige koncentrationsværdier. Som standard indlæser CFX Manager Dx software
en koncentration på 1,00E+06 for alle brønde med prøvetypen Standard. Du kan ændre værdien,
hvis det er nødvendigt.

a. I ruden Plate (Plade) vælges en Standard brønd eller gruppe af brønde.

b. I sektionen Concentration (Koncentration) skal du klikke på Load (Indlæs) for at indlæse
værdien i den eller de valgte brønde.

c. (Valgfrit) Du kan indlæse en anden koncentration ved at indtaste den nye værdi i tekstfeltet
Concentration (Koncentration) og trykke på Enter.

d. Udfør dette trin for alle brønde med prøvetypen Standard.

Tip: For at isætte den samme koncentration i alle standardbrønde skal du sikre, at <All>
(Alle) vises på rullelisten under værdien Concentration (Koncentration). For at isætte
den samme koncentrationsværdi i alle brønde med en specifik fluorofor skal du klikke på
rullelisten og vælge fluoroforen.

11. Klik på OK for at gemme den nye plade.
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Tildeling af valgfri parametre til pladefilen
En pladefil indeholder oplysninger om indholdet i hver af de brønde, der isættes med prøve til en
kørsel. Efter kørslen sammenkæder CFX Manager Dx software brøndens indhold med de
fluorescensdata, der blev indsamlet under protokollen, og udfører den relevante analyse i vinduet
Data Analysis (Dataanalyse).

I CFX Manager Dx kan du tildele parametre til hver brønd på pladen før, under og selv efter kørslen af
eksperimenter. Parametrene kan tildeles til en eksisterende pladefil eller til en ny pladefil. Disse
parametre omfatter:

n Target names (Navne på målsekvenser) – interessemålet/-målene (gener eller sekvenser) i hver
af de isatte brønde.

n Sample names (Prøvenavne) – den identifikator eller betingelse, der svarer til prøven i hver af de
isatte brønde, som for eksempel 0Hr, 1Hr eller 2Hr.

Tip: Navne på målsekvenser (targets) og prøvenavne skal være de samme på tværs af
brøndene for at kunne sammenligne data på fanen Gene Expression (Genekspression) i
vinduet Data Analysis (Dataanalyse). Hvert af disse navne skal skrives med den samme
anvendelse af store bogstaver, tegnsætning og mellemrum. For eksempel er "Actin" ikke det
samme som "actin", "2Hr" er ikke det samme som "2 hr." og "Mouse 1" er ikke det samme
som "mouse1". For at sikre en konsekvent navngivning kan navnene indtastes i sektionen
Libraries (Biblioteker) under User > User Preferences > Plate (Bruger > Brugerpræferencer >
Plade), der findes i startvinduet.

n Biological sets (Biologiske sæt) – den identifikator eller betingelse, der svarer til et sæt af
brønde.

n Replicates (Replikater) – hver brønd som anvendes til at analysere den samme kombination af
prøve og målsekvens (target), med andre ord replikerede qPCR-reaktioner.

n Dilution series (Fortyndingsserier) – den mængde der skal til for at ændre koncentrationen af
standardprøvetypen i en replikatgruppe for at oprette standardkurve-data til analyse.

Tildeling af en målsekvens (target) til brønde
Tip: Du kan tildele det sammemålsekvensnavn (target) til en enkelt brønd eller til flere brønde.
Du kan også tildele flere målsekvenser (targets) til den samme brønd.

Sådan tildeles en målsekvens (target) til en brønd eller en gruppe brønde

1. Kontroller i Plate Editor (Pladeeditor), at brønden eller gruppen af brønde er tildelt en prøvetype.

Se Valg af prøvetyper på side 116 for oplysninger om tildeling af prøvetyper til brønde.
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2. Vælg brønden eller gruppen af brønde i ruden med pladen:

n Vælg en enkelt brønd ved at klikke på brønden.

n For at vælge flere brønde, der støder op til hinanden, skal du klikke på en brønd og trække til
den sidste brønd.

n For at vælge flere brønde, der ikke støder op til hinanden, skal du holde Ctrl-tasten nede og
klikke på de enkelte brønde.

n For at vælge en hel kolonne med samme prøvetype skal du klikke på kolonnens nummer.

n For at vælge en hel række skal du klikke på rækkens nummer.

3. Vælg et navn på rullelisten Target Name (Navn på målsekvens) i højre rude for hver valgt
fluorofor.

4. Gentag Trin 3 for hver brønd eller gruppe af brønde, der skal tildeles en målsekvens (target) til.

Tip: Du kan tildele det samme eller et andet navn på en målsekvens (target) til hver valgt
fluorofor.

5. Klik på OK for at acceptere ændringerne og gemme pladen.

Sådan fjernes et navn på en målsekvens (target)

u Et navn på en målsekvens (target) kan fjernes fra den valgte brønd eller gruppe af brønde ved at
fjerne markeringen i afkrydsningsfeltet Load (Indlæs).

Vigtigt: Fjernelse af et navn på en målsekvens (target) fra en brønd fjerner også dens tilknyttede
fluorofor. Vær forsigtig, når du fjerner et navn på en målsekvens (target) fra en brønd.

Sådan tilføjes et navn på en målsekvens (target) til listen

u Et navn på en målsekvens (target) kan tilføjes til rullelisten på en af følgende måder:

n Indtast et navn på rullelisten Target Name (Navn på målsekvens), og tryk på Enter.

Tip: De navne på målsekvenser (targets), du tilføjer på én liste, vises på alle andre lister
over målsekvenser (targets).

n Klik på det grønne +-symbol til højre for rullelisten, indtast et navn på en målsekvens (target),
og tryk på Enter.
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n Klik på User Preferences (Brugerpræferencer) på værktøjslinjen, og tilføj navnet til biblioteket
Target Names (Navne på målsekvenser) på fanen Plate (Plade).

Vigtigt: Navne på målsekvenser (targets), du tilføjer på rullelisten, er kun tilgængelige for
den aktuelle plade, og kun hvis du tildeler navnet til en brønd og gemmer pladelayoutet. Hvis
du ikke tildeler navnet til en brønd og gemmer pladelayoutet, gemmes navnet ikke og er ikke
tilgængeligt til fremtidig brug. For at tilføje et navn på en målsekvens (target) permanent skal
det også tilføjes til biblioteket Target Names (Navne på målsekvenser) vha. dialogboksen
User Preferences (Brugerpræferencer). Navne, du tilføjer til biblioteket, er tilgængelige, når
Plate Editor (Pladeeditor) åbnes igen. Se Indstilling af standardparametre for plader på side
66 for yderligere oplysninger.

Sådan slettes et navn på en målsekvens (target) fra listen

1. Klik på User Preferences (Brugerpræferencer) på værktøjslinjen.

Dialogboksen User Preferences (Brugerpræferencer) vises med fanen Plate (Plade) åben.

2. Vælg det navn, der skal slettes, i biblioteket Target Names (Navne på målsekvenser) på fanen
Plate (Plade), og tryk på tasten Delete.

3. Klik på OK for at gemmeændringerne og lukke dialogboksen User Preferences
(Brugerpræferencer).

Vigtigt: Du kan ikke slette navne på målsekvenser (targets), du har gemt med en pladefil.
Tilpassede navne, du tilføjer på rullelisten Target Names (Navne på målsekvenser), og som
du ikke bruger og gemmer med pladen, fjernes automatisk fra listen. Navne, som slettes fra
biblioteket Target Names (Navne på målsekvenser), fjernes permanent fra softwaren og er
ikke længere tilgængelige for brugerne. Vær forsigtig, når du sletter navne på målsekvenser
(targets).

Tildeling af et prøvenavn til brønde
Bemærk: For at kunne tildele prøvenavn skal der tildeles mindst én fluorofor til de valgte brønde.
Hvis de valgte brønde ikke har fået tildelt en fluorofor, deaktiveres rullelisten Sample Names
(Prøvenavne). Se Tildeling af en målsekvens (target) til brønde på side 120 for at få oplysninger
om tildeling af fluoroforer.

Tip: Du kan kun tildele ét prøvenavn til hver brønd eller gruppe af brønde.

Sådan tildeles et prøvenavn til en brønd eller en gruppe af brønde

1. Sørg for, at brønden eller gruppen af brønde har fået tildelt en fluorofor i Plate Editor
(Pladeeditor).

2. Vælg brønden eller gruppen af brønde i pladeruden.
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3. Vælg et navn på rullelisten Sample Names (Prøvenavne) i højre rude.

4. Gentag Trin 3 for hver brønd eller gruppe af brønde, der skal tildeles et prøvenavn til.

5. Klik på OK for at acceptere ændringerne og gemme pladen.

Sådan fjernes et prøvenavn

u For at fjerne et prøvenavn fra en valgt brønd eller gruppe af brønde skal du fjerne markeringen i
afkrydsningsfeltet Load (Indlæs).

Sådan tilføjes et prøvenavn til listen

u For at tilføje et prøvenavn på rullelisten skal du gøre et af følgende:

n Indtast et navn på rullelisten Sample Names (Prøvenavne), og tryk på Enter.

n Klik på det grønne +-symbol til højre for rullelisten, og indtast et navn til prøven.

n Klik på User Preferences (Brugerpræferencer) på værktøjslinjen, og tilføj navnet til biblioteket
Sample Names (Prøvenavne) på fanen Plate (Plade).

Vigtigt: Prøvenavne, du tilføjer på rullelisten, er kun tilgængelige for den aktuelle plade, og
kun hvis du tildeler navnet til en brønd og gemmer pladens layout. Hvis du ikke tildeler navnet
til en brønd og gemmer pladelayoutet, gemmes navnet ikke og er ikke tilgængeligt til
fremtidig brug. For at tilføje et prøvenavn permanent skal det også tilføjes til biblioteket
Sample Names (Prøvenavne) ved hjælp af dialogboksen User Preferences
(Brugerpræferencer). Navne, du tilføjer til biblioteket, er tilgængelige, når Plate Editor
(Pladeeditor) åbnes igen. Se Indstilling af standardparametre for plader på side 66 for
yderligere oplysninger.

Sådan slettes et prøvenavn fra listen

1. Klik på User Preferences (Brugerpræferencer) på værktøjslinjen.

Dialogboksen User Preferences (Brugerpræferencer) vises med fanen Plate (Plade) åben.

2. Vælg det navn, der skal slettes, i biblioteket Sample Names (Prøvenavne) på fanen Plate (Plade),
og tryk på tasten Delete (Slet).
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3. Klik på OK for at gemmeændringerne og lukke dialogboksen User Preferences
(Brugerpræferencer).

Vigtigt: Du kan ikke slette prøvenavne, der blev gemt med en pladefil. Brugerdefinerede
navne, du tilføjer på rullelisten Sample Names (Prøvenavne) og som du ikke bruger og
gemmer med pladen, fjernes automatisk fra rullelisten. Navne, du sletter fra biblioteket
Sample Names (Prøvenavne), fjernes fra softwaren og er ikke længere tilgængelige for
brugerne. Vær forsigtig, når du sletter prøvenavne.

Tildeling af biologiske sæt til brønde
Bemærk: For at kunne tildele et biologisk sæt skal der tildeles mindst én fluorofor til de valgte
brønde. Tildeling af en fluorofor aktiverer rullelisten Biological Set Name (Navn på biologisk sæt).
Se Tildeling af en målsekvens (target) til brønde på side 120 for at få oplysninger om tildeling af
fluoroforer.

Tip: Du kan tildele ét biologisk sæt til hver brønd eller gruppe af brønde.

Sådan tildeles et biologisk sæt til en brønd eller gruppe af brønde

1. Markér afkrydsningsfeltet Biological Set (Biologisk sæt) under valgmulighederne for View (Vis)
nederst i vinduet Plate Editor (Pladeeditor).

2. Sørg for, at brønden eller gruppen af brønde har fået tildelt en fluorofor i Plate Editor
(Pladeeditor).

3. Vælg brønden eller gruppen af brønde i pladeruden.

4. Vælg et navn på rullelisten Biological Set (Biologisk sæt) i højre rude.

CFX Manager Dx software markerer automatisk afkrydsningsfeltet Load (Indlæs).

5. Gentag Trin 4 for hver brønd eller gruppe af brønde, til hvilke der skal tildeles et biologisk sæt.

6. Klik på OK for at acceptere ændringerne og gemme pladen.

Tip: Tildeling af navne til biologiske sæt aktiverer Biological Set Analysis Options
(Valgmuligheder for analyse af biologiske sæt) i dialogboksen Experiment Settings
(Eksperimentindstillinger), i hvilken der kan udføres prøveanalyse i en af fire konfigurationer.
SeÆndring af eksperimentindstillinger på side 131 for yderligere oplysninger.
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Sådan fjernes et biologisk sæt

u For at fjerne et biologisk sæt fra den valgte brønd eller gruppe af brønde skal du fjerne
markeringen i afkrydsningsfeltet Load (Indlæs).

Sådan tilføjes et biologisk sæt til listen

u For at tilføje et biologisk sæt til rullelisten skal du indtaste et navn i rullefeltet Biological Set Name
(Navn på biologisk sæt) og trykke på Enter.

Vigtigt: Navne på biologiske sæt, som tilføjes på rullelisten, er kun tilgængelige for den
aktuelle plade, og kun hvis du tildeler navnet til en brønd og gemmer pladernes layout. Hvis
navnet ikke tildeles til en brønd, og pladens layout ikke gemmes, gemmes navnet ikke og vil
ikke være tilgængeligt til fremtidig brug.

Sådan vises alle biologiske sæt på pladen

u Markér afkrydsningsfeltet Biological Set (Biologisk sæt) under valgmulighederne for View (Vis)
nederst i vinduet Editor.

Alle brønde viser navnet på deres biologiske sæt, hvis det er tildelt. Betjeningselementet
Biological Set Name (Navn på biologisk sæt) vises i højre rude.

For at skjule biologiske sæt skal du fjerne markeringen i afkrydsningsfeltet Biological Set
(Biologisk sæt) under valgmulighederne for View (Vis).

Tildeling af replikatnumre til brønde
Vigtigt: Hvis der skal tildeles replikatnumre, skal de valgte brønde have identisk brøndindhold.
Det vil sige, at de valgte brønde skal have samme prøvetype og fluorofor. Hvis relevant, skal de
desuden tildeles samme navne på målsekvenser og prøver og samme biologiske sæt. Hvis de
ikke er identiske, aktiveres denne valgmulighed ikke i CFX Manager Dx software.
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Sådan tildeles replikatnumre til en gruppe af brønde

1. Kontrollér, at indholdet af gruppen af brønde er identisk i Plate Editor (Pladeeditor).

2. Vælg målgruppen af brønde i pladeruden.

3. For at tildele det samme replikatnummer til alle valgte brønde skal du indtaste replikatnummeret i
feltet under Replicate # (Replikatnummer) i højre rude og vælge Load (Indlæs).

4. (Valgfrit) Sådan anvendes en replikatserie på et sæt valgte brønde:

a. Klik på Replicate Series (Replikatserie). Sektionen Replicate # (Replikatnummer) ændres til
at vise følgende valgmuligheder:

n Replicate size (Replikatstørrelse) – et tal, der repræsenterer antallet af brønde i hver
gruppe af replikater

n Starting Replicate # (Startreplikatnummer) – det første tal i replikatserien for den valgte
gruppe af replikater

Bemærk: CFXManager Dx software viser som standard startreplikatnummeret som et
tal, der er større end det sidste replikatnummer, som er tildelt i pladen. Hvis det seneste
replikatnummer, der er tildelt i pladen, for eksempel er fem, vil det næste startnummer
være seks. Du kan ændre startnummeret til et andet nummer, som ikke allerede er
tildelt.

n Isætningsretning (Horizontal (Vandret) eller Vertical (Lodret))

b. Klik på Apply (Anvend) for at anvende parametrene på serierne og vende tilbage til skærmen
Replicate # (Replikatnummer).

5. Klik på OK for at acceptere ændringerne og gemme pladen.
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Sådan fjernes en brønd fra en replikatserie

u Vælg den brønd eller den gruppe af brønde, som skal fjernes, og fjern markeringen i
afkrydsningsfeltet Replicate # Load (Indlæs replikatnummer).

Du kan også klikke på Clear Replicate # (Ryd replikatnummer) for at fjerne replikatnummeret fra
en valgt brønd eller gruppe af brønde.

Tildeling af en fortyndingsserie til standardprøvetyper
Som tidligere nævnt skal alle brønde med prøvetypen Standard tildeles en koncentrationsværdi. Du
kan tildele en fortyndingsserie til flere brønde med prøvetypen Standard.

Bemærk: For at tildele en fortyndingsserie til en gruppe af brønde skal brøndene være medtaget i
en replikatserie. Se Tildeling af replikatnumre til brønde på side 125 for at få oplysninger om
tilføjelse af brønde til en replikatserie.

Sådan tildeles en fortyndingsserie til en gruppe af standardprøvebrønde

1. Kontrollér i Plate Editor (Pladeeditor), at følgende krav er opfyldt:

n Prøvetypen for gruppen af brønde er Standard.

n Alle brønde i gruppen er tildelt mindst én fluorofor, og de indeholder allesammen de samme
fluoroforer.

n Alle brønde i gruppen er medtaget i den samme replikatserie.

Bemærk: CFXManager Dx software aktiverer først funktionen Dilution Series
(Fortyndingsserie), når alle valgte brønde opfylder disse kriterier.

2. Vælg målgruppen af brønde i pladeruden.

3. Klik på Dilution Series (Fortyndingsserie) i sektionen Concentration (Koncentration) i højre rude.
Sektionen Concentration (Koncentration) skifter til visning af følgende valgmuligheder:

Driftsvejledning | 127



Kapitel 7 Klargøring af plader

n Starting concentration (Startkoncentration) – den koncentrationsværdi, serien starter fra

n Replicates from and to (Replikater fra og til) – de replikater i serien, som
fortyndingsfaktoren vil blive anvendt på

n Dilution factor (Fortyndingsfaktor) – den mængde, som koncentrationen skal ændres med
inden for hver replikatgruppe

4. Indstil værdierne for valgmulighederne, eller accepter standardindstillingerne.

5. Fortyndingsserien formindskes som standard med fortyndingsfaktoren. Vælg Increasing
(Stigende) for at forøge fortyndingsserien.

6. (Valgfrit) Fortyndingsfaktoren gælder som standard for alle fluoroforer i replikatserien. Hvis serien
indeholder mere end én fluorofor, og du vil anvende fortyndingen på en enkelt fluorofor, skal du
vælge den på rullelisten.

7. Klik på Apply (Anvend) for at anvende fortyndingsserien på gruppen af brønde og vende tilbage til
visningen Concentration (Koncentration).

8. Klik på OK for at acceptere ændringerne og gemme pladen.

Kopiering af brøndindhold til en anden brønd
Du kan kopiere indholdet i en brønd og indsætte det i en enkelt brønd eller flere brønde. Du kan dog
kun kopiere indhold fra en enkelt brønd. Du kan ikke vælge flere brønde og kopiere deres indhold.

Sådan kopieres brøndindhold til en anden brønd

1. Vælg den brønd, der skal kopieres, i pladeruden.

2. Højreklik på brønden, og vælg Copy Well (Kopiér brønd).

3. Vælg den eller de brønde, som indholdet skal indsættes i:

n For at vælge en enkelt brønd skal du klikke på brønden.

n For at vælge flere brønde, der støder op til hinanden, skal du klikke på en brønd og trække til
den sidste brønd.

n For at vælge flere brønde, der ikke støder op til hinanden, skal du holde Ctrl-tasten nede og
klikke på de enkelte brønde.

4. Højreklik, når de ønskede brønde er valgt, og vælg Paste Well (Indsæt brønd).

CFX Manager Dx software indsætter indholdet af den første brønd i de valgte brønde.
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Tilføjelse af en bemærkning til en brønd
Du kan tilføje en beskrivende bemærkning til en brønd. Du kan se bemærkningerne for en brønd på
fanen Quantification (Kvantifikation) i vinduet Data Analysis (Dataanalyse).

Sådan tilføjes en bemærkning til en brønd

1. Vælg den eller de brønde, der skal tilføjes en bemærkning til, i ruden med pladen.

2. I sektionen View (Vis) nederst i ruden skal du vælge Well Note (Brøndbemærkning).

Well Note (Brøndbemærkning) vises i højre rude.

3. Indtast bemærkningen i tekstfeltet, og tryk på Enter.

Teksten vises nederst i de valgte brønde.

Tip: Hvis du tidligere har oprettet en brøndbemærkning, kan du vælge den på rullelisten og
anvende den i de valgte brønde.

Rydning af brønde for alt indhold
Du kan rydde en individuel brønd, en gruppe af brønde eller hele pladen for alt indhold. Rydning af
brønde fjerner ikke de fluorescensdata, som blev indsamlet under pladeaflæsningen.

Hvis en brønd ryddes, fjernes indholdet permanent fra brønden. Vær forsigtig, når du rydder brønde.

Sådan ryddes brønde for alle indstillinger

1. Vælg brønden eller gruppen af brønde i pladeruden i Plate Editor (Pladeeditor):

n For at vælge en enkelt brønd skal du klikke på brønden.

n For at vælge flere brønde, der støder op til hinanden, skal du klikke på en brønd og trække til
den sidste brønd.

n For at vælge flere brønde, der ikke støder op til hinanden, skal du holde Ctrl-tasten nede og
klikke på de enkelte brønde.

Driftsvejledning | 129



Kapitel 7 Klargøring af plader

n For at vælge en hel kolonne med samme prøvetype skal du klikke på kolonnens nummer.

n For at vælge en hel række skal du klikke på rækkens nummer.

2. Klik på Clear Wells (Ryd brønde) i den højre rude.

CFX Manager Dx software rydder de valgte brønde for alle indstillinger.

3. Klik på OK for at acceptere ændringerne og gemme pladen.
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Ændring af eksperimentindstillinger
Brug dialogboksen Experiment Settings (Eksperimentindstillinger) til at vise eller ændre listen med
målsekvenser (targets) eller prøver, eller til at vælge gruppen til genekspressionsanalyse og
valgmuligheder for analyse, hvis du tildelte biologiske sæt til brønde i pladen.

I dialogboksen Experiment Settings (Eksperimentindstillinger) viser fanen Targets (Målsekvenser) en
liste med navne på målsekvenser for hver PCR-reaktion, som f.eks. målsekvensgenet eller
interessegensekvenserne.

Fanen Samples (Prøver) viser en liste med navne på prøver, der angiver kilden til målsekvensen
(target), som f.eks. en prøve indsamlet efter 1 time (1Hr) eller fra et bestemt individ (mouse1).

Sådan ændres pladeindstillinger vha. dialogboksen Experiment Settings
(Eksperimentindstillinger)

1. For at åbne dialogboksen Experiment Settings (Eksperimentindstillinger) skal du gøre et af
følgende:

n Klik på Experiment Settings (Eksperimentindstillinger) i den højre rude i Plate Editor
(Pladeeditor)

n Klik på Experiment Settings (Eksperimentindstillinger) på fanen Gene Expression
(Genekspression) i vinduet Data Analysis (Dataanalyse).

Dialogboksen Experiment Settings (Eksperimentindstillinger) vises med indholdet fra fanen
Targets (Målsekvenser).
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2. Et nyt navn på en målsekvens (target) eller en prøve kan tilføjes ved at indtaste navnet i tekstfeltet
New (Ny) på den relevante fane og derefter klikke på Ad (Tilføj).

3. For at fjerne et eller flere navne på målsekvenser (targets) eller prøver fra listen skal du markere
elementets afkrydsningsfelt i kolonnen Select to Remove (Markér til fjernelse) på den relevante
fane og klikke på Remove checked item(s) (Fjern valgte elementer).

4. CFX Manager Dx software udelader prøvetypen NTC (ingen skabelonkontrol) fra
genekspressionsanalyse.

For at medtage NTC-prøvetyper skal du fjerne markeringen i afkrydsningsfeltet Exclude the
following sample types (Udelad følgende prøvetyper). Du kan vælge at udelade følgende
prøvetyper ved at markere det relevante afkrydsningsfelt:

n NRT (ingen revers transkriptase)

n Negative Control (Negativ kontrol)

n Positive Control (Positiv kontrol)

n Standard
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5. På fanen Targets (Målsekvenser):

a. For at vælge en målsekvens (target) som reference for analyse af genekspressionsdata skal
du vælge det i kolonnen Reference.

b. For at skjule analyseindstillinger, der anvendes på fanen Gene Expression (Genekspression)
i vinduet Analysis Settings (Analyseindstillinger), skal du fjerne markeringen i Show Analysis
Settings (Vis analyseindstillinger).

Softwaren skjuler følgende kolonner:

n Color (Farve)

n Show Chart (Vis diagram)

n Auto Efficiency (Automatisk effektivitet)

n Efficiency (%) (Effektivitet (%))

c. For at ændre farven på målsekvensen (target), som den gengives i diagrammet Gene
Expression (Genekspression), skal du klikke på dets celle i kolonnen Color (Farve), vælge en
ny farve i dialogboksen Color (Farve) og klikke på OK.

d. For at vise målsekvensen (target) med den valgte farve i diagrammet Gene Expression
(Genekspression) skal du markere afkrydsningsfeltet i kolonnen Show Chart (Vis diagram).

e. Som standard beregner CFX Manager Dx automatisk den relative effektivitet for en
målsekvens (target), hvis dets data omfatter en standardkurve.

For at bruge en tidligere fastlagt effektivitetsværdi skal du indtaste værdien i cellen i kolonnen
Efficiency (%) (Effektivitet (%)) og trykke på tasten Enter. CFX Manager Dx fjerner
markeringen i afkrydsningsfeltet Auto Efficiency (Automatisk effektivitet).

6. På fanen Samples (Prøver):

a. For at vælge en prøve som kontrolprøve for analysen af genekspressionsdata skal du vælge
dens afkrydsningsfelt i kolonnen Control (Kontrol).

b. For at tildele en kontrolbetingelse til en prøve for en kørsel skal du klikke i dens
afkrydsningsfelt i kolonnen Control (Kontrol).

c. Hvis det ikke allerede er valgt, kan du klikke på Show Analysis Settings (Vis
analyseindstillinger) for at vise eller ændre de analyseparametre, der bruges på fanen Gene
Expression (Genekspression). Softwaren skjuler kolonnerne Color (Farve) og Show Chart
(Vis diagram).
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7. Hvis du tildelte et eller flere biologiske sæt til brønde i pladen (se Tildeling af biologiske sæt til
brønde på side 124), skal du vælge en af de følgende valgmuligheder fra listen Biological Set
Analysis Options (Valgmuligheder for analyse af biologiske sæt):

n Target vs. Sample (Målsekvens kontra prøve) – kun brøndens prøvenavn bruges i
beregningerne af genekspression.

n Target vs. Biological Set (Målsekvens kontra biologisk sæt) – kun navnet på det biologiske
sæt bruges i beregningerne.

n Target vs. Sample_Biological Set (Målsekvens kontra prøve_biologisk sæt) –
prøvenavnet og navnet på det biologiske sæt kombineres for at oprette et enkelt navn, der
bruges i beregningerne.

n Target vs. Biological Set_Sample (Målsekvens kontra biologisk sæt_prøve) – navnet på
det biologiske sæt og prøvenavnet kombineres for at oprette et enkelt navn, der bruges i
beregningerne.

8. Klik på OK for at gemme parametrene i dialogboksen Experiment Settings
(Eksperimentindstillinger) og vende tilbage til vinduet Plate Editor (Pladeeditor).

Oprettelse af brøndgrupper
Brøndgrupper opdeler en enkelt plade i undersæt, der kan analyseres hver for sig i vinduet Data
Analysis (Dataanalyse). Når brøndgrupperne er opsat, kan du vælge en i vinduet Data Analysis
(Dataanalyse) for at analysere dataene som en uafhængig gruppe. Der kan for eksempel opsættes
brøndgrupper for at analysere flere eksperimenter, der køres i én plade, eller for at analysere hver
brøndgruppe med en forskellig standardkurve.

Bemærk: Standardbrøndgruppen er All Wells (Alle brønde).

Sådan oprettes brøndgrupper

1. For at åbneWell Groups Manager (Brøndgruppeadministrator) skal du gøre et af følgende:

n Klik på Well Groups (Brøndgrupper) på værktøjslinjen i Plate Editor (Pladeeditor).

n I vinduet Data Analysis (Dataanalyse) skal du klikke på ManageWell Groups (Administrer
brøndgrupper).
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DialogboksenWell Groups Manager (Brøndgruppeadministrator) åbnes.

2. Klik på Add (Tilføj) for at oprette en ny gruppe. Rullemenuen viser gruppenavnet som Group 1
(Gruppe 1) for den første gruppe.

3. Vælg brøndene til brøndgruppen i pladevisningen ved at klikke og trække på tværs af gruppen af
brønde. Valgte brønde vises med blåt i administratoren.

4. (Valgfrit) Navnet på en gruppe kan ændres ved at vælge navnet i rullemenuen og indtaste et nyt
navn.

5. (Valgfrit) En brøndgruppe kan slettes ved at vælge navnet på rullelisten og klikke på Delete (Slet).

6. Klik på OK for at afslutte og lukke vinduet, eller klik på Cancel (Annuller) for at lukke vinduet uden
at gemmeændringerne.

Vigtigt: For at vise brøndgrupperne skal du vælge Well Groups (Brøndgrupper) i
valgmulighederne for View (Vis) nederst i vinduet Plate Editor (Pladeeditor).
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Genvejsmenupunkter for dialogboksen Well Groups Manager
(Brøndgruppeadministrator)

Tabel 13 indeholder en liste over de menupunkter, der er tilgængelige i dialogboksenWell Groups
Manager (Brøndgruppeadministrator), når du højreklikker på en vilkårlig brønd.

Element Funktion

Copy (Kopiér) Kopierer brøndindholdet, som derefter kan sættes ind i en
anden brønd eller andre brønde.

Copy as Image (Kopiér som
billede)

Kopierer brøndvælgervisningen som et billede.

Print (Udskriv) Udskriver brøndvælgervisningen.

Print Selection (Udskriv valgte) Udskriver kun de valgte celler.

Export to Excel (Eksportér til
Excel)

Eksporterer data til et Excel-regneark.

Export to CSV (Eksportér til
CSV)

Eksporterer data som et kommasepareret dokument.

Export to Xml (Eksportér til Xml) Eksporterer data som et .xml-dokument.

Export to Html (Eksportér til
Html)

Eksporterer data som et .html-dokument.

Tabel 13. Genvejsmenupunkter i dialogboksen Well Selector (Brøndvælger)
i Plate Editor (Pladeeditor)
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Ændring af kurvelinjelayout
Du kan ændre amplifikationskurvelinjernes farve og layout under pladeopsætning og mens en kørsel
er i gang. Derefter er det nemt at se kurvelinjerne i statusvinduet i realtid, efterhånden som dataene
indsamles.

Sådan ændres kurvelinjelayout

1. Klik på Trace Styles (Kurvelinjelayout) på værktøjslinjen Plate Editor (Pladeeditor).

Dialogboksen Trace Styles (Kurvelinjelayout) vises for den åbne plade, for eksempel:

2. For at vise kurvelinjelayout efter en specifik fluorofor skal du vælge den i rullemenuen
Fluorophores (Fluoroforer).

3. Sådan ændres kurvelinjevisningen:

a. Vælg kurvelinjetypen på rullelisten Wells (Brønde).

b. Klik på dens farve i kolonnen Color (Farve).

c. Vælg en anden farve for kurvelinjen i dialogboksen Color (Farve), der åbnes, og klik på OK.

Ændringen for brøndtypen vises i gitteret nedenfor.

d. (Valgfrit) Vælg et symbol for kurvelinjen på rullelisten Symbols (Symboler).
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4. For at ændre den indstillede farve hurtigt skal du klikke på det relevante valg i sektionen Color
Quick Set (Hurtig indstilling af farve).

5. For at se brøndbetegnelserne i gitteret skal du vælge betegnelsestypen i sektionenWell Labels
(Brøndbetegnelser).

6. Klik på OK for at gemmeændringerne, eller klik på Cancel (Annuller) for at annullere
ændringerne.
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Visning af pladen i regnearksformat
Værktøjet Spreadsheet View/Importer (Visning/import af regneark) viser indholdet af en plade i
regnearksformat. Værktøjet Spreadsheet View/Importer (Visning/import af regneark) kan bruges til at
eksportere brøndindhold i et tabulatorsepareret format til en applikation såsomMicrosoft Excel. Du
kan også importere brøndindhold fra en tabulatorsepareret applikation.

Sådan bruges værktøjet Spreadsheet View/Importer (Visning/import af regneark)

1. Klik på Spreadsheet View/Importer (Visning/import af regneark) på værktøjslinjen Plate Editor
(Pladeeditor) for at åbne dialogboksen Plate Spreadsheet View (Visning af pladeregneark).

2. Dialogboksen Spreadsheet View (Regnearksvisning) viser pladens indhold for en enkelt fluorofor.
For at se pladens indhold for en anden fluorofor skal du vælge den på rullelisten Fluors List
(Fluorliste).

3. Klik på Export Template (Eksportér skabelon) for at eksportere en skabelon af pladeregnearket til
en Excel-fil (.csv-format). Du kan redigere denne skabelon med henblik på import af oplysninger
om brøndindhold.

4. (Valgfrit) Klik på Import (Importér) for at importere brøndindhold fra en kommasepareret fil.

5. For at sortere regnearket efter dataene i en specifik kolonne skal du klikke på trekanten ved siden
af kolonnenavnet.

Tip: Du kan redigere indholdet i en hvilken som helst celle i en kolonne, der har en stjerne (*)
ved siden af kolonnenavnet (for eksempel *Target Name (Navn på målsekvens)).
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Bemærk: Vælg enheder for standardkurve-data i kolonnen Quantity (Mængde) ved at åbne Plate
Editor (Pladeeditor) og vælge Settings > Units (Indstillinger > Enheder) på menulinjen. Når
pladekørslen er fuldført, vises data fra disse standarder i diagrammet Standard Curve
(Standardkurve) på fanen Quantification (Kvantifikation) i vinduet Data Analysis (Dataanalyse)
med de valgte enheder.

Genvejsmenupunkter i værktøjet Spreadsheet View/Importer (Visning/import af
regneark) for plader

Tabel 14 indeholder en liste over de menupunkter, der er tilgængelige i værktøjet Spreadsheet
View/Importer (Visning/import af regneark), når du højreklikker på en vilkårlig brønd i værktøjet.

Element Funktion

Copy (Kopiér) Kopierer hele regnearket.

Copy as Image (Kopiér
som billede)

Kopierer regnearket som en billedfil.

Print (Udskriv) Udskriver regnearket.

Print Selection (Udskriv
valgte)

Udskriver kun de valgte celler.

Export to Excel
(Eksportér til Excel)

Eksporterer filen til et Excel-regneark.

Export to CSV
(Eksportér til CSV)

Eksporterer filen som en .csv-fil.

Export to Xml
(Eksportér til Xml)

Eksporterer filen som en .xml-fil.

Export to Html
(Eksportér til Html)

Eksporterer filen som en .html-fil.

Find Søger efter den angivne tekst.

Sort (Sortér) Sorterer regnearket ved at vælge op til tre datakolonner i vinduet
Sort (Sortér).

Tabel 14. Genvejsmenupunkter i værktøjet Spreadsheet View/Importer (Visning/im-
port af regneark) for plader
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Oprettelse af et pladelayout ved brug af Setup Wizard
(Guiden Opsætning) for plader

Du kan bruge Setup Wizard (Guiden Opsætning) til at angive de oplysninger om pladelayout, som er
nødvendige for normaliseret genekspressionsanalyse, herunder:

n Navne på målsekvenser (targets)

n Prøvenavne

n Placering af målsekvenser (targets) og prøve på pladen

n Referencegen(er)

n Kontrolprøve

Setup Wizard (Guiden Opsætning) kan bruges før, under og efter en kørsel.

Anvendelse af Setup Wizard (Guiden Opsætning) for plader
Dette afsnit forklarer, hvordan et pladelayout oprettes ved hjælp af Setup Wizard (Guiden Opsætning)
for plader. For lettere at kunne se indholdet i de enkelte brønde på pladen skal du klikke på Zoom plate
(Zoom ind på pladen) øverst i Setup Wizard (Guiden Opsætning).

Vigtigt: Hvis du vender tilbage til fanen Auto layout (Automatisk layout) fra en hvilken som helst
anden fane i Setup Wizard (Guiden Opsætning), nulstilles pladelayoutet. Vær forsigtig, når du
vælger denne fane.

Tip: Du kan nulstille layoutet ved at vælge Tools > Clear Plate (Værktøjer > Ryd plade) i Setup
Wizard (Guiden Opsætning).

Sådan anvendes Setup Wizard (Guiden Opsætning) for plader

1. Åbn Plate Editor (Pladeeditor).

2. For at åbne Setup Wizard (Guiden Opsætning) skal du vælge Editing Tools > Setup Wizard
(Redigeringsværktøjer > Guiden Opsætning).
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Setup Wizard (Guiden Opsætning) åbner og viser fanen Auto layout (Automatisk layout).

3. Gør følgende på fanen Auto layout (Automatisk layout):

a. Klik på en brønd i gitteret, og træk på tværs og ned for at angive det område på pladen, hvor
du planlægger at isætte prøven.

b. Indtast antallet af målsekvenser (targets) og prøver, der skal isættes.

Tip: Antallet af målsekvenser (targets) og prøver skal være det samme som antallet af
valgte celler. Hvis det indtastede antal ikke passer til det valgte område, skal antallet
eller det valgte område på pladen ændres. Orienteringen af elementerne på pladen og
grupperingen af disse kan specificeres.

c. (Valgfrit) Rediger pladernes orientering. For eksempel kan du indstille målsekvenser
(targets) i kolonner og prøver i rækker eller gruppere efter prøver.

d. Klik på Next (Næste) for at gå videre til fanen Target names (Navne på målsekvenser).

Bemærk: Hvis pladelayoutet ikke har et regelmæssigt mønster, kan du bruge fanen Target
names (Navne på målsekvenser) til manuelt at placere målsekvenserne (targets) eller fanen
Sample Names (Prøvenavne) til manuelt at placere prøverne på pladen. Klik og træk for at
vælge flere brønde.
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4. Definer navnene på målsekvenserne (targets) for målsekvensgrupperne på fanen Target Names
(Navne på målsekvenser):

a. Gør et af følgende:

n For at omdøbe målsekvenser (targets) efter gruppe skal du indstille Select by (Vælg
efter) til Target (Målsekvens).

n For at omdøbe målsekvenser (targets) efter brønd skal du indstille Select by (Vælg efter)
til Well (Brønd).

b. Vælg en målsekvensgruppe eller -brønd i gitteret, og indtast et navn på rullelisten Target
Name (Navn på målsekvens).

Tip: Tryk på Tab for at vælge den næste gruppe eller brønd til højre, eller tryk på Enter
for at vælge den næste brønd eller gruppe nedenfor. Alternativt kan du holde Ctrl-tasten
nede og klikke på en brønd på fanerne Target name (Navn på målsekvens) og Sample
name (Prøvenavn) for at vælge flere brønde, der ikke støder op til hinanden.

c. Klik på Next (Næste) for at gå videre til fanen Sample Names (Prøvenavne).

5. På fanen Sample Names (Prøvenavne) defineres prøvenavnene for prøvegrupperne.

6. Klik på Next (Næste) for at gå videre til fanen Reference targets (Referencemålsekvenser).

7. Vælg en eller flere målsekvenser (targets) på fanen Reference targets (Referencemålsekvenser)
til brug som referencer for normaliseret genekspression, og klik på Next (Næste) for at gå videre
til fanen Control sample (Kontrolprøve).

8. Vælg en eller to prøver på fanen Control sample (Kontrolprøve) til brug som kontrol i forbindelse
med beregning af genekspression.

9. Klik på OK for at gemme pladelayoutet og gå tilbage til Plate Editor (Pladeeditor), hvor
pladeparametrene kan defineres yderligere. Se Tildeling af valgfri parametre til pladefilen på side
120 for yderligere oplysninger.

Du kan også klikke på Previous (Forrige) for at gå tilbage til en foregående fane for at foretage
ændringer.

Bemærk: Når du vender tilbage til fanen Auto layout (Automatisk layout), nulstilles
pladelayoutet. Vær forsigtig, når du klikker på Previous (Forrige).
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Kapitel 8 Kørsel af eksperimenter
Dette kapitel forklarer, hvordan du kører brugerdefinerede eller PrimePCR™ analyseeksperimenter
ved brug af CFX Manager™ Dx softwaren.

En kørselsdatafil indeholder protokol- og pladeoplysninger for kørslen. Filen indeholder også dataene
fra de analyser, som CFXManager Dx udfører, efter at kørslen er udført.

CFX Manager Dx softwaren gør det nemt at opsætte og køre brugerdefinerede eksperimenter eller
PrimePCR-eksperimenter. Vinduet Run Setup (Kørselsopsætning) fører dig gennem de almindelige
trin til opsætning af et eksperiment og ender i dialogboksen Start Run (Start kørsel), hvor du kan starte
kørslen.

Åbning af vinduet Run Setup (Kørselsopsætning)
Sådan åbnes vinduet Run Setup (Kørselsopsætning)

u Gør et af følgende:

n Klik enten på User-defined (Brugerdefineret) eller PrimePCR på fanen Run Setup
(Kørselsopsætning) i Startup Wizard (Guiden Opstart).

n Klik enten på User-defined Run Setup (Brugerdefineret kørselsopsætning) eller PrimePCR
Run Setup (PrimePCR kørselsopsætning) på værktøjslinjen i startvinduet.

n Vælg enten Run > User-defined Run (Kørsel > Brugerdefineret kørsel) eller Run > PrimePCR
Run (Kørsel > PrimePCR-kørsel) i startvinduet.
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Vinduet Run Setup (Kørselsopsætning)
Vinduet Run Setup (Kørselsopsætning) giver hurtig adgang til de filer og indstillinger, der er
nødvendige for at kunne sætte et eksperiment op og køre det. Hvis der skal køres et brugerdefineret
eksperiment, åbner vinduet Run Setup (Kørselsopsætning) med fanen Protocol (Protokol). Hvis der
skal køres et PrimePCR-eksperiment, åbner vinduet Run Setup (Kørselsopsætning) med Fanen Start
Run (Start kørsel).

Tip: Se Udførelse af PrimePCR-eksperimenter på side 162 for oplysninger om PrimePCR. Se
Fanen Start Run (Start kørsel) på side 153 for oplysninger om fanen Start Run (Start kørsel).

1. Fanerne guider brugeren gennem klargøring og kørsel af et eksperiment:

n Fanen Protocol (Protokol) – vælg en eksisterende protokol, der skal køres
eller redigeres, eller opret en ny protokol i Protocol Editor (Protokoleditor).

n Fanen Plate (Plade) – vælg en eksisterende plade, der skal køres eller
redigeres, eller opret en ny plade i Plate Editor (Pladeeditor).

n Fanen Start Run (Start kørsel) – vis eksperimentindstillingerne, vælg en eller
flere instrumentblokke, og påbegynd kørslen.

2. Hovedvinduet viser valgmulighederne for de enkelte faner, efterhånden som de
anvendes.

3. Navigationsknapperne bruges til gå til fanen Start Run (Start kørsel).

FORKLARING
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Fanen Protocol (Protokol)
Fanen Protocol (Protokol) viser en forhåndsvisning af den protokolfil, du planlægger at køre. En
protokolfil indeholder instruktionerne til instrumentets temperaturtrin samt de instrumentindstillinger,
der styrer rampehastigheden, prøvevolumenet og lågets temperatur.

Som standard viser softwaren den protokol, der er defineret i sektionen File Selection for Run Setup
(Filvalg til kørselsopsætning) på fanen Files (Filer) i dialogboksen User > User Preferences (Bruger >
Brugerpræferencer). Du kan ændre standardprotokollen i dialogboksen User Preferences
(Brugerpræferencer). SeÆndring af standardindstillinger for filer på side 63 for yderligere
oplysninger.

På fanen Protocol (Protokol) kan du:

n Oprette en ny protokol til kørsel

n Vælge en eksisterende protokol for at køre eller redigere den

Se Kapitel 6, Oprettelse af protokoller for yderligere oplysninger om oprettelse og redigering af
protokoller.
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Sådan oprettes en ny protokol

1. Klik på Create New (Opret ny) på fanen Protocol (Protokol).

Protocol Editor (Protokoleditor) vises.

2. Brug Protocol Editor (Protokoleditor) til at oprette den nye protokol.

3. Klik på OK for at gemme protokollen og gå tilbage til fanen Protocol (Protokol) under Run Setup
(Kørselsopsætning).

4. Gennemse de detaljerede oplysninger om protokollen, og gør et af følgende:

n Klik på Next (Næste), hvis oplysningerne er korrekte, for at gå videre til fanen Plate (Plade).

n Klik på Edit Selected (Rediger valgte), hvis de detaljerede oplysninger ikke er korrekte, for at
vende tilbage til vinduet Protocol Editor (Protokoleditor). Gennemgå protokollen, gem
ændringerne, og klik derefter på Next (Næste) på fanen Protocol (Protokol) for at gå videre til
fanen Plate (Plade).

Sådan vælges en eksisterende protokol

1. Gør et af følgende på fanen Protocol (Protokol):

n Klik på Select Existing (Vælg eksisterende), og naviger til en eksisterende protokol.

n Klik på Express Load (Hurtig isætning) og vælg en protokol fra rullelisten med protokoller.

Tip: Du kan tilføje eller fjerne protokoller fra rullelisten Express Load (Hurtig isætning).
Se Tilføjelse og fjernelse af protokoller til hurtig isætning nedenfor for yderligere
oplysninger.

2. Gennemse de detaljerede oplysninger om protokollen, og gør et af følgende:

n Klik på Next (Næste), hvis oplysningerne er korrekte, for at gå videre til fanen Plate (Plade).

n Klik på Edit Selected (Rediger valgte), hvis de detaljerede oplysninger ikke er korrekte, for at
åbne Protocol Editor (Protokoleditor). Gennemgå protokollen, gemændringerne, og klik
derefter på Next (Næste) på fanen Protocol (Protokol) for at gå videre til fanen Plate (Plade).

Tilføjelse og fjernelse af protokoller til hurtig isætning

Du kan redigere indholdet af rullelisten Express Load (Hurtig isætning), som vises i Protocol Editor
(Protokoleditor). Protokollerne på listen gemmes i følgende mappe:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\
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Sådan redigeres listen med protokoller til Express Load (Hurtig isætning)

1. Naviger til og åbn mappen ExpressLoad (Hurtig isætning).

2. Gennemgå protokolfilerne (.pcrl) i mappen.

3. Gør et af følgende:

n Slet protokoller fra mappen for at fjerne dem fra rullelisten.

n Kopiér protokoller til mappen for at tilføje dem på rullelisten.
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Fanen Plate (Plade)
Bemærk: Hvis den protokol, der vælges på fanen Protocol (Protokol), ikke indeholder et
pladeaflæsningstrin til real-time PCR-analyse, er fanen Plate (Plade) skjult. For at se fanen Plate
(Plade) skal du tilføje mindst én pladeaflæsning til protokollen.

Fanen Plate (Plade) viser en forhåndsvisning af den pladefil, du planlægger at indlæse. I en real-time
PCR-kørsel indeholder pladefilen en beskrivelse af indholdet i hver brønd, herunder dens fluoroforer,
scanningstilstanden og pladetypen. CFX Manager Dx softwaren anvender disse beskrivelser til
dataindsamling og analyse.

Softwaren viser som standard den plade, der er defineret i sektionen File Selection for Run Setup
(Filvalg til kørselsopsætning) på fanen Files (Filer) i dialogboksen User > User Preferences (Bruger >
Brugerpræferencer). Standardpladen kan ændres i dialogboksen User Preferences
(Brugerpræferencer). SeÆndring af standardindstillinger for filer på side 63 for yderligere
oplysninger.

På fanen Plate (Plade) kan du:

n Oprette en ny plade, som skal indsættes.

n Vælge en eksisterende plade, som skal indsættes eller redigeres.

Der findes flere oplysninger om oprettelse og ændring af plader i Kapitel 7, Klargøring af plader.
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Sådan oprettes en ny plade

1. Klik på Create New (Opret ny) på fanen Plate (Plade).

Plate Editor (Pladeeditor) vises.

2. Brug Plate Editor (Pladeeditor) til at oprette en ny plade.

3. Klik på OK for at gemme pladen og gå tilbage til fanen Plate (Plade) under Run Setup
(Kørselsopsætning).

4. Gennemse de detaljerede oplysninger om pladen, og gør et af følgende:

n Klik på Next (Næste), hvis de detaljerede oplysninger er korrekte, for at gå videre til fanen
Start Run (Start kørsel).

n Klik på Edit Selected (Rediger valgte), hvis de detaljerede oplysninger ikke er korrekte, for at
vende tilbage til Plate Editor (Pladeeditor). Gennemgå pladefilen, gemændringerne, og klik
derefter på Next (Næste) på fanen Plate (Plade) for at gå videre til fanen Start Run (Start
kørsel).

Sådan vælges en eksisterende pladefil

1. Gør et af følgende på fanen Plate (Plade):

n Klik på Select Existing (Vælg eksisterende), og naviger til en eksisterende pladefil.

n Klik på Express Load (Hurtig isætning) og vælg en pladefil på rullelisten.

Tip: Du kan tilføje plader til eller fjerne dem fra rullelisten Express Load (Hurtig
isætning). Der findes flere oplysninger i Tilføjelse og fjernelse af pladefiler til hurtig
isætning nedenfor.

2. Gennemse de detaljerede oplysninger om pladen, og gør et af følgende:

n Klik på Next (Næste), hvis de detaljerede oplysninger er korrekte, for at gå videre til fanen
Start Run (Start kørsel).

n Klik på Edit Selected (Rediger valgte), hvis de detaljerede oplysninger ikke er korrekte, for at
åbne vinduet Plate Editor (Pladeeditor). Gennemgå pladefilen, gemændringerne, og klik
derefter på Next (Næste) for at gå videre til fanen Start Run (Start kørsel).

Tilføjelse og fjernelse af pladefiler til hurtig isætning

Du kan redigere indholdet af rullelisten Express Load (Hurtig isætning), som vises i Plate Editor
(Pladeeditor). De plader, der vises på listen, er gemt i følgende mappe:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\
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Sådan redigeres listen med pladefiler til Express Load (Hurtig isætning)

1. Naviger til og åbn mappen ExpressLoad (Hurtig isætning).

2. Gennemgå pladefilerne (.pltd) i mappen.

3. Gør et af følgende:

n Slet pladefiler fra mappen for at fjerne dem fra rullelisten.

n Kopiér pladefiler til mappen for at tilføje dem på rullelisten.
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Fanen Start Run (Start kørsel)
Fanen Start Run (Start kørsel) viser oplysninger om eksperimentet, der skal køres. Den viser også
den eller de tilsluttede instrumentblokke, som eksperimentet kan køres på.

Fanen Start Run (Start kørsel) kan bruges til følgende:

n Vise detaljerede kørselsoplysninger, herunder den valgte protokolfil, pladefil og
scanningstilstand.

n Tilføj bemærkninger om kørslen.

n Vis detaljerede oplysninger om alle tilsluttede instrumenter, herunder deres kørselsstatus (kører
eller inaktiv), prøvevolumen i µl, lågets temperatur, emuleringstilstand og id eller stregkode, hvis
de er tilgængelige.

Bemærk: Du kan ændre kolonnerne, der vises i tabellen Start Run on Selected Blocks (Start
kørsel på valgte blokke). Se Redigering af detaljerede oplysninger i tabellen Selected blocks
(Valgte blokke) på side 154 for yderligere oplysninger.

n Vælg den eller de blokke, som kørslen skal udføres på.

n Åben eller luk låget med fjernbetjening for hvert valgt instrument.

n Start kørslen.
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Redigering af detaljerede oplysninger i tabellen Selected blocks (Valgte blokke)

Du kan ændre kolonnerne, der vises i tabellen Start Run on Selected Block(s) (Start kørsel på valgte
blokke). Desuden kan du ændre værdierne for standardprøvevolumenet og lågets temperatur i
tabellen. Ændringerne af indstillingerne anvendes i den kørsel, der skal udføres.

Sådan tilføjes kolonner i tabellen Start Run on Selected Block(s) (Start kørsel på valgte
blokke)

u Højreklik i tabellen, og markér et element i den menu, der vises.

Sådan fjernes kolonner i tabellen Start Run on Selected Block(s) (Start kørsel på valgte
blokke)

u Højreklik i tabellen, og fjern markeringen for et element i den menu, der vises.

Sådan redigeres værdier for prøvevolumenet eller lågets temperatur for en blok

u Vælg cellen med prøvevolumenet eller lågets temperatur for den ønskede blok, og skriv en ny
værdi i cellen.

Sådan tilføjes et kørsels-ID eller en stregkode for en blok

u Vælg cellen ID/Bar Code (ID/stregkode) for den ønskede blok, og skriv et ID eller scan blokken
med en stregkodelæser.

Kørsel af et eksperiment
Vigtigt: Inden du kører et eksperiment, skal du sikre, at computerens antivirussoftware ikke
starter en scanning under kørslen.

Sådan køres et eksperiment

1. Verificer de detaljerede oplysninger om plade og protokol i sektionen Run Information
(Kørselsoplysninger) på fanen Start Run (Start kørsel).

2. (Valgfrit) Tilføj bemærkninger om kørslen eller eksperimentet i tekstboksen Notes
(Bemærkninger).

3. Markér afkrydsningsfeltet for en eller flere blokke, som kørslen skal udføres på.

Tip: For at køre eksperimentet på alle blikke skal du vælge Select All Blocks (Vælg alle
blokke) under tabellen Selected Blocks (Valgte blokke).

4. (Valgfrit) Klik på Flash Block Indicator (Lad blokindikator blinke) for at lade LED-indikatoren blinke på de
valgte instrumentblokke.

5. Sæt eksperimentpladerne ind i blokken:
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a. Klik på Open Lid (Åbn låget). Det motoriserede låg på hver valgt blok åbnes.

b. Sæt en eksperimentblok ind i hver valgt blok.

c. Klik på Close Lid (Luk låget).

Tip: Du kan også trykke på knappen foran på hver blok for at åbne og lukke låget.

6. Klik på Open Lid (Åbn låget) og Close Lid (Luk låget) for at åbne og lukke det motoriserede låg på
hver valgt instrumentblok.

7. Gennemse de detaljerede oplysninger om kørslen, og gør et af følgende:

n Klik på Start Run (Start kørsel), hvis de detaljerede oplysninger er korrekte.

n Hvis de detaljerede oplysninger er forkerte:

o Ret de detaljerede oplysninger i tabellen Selected Blocks (Valgte blokke), og klik på
Start Run (Start kørsel).

o Vend tilbage til den relevante fane og foretag de relevante ændringer, gem
ændringerne, og klik derefter på Next (Næste) for at vende tilbage til fanen Start Run
(Start kørsel) og starte kørslen.

Sådan startes en kørsel fra en tidligere kørsel

u Gør et af følgende:

n Vælg File > Repeat a Run (Fil > Gentag en kørsel) i softwarens hovedmenulinje. Naviger til
og dobbeltklik på den kørselsdatafil, som skal gentages.

n Vælg fanen Repeat Run (Gentag kørslen) i Startup Wizard (Guiden Opstart), og dobbeltklik
på datafilen for den kørsel, som skal gentages.

Du kan også klikke på Browse (Gennemse) på fanen Repeat Run (Gentag kørslen) for at
navigere til og dobbeltklikke på den kørselsdatafil, som skal gentages.
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Dialogboksen Run Details (Kørselsdetaljer)
Når du klikker på Start Run (Start kørsel), beder CFX Manager Dx softwaren dig om at gemme
datafilen (.pcrd), starter kørslen og åbner dialogboksen Run Details (Kørselsdetaljer). Dialogboksen
Run Details (Kørselsdetaljer) består af tre statusfaner:

n Run Status (Kørselsstatus) – brug denne fane til at se protokollens aktuelle status, åbne eller
lukke låget, sætte en kørsel pause, tilføje gentagelser, springe over trin eller stoppe kørslen.

n Real-time Status (Realtidsstatus) – brug denne fane til at se PCR-fluorescensdata i realtid, mens
de indsamles.

n Time Status (Tidsstatus) – brug denne fane til at få vist en fuldskærmsnedtælling for protokollen.

Fanerne er beskrevet i detaljer i de følgende afsnit.

Fanen Run Status (Kørselsstatus)
Fanen Run Status (Kørselsstatus) viser den aktuelle status for en igangværende kørsel. I denne
visning er det også muligt at kontrollere låget og ændre den igangværende kørsel.

1. Ruden Run Status (Kørselsstatus) – viser status for den igangværende protokol.

2. Betjeningselementer for Run Status (Kørselsstatus) – giver mulighed for at
betjene instrumentet eller afbryde den igangværende protokol.

3. Ruden Run Information (Kørselsoplysninger) – viser kørselsdetaljer.

FORKLARING
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Dialogboksen Run Details (Kørselsdetaljer)

Kommandoer for Run Status (Kørselsstatus)

Kommandoerne på fanen Run Status (Kørselsstatus) kan bruges enten til at betjene instrumentet fra
softwaren eller til at ændre en igangværende kørsel.

Bemærk:Ændringer, der foretages på protokoller under kørslen, som for eksempel tilføjelsen af
repetitioner, ændrer ikke den protokolfil, der er tilknyttet til kørslen. Disse handlinger registreres i
Run Log (Kørselsloggen).

– åbner det motoriserede låg på visse instrumenter.

Vigtigt: Hvis låget åbnes under en kørsel, sættes kørslen på pause på det igangværende
trin, hvilket kan påvirke data.

– lukker det motoriserede låg på visse instrumenter.

– tilføjer yderligere repetitioner til det igangværende trin af typen GOTO (GÅ TIL) i protokollen.
Denne valgmulighed er kun tilgængelig, når en forekomst af trinnet GOTO (GÅ TIL) kører.

– springer det igangværende trin i protokollen over.

Bemærk: Hvis en forekomst af trinnet GOTO (GÅ TIL) springes over, beder softwaren om
bekræftelse på, at GOTO-løkken skal springes over for at fortsætte til det næste trin i
protokollen.

– får LED'en på visse instrumenter til at blinke for at identificere de valgte blokke.

– sætter protokollen på pause.

Bemærk: Denne handling registreres i Run Log (Kørselsloggen).

– genoptager en protokol, der er sat på pause.

– stopper kørslen før afslutningen af protokollen.

Bemærk: Hvis kørslen stoppes før afslutningen af protokollen, kan data blive påvirket.
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Fanen Real-time Status (Realtidsstatus)
Fanen Real-time Status (Realtidsstatus) viser real-time PCR-data indsamlet i hver cyklus under
kørslen efter de første to pladeaflæsninger.

1. Kurvelinjeruden Amplification (Amplifikation) – viser amplifikationsdata i realtid
under kørslen.

2. Identifikator for Well group (Brøndgruppe) – hvis der blev identificeret
brøndgrupper i pladeopsætningen, kan brugeren vælge en specifik brøndgruppe
for at se dens kurvelinjer, brønde og tabeloplysninger.

Identifikator for Step number (Trinnummer) – hvis protokollen indsamler data på
mere end ét trin (for eksempel under amplifikation og smeltekurve), kan brugeren
vælge et specifikt trin og se de kurvelinjer, der blev indsamlet på det pågældende
trin.

3. RudenWell selector (Brøndvælger) – viser de aktive, inaktive og tomme brønde i
pladen.

4. Tabelruden Plate Setup (Pladeopsætning) – viser pladeopsætningen i
tabelformat.

FORKLARING
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Dialogboksen Run Details (Kørselsdetaljer)

5. Rude med kørselsdetaljer – viser realtidsstatus for kørslen, herunder:

n Nuværende trin

n Nuværende gentagelse

n Nuværende temperatur

n Resterende tid

n Prøvetemperatur

n Lågets temperatur

6. Plate Setup (Pladeopsætning) – åbner dialogboksen Plate Setup
(Pladeopsætning), hvor brugeren kan ændre den aktuelle pladeopsætning under
en kørsel.

På fanen Real-time Status (Realtidsstatus) kan du:

n Vise eller skjule kurvelinjer i realtid ved at vælge dem i brøndvælgerruden eller tabellen til
pladeopsætning.

n Vise kurvelinjer enkelt- eller gruppevis ved at vælge dem i rullemenuen med brøndgrupper.

n Redigere pladen eller udskifte pladefilen.

n Anvende en PrimePCR-file på kørslen.

Vise eller skjule realtidskurvelinjer

Som standard er alle fyldte brønde aktive og vises i pladeopsætningstabellen. Aktive brønde vises
med blåt i brøndvælgerruden. Skjulte brønde vises med lysegråt, og eventuelle ubrugte brønde vises
med mørkegråt i brøndvælgerruden.

Du kan skjule kurvelinjer fra aktive brønde under kørslen. CFX Manager Dx bliver ved med at
indsamle data for alle brønde, men når du skjuler brøndene, vises deres data ikke i
pladeopsætningstabellen.

Sådan skjules realtidskurvelinjer

u Klik på den aktive (blå) brønd, der skal skjules, i brøndvælgerruden.

Sådan vises realtidskurvelinjer

u Klik på den skjulte (lysegrå) brønd, der skal vises, i brøndvælgerruden.

Se Brøndvælger på side 176 for yderligere oplysninger om brøndvælgeren.
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Redigering af en pladeopsætning

Sådan redigeres en pladeopsætning

u Klik på Plate Setup (Pladeopsætning), og vælg View/Edit Plate (Vis/rediger plade).

Vinduet Plate Editor (Pladeeditor) vises og giver mulighed for at redigere pladen, mens kørslen er
i gang. Der står flere oplysninger om redigering af plader i Kapitel 7, Klargøring af plader.

Bemærk: Du kan også redigere kurvelinjelayout i vinduet Plate Editor (Pladeeditor).
Ændringer vises i amplifikationskurvelinjeplottet på fanen Real-time Status (Realtidsstatus).

Udskiftning af en pladefil

Tip: Udskiftning af en pladefil er særlig nyttigt, hvis du starter en kørsel med en Quick Plate-fil i
ExpressLoad-mappen.

Sådan udskiftes en pladefil

u Klik på Plate Setup (Pladeopsætning), og vælg et af følgende:

n Replace Plate file (Udskift pladefil) – vælg den nye pladefil på listen i browservinduet

n Apply PrimePCR file (Anvend PrimePCR-fil) – søg efter en kørselsfil, som pladelayoutet skal
hentes fra, med Smart-søgning eller ved at klikke på Browse (Gennemse) for at finde en fil,
der blev downloadet fra Bio-Rads websted, og som ikke findes i PrimePCR-mappen

Bemærk: CFXManager Dx kontrollerer scanningstilstand og pladestørrelse for pladefilen.
Disse skal være de samme som de kørselsindstillinger, kørslen blev startet med.
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Dialogboksen Run Details (Kørselsdetaljer)

Fanen Time Status (Tidsstatus)
Fanen Time Status (Tidsstatus) viser, hvor lang tid der er tilbage før den aktuelle kørsel er færdig.
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Udførelse af PrimePCR-eksperimenter
PrimePCR-eksperimenter bruger signalvejs- eller sygdomsspecifikke analyser, som Bio-Rad har
valideret og optimeret til vådlaboratorier, og som er tilgængelige i følgende formater:

n Paneler med foruddefinerede plader – plader med analyser, der er specifikke for en biologisk
signalvej eller sygdom. De omfatter PrimePCR-kontroller og referencegener

n Brugerkonfigurerede plader – plader, der kan opsættes i et brugerdefineret layout, hvor der kan
vælges analyser for interessemålsekvenser (targets), kontroller og referencer

n Individuelle analyser – rør, der indeholder individuelle primersæt til brug i real-time-reaktioner

For at reducere den samlede kørselstid kan du fjerne smeltetrinnet i protokollen. Bio-Rad anbefaler på
det kraftigste, at der ikke udføres andre ændringer af en PrimePCR kørselsprotokol.
Standardprotokollen er den, der blev brugt til analysevalidering. Enhver afvigelse fra dette kan påvirke
resultaterne. Ændringer i protokollen angives på fanen Run Information (Kørselsoplysninger) i den
resulterende datafil og i eventuelle rapporter, der oprettes.

Sådan startes en PrimePCR-kørsel

u For at starte en PrimePCR-kørsel skal du gøre et af følgende:

n I Startup Wizard (Guiden Opstart) skal du vælge PrimePCR på fanen Run setup
(Kørselsopsætning) og derefter vælge den relevante kemi (SYBER eller probe).

n Vælg en PrimePCR-kørsel på listen Recent Runs (Seneste kørsler) på fanen Repeat run
(Gentag kørslen) i Startup Wizard (Guiden Opstart).

n Vælg File > New > PrimePCR Run (Fil > Ny > PrimePCR-kørsel) i startvinduet.

n Vælg File > Open > PrimePCR Run File (Fil > Åbn > PrimePCR-kørselsfil) i startvinduet.

n Træk og slip en PrimePCR-kørselsfil i startvinduet.

Når du har valgt en PrimePCR-kørsel, åbner vinduet Run Setup (Kørselsopsætning) på fanen Start
Run (Start kørsel) med standard-PrimePCR-pladelayoutet indlæst, baseret på det valgte instrument.

Sådan fjernes smeltetrinnet i protokollen

u Fjern markeringen i feltet ved siden af Include Melt Step (Medtag smeltetrin) på fanen Protocol
(Protokol).

162 | CFX96 Dx og CFX96 DeepWell Dx systemer



Udførelse af PrimePCR-eksperimenter

Sådan importeres oplysninger om målsekvenser (targets) for PrimePCR-plader til et
pladelayout

1. Gør et af følgende:

n På fanen Real-time Status (Realtidsstatus) i dialogboksen Run Details (Kørselsdetaljer)
vælges Plate Setup > Apply PrimePCR File (Pladeopsætning > Anvend PrimePCR-fil).

n I vinduet Data Analysis (Dataanalyse) vælges Plate Setup > Apply PrimePCR File
(Pladeopsætning > Anvend PrimePCR-fil).

2. Klik på Browse (Gennemse) i dialogboksen PrimePCR run file (PrimePCR-kørselsfil) for at
navigere til den relevante PrimePCR-fil (.csv).

3. Vælg den ønskede PrimePCR-filen og klik på Open (Åbn).

CFX Manager Dx importer de ønskede oplysningerne til pladelayoutet.
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Kapitel 9 Oversigt over dataanalyse
CFXManager™ Dx har flere metoder til åbning og visning af datafiler. Du kan:

n Vælge File > Open > Data File (Fil > Åbn > Datafil) i startvinduet og navigere til den ønskede
.pcrd-fil.

n Vælg File > Recent Data Files (Fil > Seneste datafiler) i startvinduet for at vælge fra en liste over
de ti senest åbnede datafiler.

Vinduet Data Analysis (Dataanalyse)
Vinduet Data Analysis (Dataanalyse) indeholder flere faner, som hver viser de analyserede data for en
specifik analysemetode eller kørselsspecifikke oplysninger. Fanerne vises kun, hvis de data, som blev
indsamlet i kørslen, er tilgængelige til den pågældende type analyse.

Tip: For at vælge de faner, som skal vises, skal de vælges i rullemenuen View (Vis) i vinduet Data
Analysis (Dataanalyse). For at vende tilbage til det oprindelige fanelayout skal du vælge Settings
(Indstillinger) > Restore Default Window Layout (Gendan standard-vindueslayout).
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Værktøjslinjen Data Analysis (Dataanalyse)
Værktøjslinjen i vinduet Data Analysis (Dataanalyse) giver hurtig adgang til vigtige
dataanalysefunktioner.

Tabel 15 viser funktionerne af knapperne på værktøjslinjen.

Knap Navn Funktion

Plate Setup
(Pladeopsætning)

View/Edit Plate (Vis/rediger plade): Åbner
Plate Editor (Pladeeditor) med henblik på
visning og redigering af indholdet af
brønde.

Replace Plate File (Udskift pladefil):
Vælger en pladefil, som skal erstatte
pladelayoutet.

Apply PrimePCR file (Anvend PrimePCR-
fil): vælger en kørselsfil, der skal erstatte
pladelayoutet for en PrimePCR™ kørsel.

ManageWell Groups
(Administrer
brøndgrupper)

Åbner vinduet Well Groups Manager
(Brøndgruppeadministrator) med henblik
på oprettelse, redigering og sletning af
brøndgrupper.

Well Group
(Brøndgruppe)

Vælg navnet på en eksisterende
brøndgruppe på rullelisten.
Standardvalget er All Wells (Alle brønde).
Denne knap vises kun, hvis der er oprettet
brøndgrupper.

Analysetilstand Analyserer dataene i enten fluorofor-
tilstand eller målsekvenstilstand (target).

Help (Hjælp) Åbner en digital kopi af denne
betjeningsvejledning i Acrobat PDF-
format.

Tabel 15. Værktøjslinjen i vinduet Data Analysis (Dataanalyse)

166 | CFX96 Dx og CFX96 DeepWell Dx systemer



Vinduet Data Analysis (Dataanalyse)

Menulinjen Data Analysis (Dataanalyse)
Tabel 16 viser menulinjepunkter i vinduet Data Analysis (Dataanalyse).

Menupunkt Kommando Funktion

File (Fil) Save (Gem) Gemmer filen.

Save As (Gem som) Gemmer filen under et nyt navn.

Repeat Run (Gentag kørsel) Ekstraherer protokollen og pladefilen fra
den aktuelle kørsel med henblik på
genkørsel.

Close (Luk) Lukker vinduet Data Analysis
(Dataanalyse).

View (Vis) Run Log (Kørselslog) Åbner vinduet Run Log (Kørselslog) for at
vise kørselsloggen for den aktuelle datafil.

Quantification (Kvantifikation),
Melt Curve (Smeltekurve), Gene
Expression (Genekspression),
End Point (Endepunkt), Custom
Data View (Tilpasset
datavisning), QC
(Kvalitetskontrol), Run
Information (Kørselsoplysninger)

Viser de analyserede data på de valgte
faner i vinduet Data Analysis (Dataanalyse).
Mindst én fane skal vælges.

Settings
(Indstillinger)

Cq Determination Mode (Cq-
bestemmelsestilstand)

Vælg tilstanden Regression eller Single
Threshold (Enkelt tærskel) for at bestemme,
hvordan Cq-værdier beregnes for hver
kurvelinje.

Baseline Setting
(Baselineindstilling)

Vælg baseline-subtraktionsmetoden for de
valgte brøndgrupper.

Analysetilstand Vælg at analysere data efter Fluorophore
(Fluorofor) eller efter Target (Målsekvens).

Tabel 16. Punkter på menulinjen i vinduet Data Analysis (Dataanalyse)
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Menupunkt Kommando Funktion

Cycles to Analyze (Cyklusser, der
skal analyseres)

Vælg de cyklusser, der skal analyseres.

Baseline Threshold
(Baselinetærskler)

Åbner vinduet Baseline Threshold
(Baselinetærskler) for at justere baseline
eller tærskel.

Trace Styles (Kurvelinjelayout) Åbner vinduet Trace Styles
(Kurvelinjelayout).

Plate Setup (Pladeopsætning) Åbner Plate Editor (Pladeeditor) for at vise
og redigere pladen eller udskifte den
aktuelle plade med en fra en
brugerdefineret pladefil eller en PrimePCR-
kørselsfil.

Include All Excluded Wells
(Medtag alle udeladte brønde)

Medtager alle udeladte brønde i analysen.

Mouse Highlighting
(Musefremhævning)

Aktiverer eller deaktiverer den samtidige
fremhævning af data med musemarkøren.

Tip: Hvis Mouse Highlighting
(Musefremhævning) er slået fra, kan
du trykke på tasten Control for at slå
fremhævning midlertidigt til.

Restore Default Window Layout
(Gendan standard-vindueslayout)

Gendanner opstillingen af vinduer til
standardindstillingen.

Tabel 16. Punkter på menulinjen i vinduet Data Analysis (Dataanalyse), fortsat
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Menupunkt Kommando Funktion

Export
(Eksportér)

Export All Data Sheets to Excel
(Eksportér alle dataark til Excel)

Eksporterer alle regnearksvisninger fra alle
faner til en separat Excel-fil.

Custom Export (Tilpasset
eksport)

Åbner vinduet Custom Export (Tilpasset
eksport), hvor du kan angive de felter, der
skal eksporteres, samt filformatet.

Export to LIMS Folder (Eksportér
til LIMS-mappe)

Åbner et vindue til lagring af data i et
forudangivet format i LIMS-mappen.

Seegene Export (Seegene-
eksport)

Åbner et vinduet til identifikation af
placeringen til lagring af data fra alle
regnearksvisninger til Excel-filer,
struktureret specifikt til brug af Seegene,
Inc.

Tools (Værktøjer) Reports (Rapporter) Åbner vinduet Report (Rapport) for denne
datafil.

Well Group Reports (Rapporter
for brøndgruppe)

Åbner vinduet Well Group Report (Rapport
for brøndgruppe) til oprettelse af rapporter
for angivne brøndgrupper.

Import Fluorophore Calibration
(Importér fluoroforkalibrering)

Vælg en kalibreringsfil, der skal anvendes
på den aktuelle datafil.

qbase+ Starter qbase+ version 2.5 direkte fra den
aktuelle .pcrd-fil, hvis installeret.

Tabel 16. Punkter på menulinjen i vinduet Data Analysis (Dataanalyse), fortsat
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Fanen Details (Detaljerede oplysninger)
Hver fane i vinduet Data Analysis (Dataanalyse) viser data i diagrammer og regneark for en specifik
analysemetode og indeholder en brøndvælger, der bruges til at vælge de data, der skal vises. Når
Data Analysis (Dataanalyse) åbnes, vises fanen Quantification (Kvantifikation) som standard. Du kan
bruge amplifikationsdiagramdataene på fanen Quantification (Kvantifikation) til at bestemme de
optimale analyseindstillinger for kørslen.

Bemærk: Softwaren linker dataene i ruderne i hver af fanerne i Data Analysis (Dataanalyse). For
eksempel vil fremhævning af en brønd ved at placere musemarkøren over brønden i
brøndvælgervisningen fremhæve dataene i alle de andre ruder.
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Vinduet Data Analysis (Dataanalyse)

Vælgeren Step Number (Trinnummer)
Systemerne CFX96 og CFX96 DeepWell kan indhente fluorescensdata ved flere forskellige
protokoltrin. Softwaren gemmer dataene, som er optaget i hvert enkelt trin, separat. I softwaren vises
vælgeren Step Number (Trinnummer). Hvis en protokol indeholder mindst ét dataindsamlingstrin,
viser CFX Manager Dx software data fra det første indsamlingstrin.

Hvis protokollen indeholder mere end ét indsamlingstrin, kan du vælge et andet trin fra rullelisten, for
eksempel:

Hvis du vælger et trin, anvender softwaren valget på alle data, som vises i vinduet Data Analysis
(Dataanalyse).

Visning af Well Groups (Brøndgrupper) i Data Analysis
(Dataanalyse)
Brøndene på en plade kan grupperes i undersæt med henblik på individuel analyse ved hjælp af
brøndgrupper. Når der oprettes brøndgrupper, vises navnene på disse i rullelisten Well Groups
(Brøndgrupper) på værktøjslinjen i vinduet Data Analysis (Dataanalyse).

Hvis der er oprettet brøndgrupper, viser softwaren standardbrøndgruppen All Wells (Alle brønde), når
vinduet Data Analysis (Dataanalyse) åbnes, med data for samtlige brønde med indhold vist i
diagrammer og regneark. Det er kun de brønde i brøndgruppen, som har indhold, der vises i
brøndvælgeren, og det er kun data for disse brønde, der medtages i dataanalyseberegningerne.

Bemærk: Hvis der ikke er oprettet nogen brøndgrupper, vises rullelisten Well Groups
(Brøndgrupper) ikke på værktøjslinjen.

Ændring af brøndindhold efter en kørsel
Under dataanalyse vil en ændring af den måde, som data vises på via ændring af indholdet af brønde i
Plate Editor (Pladeeditor) aldrig ændre de fluorescensdata, som blev indsamlet fra hver brønd i løbet
af kørslen. Efter at modulet har indsamlet fluorescensdata, kan disse data ikke slettes, men du kan
vælge at fjerne dem fra visning og analyser.

Sådan ændres indholdet af brønde efter en kørsel

u Klik på Plate Setup (Pladeopsætning) i vinduet Data Analysis (Dataanalyse), og vælg én af
følgende valgmuligheder:

n Edit/View Plate (Rediger/vis plade) – åbner Plate Editor (Pladeeditor), hvor du kan foretage
manuelle ændringer i layoutet.
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n Replace Plate file (Udskift pladefil) – åbner browseren Select Plate (Vælg plade), hvor du
kan navigere til en tidligere gemt pladefil, som det aktuelle pladelayout skal erstattes med.

n Apply PrimePCR file (Anvend PrimePCR-fil) – åbner dialogboksen Select PrimePCR file
(Vælg PrimePCR-fil), hvor du kan navigere til en PrimePCR™ kørselsfil og anvende den på
pladelayoutet.

Tip: Du kan tilføje eller redigere oplysninger om brøndens indhold før en kørsel, under en kørsel
eller efter fuldførelse af en PCR-kørsel. Du skal tildele scanningstilstand og pladestørrelse før
kørslen. Disse parametre kan ikke ændres efter kørslen.
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Indstillinger for dataanalyse

Indstillinger for dataanalyse
Data i diagrammet Amplification (Amplifikation) på fanen Quantification (Kvantifikation) viser den
relative fluorescens (RFU) for hver af brøndene i hver cyklus. Hver kurvelinje på diagrammet
repræsenterer data fra en enkelt fluorofor i én brønd. Disse data bruges til at bestemme Cq-værdierne
for hver enkelt brønd på basis af hver enkelt fluorofor. Softwaren anvender én af to måder til at
bestemme Cq-værdierne:

n Regression – anvender en nonlineær regressionsmodel med flere variabler på de individuelle
brøndkurvelinjer og bruger derefter denne model til at beregne en optimal Cq-værdi.

n Single Threshold (Enkelt tærskel) – anvender en enkelt tærskelværdi til at beregne Cq-værdien
baseret på det punkt, hvor tærsklerne for de individuelle fluorescenskurvelinjer krydser hinanden.

Vælg Settings > Cq Determination Mode (Indstillinger > Cq-bestemmelsestilstand) for at vælge Cq-
bestemmelsesmåde.

Justering af tærsklen
I tilstanden Single Threshold (Enkelt tærskel) kan du justere tærsklen for en fluorofor ved at klikke på
tærskellinjen i diagrammet Amplification (Amplifikation) og bevæge musemarkøren lodret. Alternativt
kan du specificere en præcis krydstærskel for den valgte fluorofor.

Baselineindstillinger
Softwaren indstiller automatisk baseline individuelt for hver brønd. Baselineindstillingen fastlægger
metoden til subtraktion af baseline for alle fluorescenskurvelinjer. Softwaren indeholder tre muligheder
for subtraktion af baseline:

n No Baseline Subtraction (Ingen subtraktion af baseline) – viser data som relative
fluorescenskurvelinjer. Visse analyser er ikke mulige i denne analysetilstand og softwaren viser
derfor ikke fanerne Gene Expression (Genekspression), End Point (Endepunkt) og Allelic
Discrimination (Alleldiskrimination).

n Baseline Subtracted (Baseline subtraheret) – viser data som kurvelinjer med subtraheret
baseline for hver fluorofor i en brønd. Softwaren skal subtrahere baseline fra dataene for at
fastlægge kvantifikationscyklusser, konstruere standardkurver og fastlægge koncentrationen af
ukendte prøver. For at generere en baseline-subtraheret kurvelinje indpasser softwaren den
bedste lige linje gennem den registrerede fluorescens for hver brønd under baseline-cyklusserne
og subtraherer derefter de bedst tilpassede data fra de baggrunds-subtraherede data i hver
cyklus.

n Baseline Subtracted Curve Fit (Baseline-subtraheret kurvetilpasning) – viser data som
baseline-subtraherede kurvelinjer, og softwaren udjævner den baseline-subtraherede kurve ved
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brug af et centreret middelværdifilter. Denne proces udføres således, at hver Cq forbliver
invariant.

Foruden disse muligheder kan du også vælge Apply Fluorescent Drift Correction (Anvend korrektion for
fluorescensafvigelse). For brønde, som har unormalt afvigende RFU-værdier under de første få cyklusser
af en kørsel, udleder softwaren en anslået baseline fra tilstødende brønde, der blev genereret en
horisontal baseline for uden fejl.

Sådan ændres indstillingen for baseline-subtraktion

u Vælg Settings (Indstillinger) > Baseline Setting (Baselineindstilling).

Analysetilstand
Data kan grupperes og analyseres enten efter fluorofor eller navn på målsekvens (target). Ved
gruppering efter fluorofor vises datakurvelinjerne efter fluorofor som angivet i pladeopsætningen for den
pågældende kørsel. Data for de individuelle fluoroforer vises i amplifikations- og standardkurve-
diagrammerne (hvis tilgængelige), når afkrydsningsfelterne for de relevante fluoroforer er markeret.
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Ved gruppering efter målsekvens (target) vises datakurvelinjerne efter navn på målsekvens som
angivet i pladeopsætningen for den pågældende kørsel.

Sådan vælges en dataanalysetilstand

u Gør et af følgende:

n Vælg Settings > Analysis Mode (Indstillinger > Analysetilstand).

n Vælg en tilstand i rullemenuen Analysis Mode (Analysetilstand) på værktøjslinjen.

Cyklusser, der skal analyseres
Du kan begrænse antallet af cyklusser, som skal analyseres. Du kan desuden analysere data fra et
specifikt sæt cyklusser. Det maksimale antal cyklusser, som kan analyseres, er 50.

Bemærk: Hvis cyklusser fjernes fra begyndelsen af en kørsel, kan det have en væsentlig
indflydelse på beregning af baseline.

Sådan begrænses dataanalyse til et specifikt cyklusområde

1. Vælg Settings > Cycles to Analyze (Indstillinger > Cyklusser, der skal analyseres).

Dialogboksen Cycles to Analyze (Cyklusser, der skal analyseres) vises.

2. Indtast værdier for start- og slutcyklus, og klik på OK.

Klik på Restore Defaults (Gendan standarder) i dialogboksen Cycles to Analyze (Cyklusser, der skal
analyseres) for at vende tilbage til de cyklusser, som oprindeligt blev anvendt til analyse.
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Brøndvælger
BrugWell Selector (Brøndvælger) til at vise eller skjule data i diagrammerne eller regnearkene overalt
i vinduet Data Analysis (Dataanalyse). Der kan kun vælges brønde med prøve i brøndvælgeren.
Softwaren farver brøndene i Well Selector (Brøndvælger):

n Blå – angiver valgte brønde. Dataene fra de valgte brønde vises i vinduet Data Analysis
(Dataanalyse).

n Lysegrå – angiver ikke-valgte brønde. Data fra ikke-valgte brønde vises i vinduet Data Analysis
(Dataanalyse).

n Mørkegrå – angiver tomme brønde.

Sådan vises eller skjules brønddata

u I brøndvælgeren skal du gøre et af følgende:

n For at skjule en enkelt brønd skal du klikke på den. For at vise den pågældende brønd skal
du klikke på den igen.

n For at skjule flere brønde skal du trække på tværs af de brønde, der skal skjules. For at vise
disse brønde skal du trække musen på tværs af brøndene igen.

n Klik i øverste venstre hjørne af pladen for at skjule alle brønde. Klik i øverste venstre hjørne
igen for at vise alle brøndene.

n Klik på begyndelsen af en kolonne eller række for at skjule disse brønde. Klik på kolonnen
eller række igen for at vise brøndene.
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Genvejsmenupunkter for brøndvælger
Tabel 17 indeholder en liste over de genvejsmenupunkter, der er tilgængelige i
brøndvælgervisningen.

Element Funktion

Well XX (Brønd XX) Viser kun denne brønd, fjerner denne brønd fra visningen, indstiller
farve for denne brønd eller udelader denne brønd fra analyse.

Selected Wells (Valgte brønde)
(højreklik og træk)

Viser kun disse brønde, fjerner disse brønde fra visningen, indstiller
farve for disse brønde eller udelader disse brønde fra analyse.

Copy (Kopiér) Kopierer indholdet af brønden til udklipsholderen, herunder Sample
Type (Prøvetype) og valgfrit Replicate # (Replikatnummer).

Copy as Image (Kopiér som
billede)

Kopierer brøndvælgervisningen som et billede.

Print (Udskriv) Udskriver brøndvælgervisningen.

Print Selection (Udskriv valgte) Udskriver det aktuelt markerede.

Export to Excel (Eksportér til
Excel)

Eksporterer data til et Excel-regneark.

Export to CSV (Eksportér til
CSV)

Eksporterer data som et tekstdokument.

Export to Xml (Eksportér til Xml) Eksporterer data som et .xml-dokument.

Well Labels (Brøndbetegnelser) Ændrer brøndbetegnelser til Sample Type (Prøvetype), Target
Name (Navn på målsekvens) eller Sample Name (Prøvenavn).

Tabel 17. Genvejsmenupunkter for brøndvælger
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Midlertidig udeladelse af brønde fra analyse
Sådan udelades brønde midlertidigt fra dataanalyse

1. Højreklik på brønden i brøndvælgeren. For at udelade flere brønde skal du højreklikke og trække
for at fremhæve flere brønde, kurvelinjer eller punkter.

2. Vælg det relevante genvejsmenupunkt:

n Well > Exclude Well (Brønd > Udelad brønd)

n Selected Wells > Exclude from Analysis (Valgte brønde > Udelad fra analyse)

n Selected Traces > Exclude these wells from Analysis (Valgte kurvelinjer > Udelad disse
brønde fra analyse)

Alternativt kan du rydde indholdet fra brøndene i Plate Editor (Pladeeditor) ved at klikke på
knappen Clear Wells (Ryd brønde) for at fjerne brønde permanent fra analyse.

Vigtigt: Du skal indtaste alt brøndindhold igen, hvis det ryddes.

Sådan medtages en udeladt brønd

u Højreklik på den relevante brønd i brøndvælgeren, og vælg Well (Brønd) > Include Well in
Analysis (Medtag brønd i analyse).
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Diagrammer
Hvert diagram i vinduet Data Analysis (Dataanalyse) viser dataene i en forskellig graf og indeholder
valgmuligheder til justering og eksport af dataene og diagrammets grafik.

Fælles genvejsmenupunkter for diagrammer
Tabel 18 indeholder en liste over de genvejsmenupunkter, der er tilgængelige for diagrammer. Visse
af de tilgængelige menupunkter findes for alle diagrammer, og disse kan anvendes til at ændre,
hvordan data vises, eller til nemt at eksportere data fra et diagram.

Element Funktion

Copy (Kopiér) Kopierer diagrammet til udklipsholderen.

Save Image As (Gem
billede som)

Gemmer billedet i den specificerede størrelse, opløsning og filtype. De
tilgængelige billedformater er PNG (standard), JPG og BMP.

Page Setup
(Sideopsætning)

Vis og vælg sideopsætning til udskrift.

Print (Udskriv) Udskriver diagrammet.

Set Scale to Default (Indstil
skala til standard)

Stiller diagrammet tilbage til dets standardvisning efter at have forstørret
det.

Chart Options
(Valgmuligheder for
diagrammer)

Åbner vinduet Chart Options (Valgmuligheder for diagrammer), hvor det
er muligt at ændre diagrammet, herunder at ændre titlen, vælge
grænser for x- og y-akserne, vise gitterlinjer og vise underinddelinger på
akserne.

Tabel 18. Genvejsmenupunkter for diagrammer

Bemærk: Menupunkter, som kun gælder for specifikke diagrammer, er beskrevet i Kapitel 10,
Detaljerede oplysninger om dataanalyse.
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Kopiering af diagramdata til udklipsholderen
Du kan kopiere indholdet af diagramvisningen og indsætte det i en hvilken som helst applikation, der
kan bruge bitmap-billedfiler.

Sådan kopieres diagramdata til udklipsholderen

1. Fra diagrammets genvejsmenu skal du vælge Copy (Kopiér).

2. Åbn en applikation, der kan bruge bitmap-billeder, f.eks. Microsoft Word.

3. Højreklik og vælg Paste (Sæt ind) for at indsætte bitmap-billedet fra udklipsholderen i
applikationen.

Ændring af indstillingerne for Baseline Threshold
(Baselinetærskel)
I tilstanden Single Threshold (Enkelt tærskel) kan du justere tærsklen for en fluorofor ved at klikke på
tærskellinjen i amplifikationsdiagrammet og bevæge musemarkøren lodret. Alternativt kan du
specificere en præcis krydstærskel for den valgte fluorofor.

Tip: Du kan angive et cyklusområde for at fastlægge baseline for alle datafiler på fanen Data
Analysis (Dataanalyse) i User > User Preferences (Bruger > Brugerpræferencer).
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Sådan justeres start og slut for en baselinecyklus for hver brønd

1. Vælg en enkelt fluorofor på fanen Quantification (Kvantifikation) under amplifikationsdiagrammet.

2. Vælg Baseline Threshold (Baselinetærskel) i diagrammets genvejsmenu.

Dialogboksen Baseline Threshold (Baselinetærskel) vises.

3. Gør et af følgende i sektionen Baseline Cycles (Baselinecyklusser):

n For at vælge en brønd skal du klikke på dens rækkenummer.

n For at vælge flere brønde, der støder op til hinanden, skal du klikke på rækkenummeret for
den første brønd og trække ned over kolonnen til den sidste brønd.

n For at vælge flere brønde, der ikke støder op til hinanden, skal du holde Ctrl-tasten nede og
klikke på rækkenummeret for de enkelte brønde, der skal medtages.

n For at vælge alle brønde skal du klikke i øverste venstre hjørne af tabellen.

4. Juster cyklus for Baseline Begin (Baseline start) og Baseline End (Baseline slut) for alle valgte
brønde, eller rediger cyklustallet under Begin (Start) og End (Slut) nederst på regnearket.

Tip: For at vende tilbage til de sidst gemte værdier skal du klikke på Reset All User Defined
Values (Nulstil alle brugerdefinerede værdier).

5. Klik på OK for at gemmeændringerne og vende tilbage til diagrammet.
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Sådan specificeres et cyklusområde for alle datafiler

u Vælg User > User Preferences (Bruger > Brugerpræferencer) i startvinduet eller vinduet Plate
Editor (Pladeeditor), og vælg fanen Data Analysis (Dataanalyse).

Sortering af data for målsekvens (target) og prøve
Bemærk: Denne valgmulighed er kun tilgængelig på diagrammer for genekspression.

Som standard vises listerne Targets (Målsekvenser) og Samples (Prøver) i alfabetisk rækkefølge.
Brug dialogboksen Sort (Sortér) til at sortere visningen i omvendt alfabetisk rækkefølge eller til
manuelt at flytte en term til en anden placering på listen.

Sådan sorteres data vedrørende målsekvens (target) og prøve

1. Klik på Sort (Sortér) i diagrammets genvejsmenu.

Dialogboksen Gene Expression Chart Sorting (Sortering af diagrammet Genekspression) åbnes.

2. Klik på Z-A i dialogboksen for at sortere listen i omvendt alfabetisk rækkefølge.

3. For at flytte en term manuelt skal du vælge den og klikke på den relevante knap mellem
diagrammerne:

n Klik på pil op eller pil ned for at flytte den valgte term én position.

n Klik på pil op med slutstreg eller pil ned med slutstreg for at flytte den valgte term til toppen
eller bunden af listen.

4. Klik på OK for at gemmeændringerne og gå tilbage til fanen Gene Expression (Genekspression).
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Forstørrelse af et område i diagrammet
Sådan forstørres et område i diagrammet

u Klik og træk på tværs af diagrammet, og klik derefter på Zoom*. Softwaren tilpasser størrelsen på
diagrammet og centrerer det på det valgte område.

Bemærk: * Det er ikke nødvendigt at klikke på pop op-kommandoen Zoom i
søjlediagrammer.

Sådan nulstilles diagrammet til fuld visning

u Højreklik i diagrammet, og vælg Set Scale to Default (Indstil skala til standard).

Kopiering af diagrammer til en Microsoft-fil
Du kan kopiere datadiagrammer til Microsoft Word, Excel eller PowerPoint. Billedets opløsning svarer
til den, der gælder for den skærm, som billedet blev hentet fra

Sådan kopieres diagrammer til en Microsoft-fil

1. Vælg Copy (Kopiér) i diagrammets genvejsmenu i vinduet Data Analysis (Dataanalyse).

2. Åbn en tomMicrosoft-fil, og indsæt indholdet fra udklipsholderen.

Alternativ: Klik på klik-og-træk-ikonet, og træk og slip diagrammet til en Microsoft-fil.
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Regneark
De regneark, der vises i Data Analysis (Dataanalyse), indeholder indstillinger til sortering og overførsel
af data. Sortér kolonnerne ved at bruge en af disse metoder:

n Klik på og træk en kolonne til en ny placering i den valgte tabel.

n Klik på kolonneoverskriften for at sortere dataene i stigende eller faldende rækkefølge.

Sådan sorteres op til tre kolonner med data i vinduet Sort (Sortér)

1. Højreklik i regnearket, og vælg Sort (Sortér).

2. Vælg den første kolonnetitel, der skal sorteres, i dialogboksen Sort (Sortér). Sortér dataene i
stigende eller faldende rækkefølge.

3. Vælg en anden eller tredje kolonne, der skal sorteres, og vælg Ascending (Stigende) eller
Descending (Faldende).

4. Klik på OK for at sortere dataene, eller klik på Cancel (Annuller) for at stoppe sorteringen.

Fremhæv dataene i de tilknyttede diagrammer og brøndvælgeren ved at holde musemarkøren hen
over en celle. Klik i en celle for at kopiere og indsætte indholdet i et andet softwareprogram.

Fælles genvejsmenupunkter for regneark
Tabel 19 indeholder en liste over genvejsmenupunkterne i alle regnearksvisninger.

Element Funktion

Copy (Kopiér) Kopierer indholdet af de valgte brønde til en udklipsholder. Herfra
kan indholdet indsættes i et regneark som for eksempel Excel.

Copy as Image (Kopiér som
billede)

Kopierer regnearksvisningen som en billedfil, som derefter kan
indsættes i en fil, der kan bruge billedfiler, som for eksempel tekst-,
billed- eller regnearksfiler.

Print (Udskriv) Udskriver den aktuelle visning.

Print Selection (Udskriv valgte) Udskriver det aktuelt markerede.

Export to Excel (Eksportér til
Excel)

Eksporterer data til et Excel-regneark.

Tabel 19. Genvejsmenupunkter for regneark
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Element Funktion

Export to CSV (Eksportér til
CSV)

Eksporterer data til en kommasepareret (.csv) fil.

Export to Xml (Eksportér til Xml) Eksporterer data til en Xml-fil.

Export to Html (Eksportér til
Html)

Eksporterer data til en Html-fil.

Find Søger efter tekst.

Sort (Sortér) Sorterer data i op til tre kolonner.

Select Columns (Vælg kolonner) Vælger de kolonner, der vil blive vist i regnearket.

Tabel 19. Genvejsmenupunkter for regneark, fortsat
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Eksport
CFXManager Dx software har fire valgmuligheder for eksport i rullemenuen Export (Eksporter):

n Export All Data Sheets (Eksporter alle dataark)

n Custom Export (Tilpasset eksport)

n Export to LIMS (Eksporter til LIMS)

n Seegene Export (Seegene-eksport)

Eksport af alle dataark
Du kan eksportere alle regnearksvisninger fra samtlige faner på CFX Manager Dx software til
individuelle filer.

Sådan eksporteres alle dataark

u Vælg Export > Export All Data Sheets (Eksporter > Eksportér alle dataark), og vælg derefter den
ønskede filtype:

n CSV (*.csv)

n Tekst (*.txt)

n Excel 2007 (*.xlsx)

n Excel 2003 (*.xls)

n XML (*.xml)
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Oprettelse af en tilpasset eksportfil
Sådan oprettes en tilpasset eksportfil

1. Vælg Export > Custom Export (Eksport > Tilpasset eksport). Dialogboksen Custom Export
(Tilpasset eksport) vises.

2. Vælg eksportformatet på den rulleliste, der vises.

3. Vælg afkrydsningsfelterne for de elementer, som skal eksporteres.

4. (Valgfrit) Klik på Customize Column Names (Tilpas kolonnenavne) for at ændre kolonnenavne.

5. Klik på Export (Eksportér). Dialogboksen Save As (Gem som) vises.

6. Angiv et filnavn og en placering, hvor den eksporterede fil skal gemmes, i dialogboksen Save As
(Gem som).

7. Klik på OK for at gemme den eksporterede fil.
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Eksport til en LIMS-mappe
Du kan eksportere data til et LIMS-kompatibelt filformat.

Sådan eksporteres data i LIMS-format

1. Vælg Export > Export to LIMS Folder (Eksportér > Eksportér til LIMS-mappe).

Dialogboksen Save As (Gem som) vises.

2. Angiv et filnavn og en placering, hvor den eksporterede fil skal gemmes, i dialogboksen Save As
(Gem som).

3. Klik på OK for at gemme den eksporterede fil.

Eksport af Seegene-formaterede data
Du kan eksportere data alle regnearksvisninger til Excel-filer, struktureret specifikt til brug af Seegene,
Inc.

Sådan eksporteres data i et Seegene-specifikt format

1. Vælg Export > Seegene Export (Eksport > Seegene-eksport).

Dialogboksen Save As (Gem som) vises.

2. I dialogboksen Save As (Gem som) specificeres en mappeplacering, hvor de eksporterede
Seegene-formaterede Excel (.xlsx)-filer skal gemmes.

3. Klik på OK for at gemme de eksporterede filer.
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CFXManager™ Dx softwarens vindue Data Analysis (Dataanalyse) har flere faner til visning af data.
Dette kapitel forklarer disse faner i detaljer.

Tip: Du kan vælge, hvilke faner der skal vises i vinduet Data Analysis (Dataanalyse), i menuen
View (Vis). Det tilpassede layout gemmes med datafilen.
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Fanen Quantification (Kvantifikation)
Brug dataene på fanen Quantification (Kvantifikation) til at indstille betingelserne for dataanalysen,
herunder baselineindstillinger for individuelle brønde og tærskelindstillinger. Fanen Quantification
(Kvantifikation) viser data i fire visninger:

n Diagrammet Amplification (Amplifikation) – viser relative fluorescensenheder (RFU'er) for hver
brønd ved hver cyklus. Hver kurvelinje på diagrammet repræsenterer data fra en enkelt fluorofor i
én brønd.

n Standard curve (Standardkurve) – vises kun, hvis kørslen omfatter brønde, der er angivet som
prøvetypestandard (Std). Standardkurven viser tærskelcyklussen plottet mod log af
startmængden. Beskrivelsen viser reaktionseffektivitet (E) for hver fluorofor i brøndene med en
standardprøvetype.

n Well selector (Brøndvælger) – vælger brøndene med de fluorescensdata, der skal vises.

n Regneark – viser et regneark med data, der er indsamlet i de valgte brønde.

Valgmuligheder for fluorofor
For at vise fluorofordata i diagrammer og regneark på fanen Quantification (Kvantifikation) skal du
vælge fluoroforen/fluoroforerne under diagrammet Amplification (Amplifikation). For at skjule
fluorofordataene i dataanalysevinduet skal du fjerne markeringen i det tilhørende afkrydsningsfelt.
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Dialogboksen Trace Styles (Kurvelinjelayout)
Du kan bruge dialogboksen Trace Styles (Kurvelinjelayout) til at tilpasse visningen af kurvelinjer i
amplifikations- og smeltekurvediagrammer på fanerne Quantification (Kvantifikation) og Melt Curve
(Smeltekurve). Du kan derefter gennemgå ændringerne i brøndvælgeren, som vises i dialogboksen
Trace Styles (Kurvelinjelayout).

Sådan justeres kurvelinjelayout

1. Vælg kun én fluorofor under diagrammet Amplification (Amplifikation).

2. For at åbne dialogboksen Trace Styles (Kurvelinjelayout) skal du gøre et af følgende:

n Klik på Trace Styles (Kurvelinjelayout) i diagrammet Amplification (Amplifikation).

n Vælg Settings > Trace Styles (Indstillinger > Kurvelinjelayout) på menulinjen Data Analysis
(Dataanalyse).

n Højreklik på en kurvelinje, og vælg Trace Styles (Kurvelinjelayout).

Dialogboksen Trace Styles (Kurvelinjelayout) åbnes.

3. I dialogboksen Trace Styles (Kurvelinjelayout) skal du vælge et specifikt sæt brønde i
brøndvælgeren i den nederste rude. Alternativt kan du vælge brønde, som indeholder én
prøvetype, i rullemenuen i kolonnenWells (Brønde).

Driftsvejledning | 191



Kapitel 10 Detaljerede oplysninger om dataanalyse

4. Gør et af følgende:

n For at vælge en farve til de valgte brønde skal du klikke på feltet i kolonnen Color (Farve).

n For at tildele et symbol til de valgte brønde skal du vælge et symbol på rullelisten Symbol.

n For at farve brøndene hurtigt efter knapbetegnelsen skal du klikke på den relevante
hurtigindstilling:

o Random byWell (Vilkårlig efter brønd)

o Random by Replicate (Vilkårlig efter replikat)

o Use Fluor Colors (Anvend fluorfarver)

o Use Target Colors (Anvend målsekvensfarver)

o Use Sample Colors (Anvend prøvefarver)

n For at tildele nye brøndbetegnelser skal du vælge enten Sample Type (Prøvetype), Target
Name (Navn på målsekvens), Sample Name (Prøvenavn) eller Symbol.

Funktionen Log Scale (Logaritmisk Skala)
Vælg Log Scale (Logaritmisk skala) under diagrammet Amplification (Amplifikation) for at vise
fluorescenskurvelinjerne på en semilogaritmisk skala:

Tip: For at forstørre et vilkårligt område i diagrammet skal du trække på tværs af det ønskede
område. For at vende tilbage til fuld visning skal du højreklikke på diagrammet og vælge Set
Scale to Default (Indstil skala til standard).
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Standardkurve-diagram
Softwaren opretter et Standard Curve-diagram (Standardkurve-diagram) på fanen Quantification
(Kvantifikation), hvis dataene omfatter prøvetyper defineret som Std (Standard) for mindst én fluorofor
i kørslen.

Diagrammet Standard Curve (Standardkurve) indeholder følgende oplysninger:

n Navnet på hver af kurverne (fluoroforen eller målsekvensen (target)).

n Farven på hver fluorofor eller hver målsekvens (target).

n Reaktionseffektivitet (E). Disse statistiske oplysninger kan anvendes til at optimere en
multiplexreaktion og udligne data til standardkurven.

Bemærk: Reaktionseffektiviteten beskriver, hvor meget der bliver produceret af
målsekvensen (target) i hver af protokollens cyklusser. En effektivitet på 100 % angiver, at
målsekvensen (target) fordobles med hver cyklus.

n Bestemmelseskoefficient, R2 (anført som R^2). Disse statistiske oplysninger kan anvendes til at
bestemme, hvor korrekt linjen beskriver dataene (tilpasningsgrad).

n Slope (Hældning)

n y-skæringspunkt
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Menupunkter for Amplification Chart (Amplifikationsdiagram)
Udover de fælles genvejsmenupunkter (se Fælles genvejsmenupunkter for diagrammer på side 179) er
der andre genvejsmenupunkter, der kun er tilgængelige i diagrammet Amplification (Amplifikation). De
vises i Tabel 20.

Bemærk: Standard Curve Chart (Standardkurvediagram) har kun de fælles
genvejsmenupunkter.

Menupunkt Funktion

Show Threshold Values (Vis
tærskelværdier)

Viser tærskelværdien for hver amplifikationskurve på diagrammet.

Trace Styles (Kurvelinjelayout) Åbner vinduet Trace Styles (Kurvelinjelayout), hvor
kurvelinjelayoutet, der vises på fanerne Quantification
(Kvantifikation) og Melt Curve (Smeltekurve), kan ændres.

Baseline Thresholds
(Baselinetærskler)

Åbner vinduet Baseline Thresholds (Baselinetærskler), hvor du
kan ændre baseline eller tærskler for hver fluorofor (ændringerne
kan ses i diagrammet Amplification (Amplifikation) på fanen
Quantification (Kvantifikation)).

Tabel 20. Menupunkter for Amplification (Amplifikation) ved højre- og venstreklik

Fanen Quantification (Kvantifikation) i regneark
Tabel 21 definerer de data, der vises i regnearket på fanen Quantification (Kvantifikation).

Oplysninger Beskrivelse

Well (Brønd) Brøndens position på pladen

Fluor Detekteret fluorofor

Target (Målsekvens) Navn på den målsekvens (target), der er indlæst i brøndene i Plate
Editor (Pladeeditor)

Content (Indhold) En kombination af Sample Type (Prøvetyp) (påkrævet) og Replicate
# (Replikatnummer) (valgfrit) indlæst i Plate Editor (Pladeeditor)

Sample (Prøve) Sample Name (Prøvenavn) indlæst i brøndene i Plate Editor
(Pladeeditor)

Cq Kvantifikationscyklus for hver kurvelinje

Tabel 21. Indholdet på fanen Quantification (Kvantifikation) i regnearket
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Ændring af målsekvens- (target), indholds- eller prøvedata

Du kan ændre dataene i kolonnerne Target (Målsekvens), Content (Indhold) og Sample (Prøve) ved at
redigere pladefilen med Plate Editor (Pladeeditor) – også selv om eksperimentet er blevet kørt.

Sådan ændres dataene i kolonnerne Target (Målsekvens), Content (Indhold) og Sample
(Prøve)

u Klik på Plate Setup (Pladeopsætning), og vælg View/Edit Plate (Vis/rediger plade) for at åbne
Plate Editor (Pladeeditor).
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Fanen Quantification Data (Kvantifikationsdata)
Fanen Quantification Data (Kvantifikationsdata) viser de kvantifikationsdata, som indsamles i hver
brønd. CFX Manager Dx software viser dataene i fire forskellige regnearksvisninger:

n Results (Resultater) – viser et regneark med dataene. Dette er standardvisningen.

n Standard Curve Results (Standardkurve-resultater) – viser et regneark med standardkurve-
dataene.

n Plate (Plade) – viser dataene i hver brønd som et pladekort.

n RFU – viser RFU-mængder i hver brønd for hver cyklus.

Vælg hvert regneark på rullelisten, som vises neden for fanen Quantification Data
(Kvantifikationsdata).

Regnearket Results (Resultater)
Regnearket Results (Resultater) viser data for hver brønd i en plade.

Bemærk: Alle Std. Dev (standardafvigelse)-beregninger gælder for de replikatgrupper, der er
tildelt i brøndene i vinduet Plate Editor (Pladeeditor). Beregningerne udregner gennemsnittet af
Cq-værdien for hver brønd i replikatgruppen.

Tabel 22 definerer de data, der vises i regnearket Results (Resultater).
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Oplysninger Beskrivelse

Well (Brønd) Brøndens position på pladen

Fluor Detekteret fluorofor

Target (Målsekvens) Navn på amplifikationsmålsekvensen (target) (gen)

Content (Indhold) Prøvetype og replikatnummer

Sample (Prøve) Beskrivelse af prøven

Biological Set Name (Navn på
biologisk sæt)

Navnet på det biologiske sæt

Cq Kvantifikationscyklus

CqMean (Cq-middelværdi) Middelværdien for kvantifikationscyklussen for replikatgruppen

Cq Std. Dev (Cq-
standardafvigelse)

Standardafvigelse for kvantifikationscyklussen for replikatgruppen

Starting Quantity (SQ)
(Startmængde (SQ))

Anslået startmængde for målsekvensen (target)

Log Starting Quantity (Log af
startmængde)

Log af startmængden

SQMean (SQ-middelværdi) Middelværdi for startmængden

SQ Std. Dev (Cq-
standardafvigelse)

Standardafvigelse for startmængden på tværs af replikater

Tabel 22. Indhold i regnearket Results (Resultater)
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Regnearket Standard Curve Results (Standardkurve-resultater)
Regnearket Standard Curve Results (Standardkurve-resultater) viser de beregnede standardkurve-
parametre.

Tabel 23 definer de data, der vises i regnearket Standard Curve Results (Standardkurve-resultater).

Oplysninger Beskrivelse

Fluor (eller Target
(Målsekvens))

Detekteret fluorofor (eller målsekvens (target))

Efficiency % (Effektivitet %) Reaktionseffektivitet

Slope (Hældning) Standardkurvens hældning

Y-intercept (Y-skæringspunkt) Punkt ved hvilket kurven skærer y-aksen

R^2 Bestemmelseskoefficient

Tabel 23. Indhold i regnearket Standard Curve Results (Standardkurve-resultater)
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Regnearket Plate (Plade)
Regnearket Plate (Plade) viser et pladekort med data for én fluorofor ad gangen.

Sådan vises data for en specifik fluorofor

u Klik på dens fane nederst i regnearket.

Regnearket RFU
Regnearket RFU viser aflæsningerne af relative fluorescensenheder (RFU) for hver brønd indhentet
under hver af kørslens cyklusser. Brøndens nummer vises øverst i hver kolonne, og cyklusnummeret
vises til venstre for hver række.
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Fanen Melt Curve (Smeltekurve)
Ansvarsfraskrivelse: Bio-Rad tildeler ingen rettigheder til brug af smeltekurveanalyse i forbindelse
med højopløsningssmelteanalyser inden for in vitro-diagnosticering af mennesker og dyr. Derudover
er køber ansvarlig for at indhente eventuelle immaterielle rettigheder, sommåtte være påkrævet i
forbindelse med de specifikke anvendelser.

I forbindelse med DNA-bindende farvestoffer og ikke-spaltbare hybridiseringsprober er fluorescensen
klarest, når de to DNA-strenge hybridiseres. Derfor vil fluorescensen, når temperaturen stiger mod
smeltetemperatur (Tm), falde ved en konstant hastighed (konstant hældning). Ved Tm sker der en
dramatisk reduktion i fluorescens med en mærkbar hældningsændring. Hastigheden af denne
ændring fastlægges ved at plotte negativ først-regression af fluorescens kontra temperatur (-d
(RFU)/dT). Den største ændringshastighed i fluorescens medfører synlige kurvetoppe og
repræsenterer Tm for de dobbeltstrengede DNA-komplekser.

CFX Manager Dx software indtegner de RFU-data, der indsamles under en smeltekurve, som en
funktion af temperaturen. Med henblik på analyse af smeltekurvetopdata tildeler softwaren en start- og
sluttemperatur til hver kurvetop ved at flytte tærskellinjen. Bunden af kurvetop-området er specificeret
af smeltetærskellinjens placering. En valid kurvetop skal have en minimumhøjde i forhold til afstanden
mellem tærskellinjen og højden på den højeste kurvetop.

Fanen Melt Curve (Smeltekurve) viser Tm (smeltetemperaturen) for amplificerede PCR-produkter i fire
visninger:

n Melt Curve (Smeltekurve) – viser realtidsdata for hver fluorofor som RFU'er pr. temperatur for
hver brønd.

n Melt Peak (Smeltekurvetop) – viser den negative regression for RFU-data pr. temperatur for hver
brønd.

n Well selector (Brøndvælger) – viser brønde for at vise eller skjule dataene.

n Regneark med kurvetoppe – viser data indsamlet i den valgte brønd.

Bemærk: Dette regneark viser op til to kurvetoppe for hver kurvelinje. For at se flere
kurvetoppe skal du klikke på fanen Melt Curve Data (Smeltekurvedata).
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Tabel 24 på side 201 definerer de data, der vises i regnearket Melt Curve (Smeltekurve).

Oplysninger Beskrivelse

Well (Brønd) Brøndens position på pladen

Fluor Detekteret fluorofor

Content (Indhold) En kombination af prøvetype og repli-
katnummer

Sample (Prøve) Navn på den prøve, der er indlæst i Plate Edi-
tor (Pladeeditor)

Melt Temp (Smeltetemperatur) Temperaturen på smeltekurvetoppen for hver
brønd

Bemærk: Kun de to højeste kurvetoppe
vises i regnearket.

Tabel 24. Indhold af regnearket Melt Curve (Smeltekurve)

Driftsvejledning | 201



Kapitel 10 Detaljerede oplysninger om dataanalyse

Justering af smeltekurvedata
Sådan justeres smeltekurvedata

u Gør et af følgende:

n Klik og træk i tærskelbjælken i diagrammet Melt Peak (Smeltekurvetop) for at medtage eller
udelade kurvetoppe i dataanalysen.

n Vælg Positive i rullemenuen Peaks (Kurvetoppe) for at vise regnearksdata for toppene over
smeltetærskellinjen, eller vælg Negative for at vise regnearksdata for kurvetoppene under
smeltetærskellinjen.

n Åbn vinduet Trace Styles (Kurvelinjelayout) for at ændre farven på kurvelinjerne i
diagrammerne Melt Curve (Smeltekurve) og Melt Peak (Smeltekurvetop).

n Vælg et nummer i vælgeren Step Number (Trinnummer) for at vise data for Melt Curve
(Smeltekurve) i et andet trin i protokollen. Listen viser mere end ét trin, hvis pladen
indeholder pladeaflæsninger i mere end ét smeltekurvetrin.

n Vælg brønde i brøndvælgeren for at fokusere på undersæt af dataene.

n Vælg en brøndgruppe for at vise og analysere et undersæt af brønde på pladen. Vælg hver
enkelt brøndgruppe efter navn i rullemenuenWell Group (Brøndgruppe) på værktøjslinjen.
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Fanen Melt Curve Data (Smeltekurvedata)
Fanen Melt Curve Data (Smeltekurvedata) viser data fra fanen Melt Curve (Smeltekurve) i flere
regneark, der omfatter alle smeltekurvetoppene for hver kurvelinje. har fire valgmuligheder for
regneark til visning af smeltekurvedata:

n Melt Peaks (Smeltekurvetoppe) – viser alle dataene, herunder alle smeltekurvetoppene, for hver
kurvelinje. Dette er standardvisningen.

n Plate (Plade) – viser en visning af dataene og indholdet af hver brønd i pladen.

n RFU – viser RFU-mængderne ved hver temperatur for hver brønd.

n -d(RFU)/dT – viser den negative ændringshastighed for RFU, efterhånden som temperaturen (T)
ændres. Dette er et første regressionsplot for hver brønd i pladen.

Vælg de enkelte regneark på rullelisten, der vises på fanen Melt Curve Data (Smeltekurvedata).

Regnearket Melt Peaks (Smeltekurvetoppe)
Regnearket Melt Peaks (Smeltekurvetoppe) viser alle smeltekurvedata.

Tabel 25 på side 204 definerer de data, der vises i regnearket Melt Peaks (Smeltekurvetoppe).
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Oplysninger Beskrivelse

Well (Brønd) Brøndens position på pladen

Fluor Detekteret fluorofor

Content (Indhold) Prøvetype angivet i vinduet Plate Editor (Pladeeditor)

Target (Målsekvens) Amplifikationsmålsekvens (target) (gen)

Sample (Prøve) Prøvenavn angivet i vinduet Plate Editor (Pladeeditor)

Melt Temperature
(Smeltetemperatur)

Smeltetemperaturen for hvert produkt angivet som én kurvetop
(højeste) pr. række i regnearket

Peak Height (Kurvetophøjde) Kurvetoppens højde

Begin Temperature
(Begyndelsestemperatur)

Temperatur ved kurvetoppens begyndelse

End Temperature (Sluttemperatur) Temperatur ved kurvetoppens slutning

Tabel 25. Indhold i Regnearket Melt Peaks (Smeltekurvetoppe)

Regnearket Plate (Plade)
Regnearket Plate (Plade) viser smeltekurvedata i et pladeformat.

Bemærk: Den kurvetop, som softwaren bedømmer, kan justeres ved at justere tærskellinjen i
diagrammet Melt Peak (Smeltekurvetop) på fanen Melt Curve (Smeltekurve).

Tabel 26 på side 205 definerer de data, der vises i regnearket Plate (Plade).
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Oplysninger Beskrivelse

Content (Indhold) En kombination af Sample Type (Prøvetyp) og Replicate # (Replikatnummer)
(valgfrit)

Sample (Prøve) Beskrivelse af prøven

Peak 1 (Kurvetop 1) Første smeltekurvetop (højeste)

Peak 2 (Kurvetop 2) Anden (nederste) smeltekurvetop

Tabel 26. Indhold i regnearket Plate (Plade)

Regnearket RFU
Regnearket RFU viser fluorescens for hver brønd i hver cyklus indsamlet under smeltekurven.

Tabel 27 definerer de data, der vises i regnearket RFU.

Oplysninger Beskrivelse

Brøndnummer (A1, A2, A3, A4, A5) Brøndposition i pladen for de isatte brønde

Temperature (Temperatur) Den amplificerede målsekvens' (target)
smeltetemperatur, indtegnet som én brønd pr.
række og flere brønde for flere produkter i
samme brønd

Tabel 27. Indhold i regnearket RFU

Driftsvejledning | 205



Kapitel 10 Detaljerede oplysninger om dataanalyse

Regnearket -d(RFU)/dT
Regnearket -d(RFU)/dT viser den negative ændringshastighed i RFU, efterhånden som temperaturen
(T) ændres.

Tabel 28 definerer de data, der vises i regnearket -d(RFU)/dT.

Oplysninger Beskrivelse

Brøndnummer (A1, A2, A3, A4, A5) Brøndposition i pladen for de isatte brønde

Temperatur -d(RFU)/dT Negativ ændringshastighed i RFU, efterhånden som
temperaturen (T) ændres

Tabel 28. Indhold i regnearket -d(RFU)/dT i
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Fanen End Point (Endepunkt)
Åbn fanen End Point (Endepunkt) for at analysere endelige relative fluorescensenheder (RFU'er) for
prøvebrøndene. Softwaren sammenligner RFU-niveauer i brønde med ukendte prøver med RFU-
niveauer i brønde med negative kontroller og bedømmer de ukendte som positive eller negative.
Positive prøver har en RFU-værdi, der er større end den gennemsnitlige RFU-værdi i de negative
kontroller plus cut-off-værdien.

For at kunne analysere endepunktsdata skal pladen indeholde negative kontroller; ellers kan
softwaren ikke foretage en bedømmelse. Kør en af disse to typer protokoller:

n Kør protokollen Quantification (Kvantifikation) – opsæt en standardprotokol. Når kørslen er
færdig, skal du åbne vinduet Data Analysis (Dataanalyse), justere indstillingerne for dataanalyse
på fanen Quantification (Kvantifikation) og derefter klikke på fanen End Point (Endepunkt) for at
vælge en endepunktscyklus.

n Kør protokollen End Point Only (Kun endepunkt) – indlæs protokollen End Point Only (Kun
endepunkt) på fanen Plate (Plade) i vinduet Run Setup (Kørselsopsætning), vælg og opret en
plade, og start kørslen

Fanen End Point (Endepunkt) viser de gennemsnitlige RFU-værdier for at bestemme, om
målsekvensen (target) blev amplificeret af den sidste (ende-) cyklus. Brug dataene til at bestemme,
om der er en specifik målsekvens (target) tilstede (positiv) i en prøve. Positive målsekvenser (targets)
har højere RFU-værdier end det cut off-niveau, der blev defineret.
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Tip: For at oprette en endepunktsprotokol skal du åbne fanen Protocol (Protokol) (vinduet Run
Setup (Kørselsopsætning)) og vælge Run > End Point Only Run (Kør > Kør kun endepunkt).

Når kørslen er færdig, åbnes datafilen på fanen End Point (Endepunkt), som har følgende sektioner:

n Settings (Indstillinger) – justerer indstillingerne for dataanalyse.

n Results (Resultater) – viser resultaterne straks efter indstillingerne er justeret.

n Well Selector (Brøndvælger) – vælger brøndene med de endepunktsdata, der skal vises.

n RFU-regneark – Viser ende-RFU indsamlet i de valgte brønde.

Resultatdata
Sektionen Results (Resultater) viser følgende data:

n Lowest RFU value (Laveste RFU-værdi) – laveste RFU-værdi i dataene

n Highest RFU value (Højeste RFU-værdi) – højeste RFU-værdi i dataene

n Negative Control Average (Gennemsnit for negative kontroller) – gennemsnitlig RFU for de
brønde, som indeholder negative kontroller

n Cut Off Value (Cut-off-værdi) – beregnes ved at tilføje tolerancen (RFU eller procentdel af område
angivet under Settings (Indstillinger)) og gennemsnit for de negative kontroller. Prøver med
RFU'er, der er større end cut-off-værdien, kaldes “Positive”; rediger RFU eller Percentage of
Range (Procentdel af område) for at justere cut-off-værdien

Cut Off Value (Cut-off-værdi) beregnes ved brug af følgende formel:

Cut-off-værdi = gennemsnit for negative kontroller + tolerance

Vælg en tolerance ved brug af en af disse metoder:

n RFUs (RFU'er) (standard) – vælg denne metode for at anvende en absolut RFU-værdi for
tolerancen. Minimumværdien for RFU-tolerance er 2. Maksimum er den absolutte værdi af den
højeste RFU-værdi minus den absolutte værdi af den laveste RFU-værdi. Standardværdien for
RFU-tolerance er 10 % af det samlede RFU-område.

n Percent of Range (Procentdel af område) – vælg denne metode for at bruge en procentdel af
RFU-området som tolerance. Minimumsprocentdelen af området er 1 %.
Maksimumsprocentdelen af området er 99 %. Standardprocentdelen af området er 10 %.
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Fanen End Point (Endepunkt)

Justering af endepunktsdataanalysen
Sådan justeres data på fanen End Point (Endepunkt)

u Gør et af følgende:

n Vælg en fluorofor fra rullelisten.

n Vælg en værdi for End Cycle to Average (Slutcyklus til gennemsnitsberegning) for at indstille
antallet af cyklusser, der skal bruges til at beregne det gennemsnitlige endepunkts-RFU.

n Vælg RFU'er for at vise data i relative fluorescensenheder.

n Vælg Percentage of Range (Procentdel af område) for at vise data som en procentdel af
RFU-område.

n Vælg brønde i brøndvælgeren for at fokusere på undersæt af dataene.

n Vælg en brøndgruppe for at vise og analysere et undersæt af brønde på pladen. Vælg hver
enkelt brøndgruppe efter navn i rullemenuenWell Group (Brøndgruppe) på værktøjslinjen.

RFU-regneark til analyse af endepunkter
Tabel 29 indeholder definitioner af de data, der vises i RFU-regnearket på fanen End Point
(Endepunkt).

Oplysninger Beskrivelse

Well (Brønd) Brøndens position på pladen

Fluor Detekteret fluorofor

Content (Indhold) En kombination af prøvetype og replikatnummer

End RFU (Ende-RFU) RFU ved endepunktscyklus

Call (Bedømmelse) Positive (Positiv) eller Negative (Negativ), hvor positive prøver har en
RFU-værdi, der er større end den gennemsnitlige RFU-værdi for de
negative kontroller plus cut-off-værdien

Sample (Prøve) Sample Name (Prøvenavn) isat i Plate Editor (Pladeeditor)

Tabel 29. Indhold af regneark for endepunkt
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Fanen Allelic Discrimination (Alleldiskrimination)
Fanen Allelic Discrimination (Alleldiskrimination) tildeler genotyper til brønde med ukendte prøver.
Disse data anvendes til at identificere prøver med forskellige genotyper, herunder Allele 1 (Allel 1),
Allele 2 (Allel 2), Heterozygote (Heterozygot), No Call (Ingen bedømmelse) (ingen amplifikation) eller
Undetermined (Ikke fastslået).

Bemærk: Dataene for alleldiskrimination skal komme fra multiplexkørsler med mindst to
fluoroforer. Hver fluorofor identificerer én allel i hver af prøverne.

Alleldiskriminationsanalysen kræver somminimum følgende indhold i brøndene:

n To fluoroforer i hver brønd

n NTC-prøver (ingen skabelonkontrol) til optimeret dataanalyse

CFX Manager Dx software indeholder fire valgmuligheder for visning af alleldiskriminationsdata:

n Alleldiskriminationsdiagram – viser data på en graf med RFU for allel 1/allel 2. Hvert af punkterne
på grafen repræsenterer data fra begge fluoroforer i én brønd. Du kan skifte mellem kartesiske og
polære koordinater ved at markere eller fjerne markeringen i afkrydsningsfeltet Polar Coordinates
(Polære koordinater). Cartesian Coordinates (Kartesiske koordinater) repræsenterer RFU for
allel 1 på x-aksen og RFU for allel 2 på y-aksen. Polære koordinater repræsenterer vinklen på
x-aksen og afstanden mellem den oprindelige og RFU på y-aksen (median for alle NTC).

n Regneark med brønde – viser alleldiskriminationsdata indsamlet fra hver enkelt brønd på pladen.

n Brøndvælger – vælger brøndene med de alleldata, der skal vises.
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Fanen Allelic Discrimination (Alleldiskrimination)

n Panelet Selected Fluorophores (Valgte fluoroforer) – ændrer betegnelserne for x- og y-aksen i
alleldiskriminationsdiagrammet, den cyklus der skal analyseres, og hvorvidt bedømmelseskortet
skal vises.

Justering af data til alleldiskrimination
Softwaren tildeler automatisk en genotype til brønde med ukendte prøver baseret på NTC-positioner
og de ukendte datapunkters vinkel og afstand fra NTC'erne.

Sådan justeres data til alleldiskrimination

u Gør et af følgende:

n Markér afkrydsningsfeltet i diagrammet Allelic Discrimination (Alleldiskrimination) for at få vist
polære koordinater.

n For at se en anden fluorofor skal du vælge den på rullelisten i panelet Selected Fluorophores
(Valgte fluoroforer).

n For at redigere en bedømmelse skal du trække på tværs af datapunkterne i diagrammet
Allelic Discrimination (Alleldiskrimination) og vælge en mulighed på listen Selected Wells
(Valgte brønde):

o Allele 1

o Allele 2

o Heterozygote (Heterozygot)

o Undetermined (Ikke fastslået)

o No Call (Ingen bedømmelse)

o Auto Call (Automatisk bedømmelse)

Tip: Vælg Auto Call (Automatisk bedømmelse) for at vende tilbage til
standardbedømmelsen.
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Valgmuligheder i diagrammenuen
Udover de fælles genvejsmenupunkter (se Fælles genvejsmenupunkter for diagrammer på side 179), er
der andre genvejsmenupunkter i diagrammet Allelic Discrimination (Alleldiskrimination). De vises i
Tabel 30.

Menupunkt Funktion

Zoom Fokuserer diagramvisningen på det valgte område (ved at klikke og
trække markøren i diagrammet).

Tip: Højreklik og vælg Set Scale to Default (Indstil skala til
standard) for at nulstille zoomniveauet, så alle datapunkter
vises.

Well (Brønd) Valgmulighederne for den valgte brønd er: display only this well (vis
kun denne brønd), remove this well from view (fjern denne brønd
fra visningen), set color for this trace (indstil farve for denne
kurvelinje) eller exclude this well from analysis (udelad denne
brønd fra analyse).

Selected Wells (Valgte brønde) Valgmulighederne for de valgte brønde (valgt ved at klikke og
trække markøren i diagrammet) er: display only these wells (vis kun
disse brønde), remove these wells from view (fjern disse brønde fra
visningen), set color for these traces (indstil farve for disse
kurvelinjer) eller exclude these wells from analysis (udelad disse
brønde fra analyse).

Tabel 30. Valgmuligheder i genvejsmenuerne (højre- og venstreklik) i diagrammet Allelic
Discrimination (Alleldiskrimination)

Regnearket Allelic Discrimination (Alleldiskrimination)
Tabel 31 definerer de data, der vises i regnearket Allelic Discrimination (Alleldiskrimination).

Oplysninger Beskrivelse

Well (Brønd) Brøndens position på pladen

Sample (Prøve) Beskrivelse af prøvens navn

Tabel 31. Indhold i regnearket Allelic Discrimination (Alleldiskrimination)
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Fanen Allelic Discrimination (Alleldiskrimination)

Oplysninger Beskrivelse

Call (Bedømmelse) Identifikation af allelen, herunder automatisk Allele 1 (allel 1),
Allele 2 (Allel 2), Heterozygote (Heterozygot), No Call (Ingen
bedømmelse) eller Undetermined (Ikke fastslået)

Type Auto (Automatisk) eller Manual (Manuel); beskriver, hvordan
bedømmelsen blev foretaget. Automatisk betyder, at softwaren
foretog bedømmelsen; Manuel betyder, at brugeren foretog
bedømmelsen

RFU1 RFU for Allele1 (Allel 1)

RFU2 RFU for Allele2 (Allel 2)

Tabel 31. Indhold i regnearket Allelic Discrimination (Alleldiskrimination), fortsat
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Fanen Custom Data View (Tilpasset datavisning)
Fanen Custom Data View (Tilpasset datavisning) viser flere faner samtidigt i et format, der kan
tilpasses.

Rullelisten Load a Preset View (Indlæs en forudindstillet visning) indeholder flere skabeloner for
visningsformat. Den visning, der vises som standard, er afhængig af den fil, der analyseres. Hvis
dataene for eksempel er for en Melt Curve (Smeltekurve), vises standardvisningen Amp+Melt.
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Fanen Custom Data View (Tilpasset datavisning)

Oprettelse af en tilpasset datavisning
Sådan oprettes en tilpasset datavisning

u Gør et af følgende:

n Vælg en alternativ forudindstillet visning på rullelisten.

n Vælg en anden diagramvisning på rullelisten, der findes øverst i hver individuel rude.

n Ændr antallet af rækker og kolonner på fanen.

n Ændr individuelle rudedimensioner. Træk stregerne i yderkanten i hver rude.

Klik på Save as Preset (Gem som forudindstilling) for at gemme tilpasningen som en forudindstillet
skabelon. Klik på Manage Presets (Administrer forudindstillinger) for at slette, omdøbe eller gendanne
eksisterende forudindstillede visninger.
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Fanen QC (Kvalitetskontrol)
Brug fanen QC (Kvalitetskontrol) til hurtigt at vurdere kvaliteten af de kørte data baseret på de regler,
som er defineret .

CFX Manager Dx software indeholder fire valgmuligheder for visning af kvalitetskontroldata:

n Diagrammet Amplification (Amplifikation) – viser RFU for hver brønd ved hver cyklus. Hver
kurvelinje på diagrammet repræsenterer data fra en enkelt fluorofor i én brønd.

n Tabellen QC rules (Regler for kvalitetskontrol) – viser de tilgængelige regler for kvalitetskontrol
og de indstillinger, der definerer hver regel. Anvendte regler for kvalitetskontrol er indikeret med
en markering.

n Well selector (Brøndvælger) – vælger brøndene med de fluorescensdata, der skal vises.

n Oversigtsside for kvalitetskontrolregel – viser den valgte regel for kvalitetskontrol og
fremhæver brønde, der ikke opfylder reglen.

Ændring af kriterier for kvalitetskontrol
Sådan ændres kriterier for QC (Kvalitetskontrol)

u Markér eller fjern markeringen i afkrydsningsfeltet Use (Brug) for at medtage eller udelade reglen i
kvalitetskontrollen.
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Fanen QC (Kvalitetskontrol)

Udeladelse af brønde, som ikke består QC (Kvalitetskontrol)
CFXManager Dx software viser brønde, som ikke består kriterierne for QC (Kvalitetskontrol) i
kolonnen Results (Resultater) i tabellen med QC-regler og i oversigtsruden.

Sådan udelades brønde, som ikke opfylder kriterierne for QC (Kvalitetskontrol)

u Vælg Exclude Wells (Udelad brønde) for hver af de brønde, der skal udelades.
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Fanen Run Information (Kørselsoplysninger)
Fanen Run Information (Kørselsoplysninger) viser protokollen og andre oplysninger om hver kørsel.
Denne fane kan bruges til følgende:

n Vise protokollen.

n Indtaste eller redigere bemærkninger om kørslen.

n Indtaste eller redigere id eller stregkode for kørslen.

n Vise hændelser, der måtte være opstået under kørslen. Brug disse meddelelser til at fejlfinde en
kørsel.

Tip: Højreklik på protokollen for at kopiere, eksportere eller udskrive den. Højreklik på Notes
(Bemærkninger), ID/Bar Code (Id/stregkode) eller Other panes (Andre ruder) for at klippe,
kopiere, indsætte, slette eller vælge teksten.
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Dataanalyserapporter

Dataanalyserapporter
Rapportdialogboksen viser oplysninger om den aktuelle datafil i vinduet Data Analysis (Dataanalyse).
For at åbne en rapport skal du vælge Tools > Reports (Værktøjer > Rapporter).

Dialogboksen Report (Rapport) består af følgende sektioner:

n Menu og værktøjslinje – indeholder valgmuligheder til at formatere, gemme og udskrive rapporten
eller skabelonen.

n Liste med valgmuligheder (øverst til venstre i dialogboksen) – indeholder valgmuligheder for,
hvad der skal vises i rapporten.

n Rude med valgmuligheder (nederst til venstre i dialogboksen) – indeholder tekstfelter, i hvilke der
kan angives oplysninger om en given valgmulighed.

n Rude med forhåndsvisning (til højre i dialogboksen) – viser en forhåndsvisning af den aktuelle
rapport.
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Kategorier for dataanalyserapporter
Tabel 32 indeholder alle de valgmuligheder, der er tilgængelige i forbindelse med en
dataanalyserapport, afhængigt af datatypen i vinduet Data Analysis (Dataanalyse).

Kategori Valgmulighed Beskrivelse

Header (Overskrift)

Rapportens titel, undertitel og logo

Report Information
(Rapportoplysninger)

Kørselsdato, brugernavn, datafilens
navn, sti til datafilen og den valgte
brøndgruppe

Audit Information
(Revisionsoplysninger)

Yderligere oplysninger, som er
nødvendige i forbindelse med revision,
herunder signaturer

Notes (Bemærkninger) Bemærkninger til datarapporten

Run Setup (Kørselsopsætning)

Run Information
(Kørselsoplysninger)

Kørselsdato, brugernavn, datafilens
navn, sti til datafilen og den valgte
brøndgruppe

Protocol (Protokol) Tekstvisning af protokoltrin og
valgmuligheder

Plate Display (Pladevisning) Pladevisning af oplysningerne i hver
enkelt brønd i pladen

Quantification (Kvantifikation)

Analysis Settings
(Analyseindstillinger)

Dataindsamlingens trinnummer,
analysetilstand og baseline-
subtraktionsmetode

Amplification Chart
(Amplifikationsdiagram)

Amplifikationsdiagram til kørsler, der
omfatter kvantifikationsdata

Standard Curve Chart
(Standardkurvediagram)

Standardkurve-diagram

Tabel 32. Kategorier for dataanalyserapporter på listen med valgmuligheder
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Kategori Valgmulighed Beskrivelse

Data Regneark, der oplister dataene i hver
brønd

Gene Expression (Genekspression) – søjlediagram

Analysis Settings
(Analyseindstillinger)

Analysetilstand, diagramdata,
valgmulighed for skalering og
diagramfejl

Chart (Diagram) Kopi af søjlediagrammet

Target Names (Navne på
målsekvenser)

Diagram over navne på målsekvenser

Sample Names (Prøvenavne) Diagram over prøvenavne

Data Regneark, der oplister dataene i hver
brønd

Target Stability (Stabilitet af
målsekvens)

Diagram over stabilitetsværdier for
målsekvensen (target)

Gene Expression (Genekspression) – Clustergram (Klyngeoversigt) og Scatter Plot
(Punktdiagram)

Analysis Settings
(Analyseindstillinger)

Indstillinger for hver diagramtype

Chart (Diagram) Kopi af diagrammet

Data Regneark, der oplister data i hver
målsekvens (target)

Melt Curve (Smeltekurve)

Analysis Settings
(Analyseindstillinger)

Smeltetrinnummer og
tærskellinjeindstilling

Melt Curve Chart
(Smeltekurvediagram)

Smeltekurvediagram

Tabel 32. Kategorier for dataanalyserapporter på listen med valgmuligheder, fortsat
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Kategori Valgmulighed Beskrivelse

Melt Peak Chart
(Smeltekurvetopdiagram)

Smeltekurvetopdiagram

Data Regneark, der oplister dataene i hver
brønd

Allelic Discrimination (Alleldiskrimination)

Analysis Settings
(Analyseindstillinger)

Viser fluoroforer, cyklusser og
bedømmelseskort

Diagrammet Allelic Discrimination
(Alleldiskrimination)

Kopi af diagrammet over
alleldiskrimination

Data Regneark, der oplister dataene i hver
brønd

End Point (Endepunkt)

Analysis Settings
(Analyseindstillinger)

Fluorofor, endecyklusser til
gennemsnit, tilstand, laveste RFU-
værdi, højeste RFU-værdi og cut-off-
værdi

Data Regneark, der oplister dataene i hver
brønd

QC Parameters (Parametre for kvalitetskontrol)

Data Regneark, der oplister parametrene for
hver enkelt QC-regel

Tabel 32. Kategorier for dataanalyserapporter på listen med valgmuligheder, fortsat
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Dataanalyserapporter

Oprettelse af en dataanalyserapport
Du kan gemme rapportens layout som en skabelon, der kan bruges igen til lignende rapporter.

Sådan oprettes en dataanalyserapport

1. Udfør de endelige justeringer af brøndindholdet, valgte brønde, diagrammer og regneark i vinduet
Data Analysis (Dataanalyse), inden rapporten oprettes.

2. Vælg Tools > Reports (Værktøjer > Rapporter) i menuen Data Analysis (Dataanalyse) for at åbne
dialogboksen Report (Rapport).

3. Vælg, hvad der skal medtages i rapporten. Rapporten åbnes med standardvalgmulighederne
valgt. Markér eller fjern markering i afkrydsningsfelterne for at ændre hele kategorier eller
individuelle valgmuligheder i en kategori.

Bemærk: De data, der vises i rapporten, afhænger af de aktuelle valg på fanerne i vinduet
Data Analysis (Dataanalyse) . For eksempel indeholder en kvantifikationskørsel muligvis ikke
en standardkurve, og disse data vises derfor ikke i vinduet Data Analysis (Dataanalyse) eller i
datarapporten.

4. Ændring af rækkefølgen af kategorier og elementer i en rapport. Træk valgmulighederne til den
relative position. Elementers rækkefølge kan kun ændres i den kategori, de tilhører.

5. (Valgfrit) I ruden Report Options (Valgmuligheder for rapport) indtastes information, der er
relevant for den valgte valgmulighed:

n Vælg et undersæt af oplysninger, der skal vises i rapporten.

n Vælg specifikke indstillinger for den valgte valgmulighed.

n Ændr teksten, der skal vises for den valgte valgmulighed.

6. Klik på Update Report (Opdater rapport) for at opdatere Report Preview (Vis rapport) med
eventuelle ændringer.

7. Udskriv eller gem rapporten. Klik på knappen Print Report (Udskriv rapport) i værktøjslinjen for at
udskrive den aktuelle rapport. Vælg File > Save (Fil > Gem) for at gemme rapporten i et af
formaterne PDF (Adobe Acrobat Reader)-fil og vælg en placering, hvor filen skal gemmes. Vælg
File > Save As (Fil > Gem som) for at gemme rapporten med et nyt navn eller på en ny placering.

8. (Valgfrit) Opret en skabelonrapport med den information, du ønsker. For at gemme de aktuelle
rapportindstillinger i en skabelon skal du vælge Template > Save (Skabelon > Gem) eller Save As
(Gem som). Indlæs rapportskabelonen, næste gang der skal oprettes en ny rapport.
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Oprettelse af Well Group Reports (Brøndgrupperapporter)
Sådan oprettes en brøndgrupperapport

1. Vælg Tools > Well Group Reports (Værktøjer > Brøndgrupperapporter) i vinduet Data Analysis
(Dataanalyse).

2. Vælg de brøndgrupper, amplifikationstrin og smeltetrin, som skal medtages i rapporten, i
dialogboksenWell Groups Reports (Brøndgrupperapporter).

3. Indtast stien eller naviger til destinationsmappen, hvor rapporten skal gemmes.

4. (Valgfrit) Vælg Choose a Report Template (Vælg en rapportskabelon) og naviger til
skabelonfilmappen.

5. (Valgfrit) Vælg Open Destination Folder (Åbn destinationsmappe) for at åbne mappen og se
rapporterne, når de er blevet genereret.

6. Klik på Create Reports (Opret rapporter).
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Kapitel 11 Genekspressionsanalyse
Ved at bruge strengt kvalificerede kontroller i reaktionerne kan du anvende CFX Manager™ Dx
softwaren til at udføre en genekspressionskørsel med henblik på at normalisere de relative differencer
i en målkoncentration blandt prøver. Typisk anvendes ekspressionsniveauer for ét eller flere
referencegener til normalisering af ekspressionsniveauerne for et interessegen. Referencegener
tager højde for isætningsforskelle (loading-forskelle) eller andre variationer i hver enkelt prøve, og
deres ekspressionsniveauer bør ikke ændres i det biologiske system, der undersøges.

Vælg fanen Gene Expression (Genekspression) i vinduet Data Analysis (Dataanalyse) for at evaluere
de relative differencer mellem PCR-reaktioner i to eller flere brønde. Du kan for eksempel evaluere det
relative antal virale genomer eller det relative antal transfekterede sekvenser i en PCR-reaktion. Den
mest almindelige anvendelse af et genekspressionsstudie er til at sammenligne cDNA-
koncentrationen i mere end én reaktion for at estimere niveauerne af steady state-mRNA.

Softwaren beregner det relative ekspressionsniveau for en målsekvens (target) med et af følgende
scenarier:

n Relativt ekspressionsniveau for en målsekvens (target 1) i forhold til en anden målsekvens (target
2). Det kan for eksempel være mængden af ét gen i forhold til et andet gen i samme
prøvebehandling.

n Relativt ekspressionsniveau for én målsekvens (target) i én prøve sammenlignet med den
sammemålsekvens (target) under en anden prøvebehandling. Det kan for eksempel være den
relative mængde af ét gen i forhold til genet selv under andre temporale, geografiske eller
udviklingsmæssige betingelser.
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Opsætning af plader til genekspressionsanalyse
For at kunne udføre genekspressionsanalyse skal brøndenes indhold omfatte følgende:

n To eller flere målsekvenser (targets) – de to målsekvenser (targets), som repræsenterer
forskellige amplificerede gener eller sekvenser i prøverne.

n En eller flere referencemålsekvenser (targets) – mindst én målsekvens (target) skal være en
referencemålsekvens (target) for normaliseret ekspression. Tildel alle referencemålsekvenser
(targets) i vinduet Experiment Settings (Eksperimentindstillinger) for at analysere data i tilstanden
Normalized Expression (Normaliseret ekspression) (ΔΔCq). Kørsler, som ikke indeholder en
reference, skal analyseres ved hjælp af tilstanden Relative Expression (Relativ ekspression)
(ΔCq).

n Almindelige prøver – reaktionerne skal omfatte almindelige prøver (der kræves mindst to) for at
vise dataene plottet på fanen Gene Expression (Genekspression). Disse prøver skal
repræsentere forskellige behandlinger eller tilstande for hver af målsekvenserne (targets). Tildel
en kontrolprøve (valgfrit) i vinduet Experiment Settings (Eksperimentindstillinger). Hvis der ikke
vælges en kontrol, anvender softwaren den laveste Cq som kontrol.

Kravene i forbindelse med opsætning af Gene Expression (Genekspression) i Plate Editor
(Pladeeditor) afhænger af, hvorvidt reaktionsindholdet er singleplex PCR, med én fluorofor i
reaktionerne, eller multiplex PCR, med mere end én fluorofor i reaktionerne.

Vejledt pladeopsætning
Hvis pladeopsætningen af en datafil ikke indeholder informationen, der er nødvendig til analysen, og
hvis fanen Gene Expression (Genekspression) er valgt, er det område, der normalt bruges til at vise
søjlediagrammet, i stedet for udfyldt med vejledninger i, hvordan denne information udfyldes. For
normaliseret genekspression udfyldes følgende trin:

1. Definer navne for Target (Målsekvens) og Sample (Prøve) ved brug af en af følgende:

n Plate Setup (Pladeopsætning) – åbner vinduet Plate Editor (Pladeeditor).

n Replace Plate File (Udskift pladefil) – åbner browseren Select Plate (Vælg plade), hvor du
kan navigere til en tidligere gemt pladefil, som det aktuelle pladelayout skal erstattes med.

n Replace PrimePCR File (Erstat PrimePCR-filen) – åbner dialogboksen Select PrimePCR file
(Vælg PrimePCR-fil), hvor du kan navigere til en PrimePCR™ kørselsfil, der kan anvendes
på pladelayoutet.

2. Vælg en eller flere referencemålsekvenser (targets) og en kontrolprøve i dialogboksen
Experiment Settings (Eksperimentindstillinger).
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Vejledt pladeopsætning

Hvis pladelayoutet allerede indeholder information ommålsekvens (target) og prøve, er det kun
nødvendigt at udføre det andet trin, der vil være fremhævet med orange. Dette trin skal udføres
inden der kan udføres normaliseret genekspressionsanalyse.

Bemærk: Data for klyngeoversigt og punktdiagram vises kun hvis alle kravene til
normaliseret genekspressen, der anført under Plate Setup (Pladeopsætning) for Gene
Expression Analysis (Genekspressionsanalyse), er opfyldt.
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Diagrammer for genekspression
CFXManager Dx softwaren viser genekspressionsdata i flere forskellige visninger. Tabel 33
indeholder en liste over de diagramvisninger, der kan vælges i softwaren.

Knap Navn Funktion

Bar Chart (Søjlediagram) Viser normaliserede genekspressionsdata i
søjlediagramformat.

Clustergram (Klyngeoversigt) Viser de normaliserede
genekspressionsdata i et hierarki baseret på
graden af lighed for ekspressionen af
forskellige målsekvenser (targets) og
prøver.

Scatter Plot (Punktdiagram) Viser den normaliserede ekspression af
målsekvenser (targets) for en kontrol kontra
en eksperimentel prøve.

Results (Resultater) Indeholder en oversigt over data fra alle
diagrammer.

Tabel 33. Valgmuligheder for genekspressionsdiagrammer
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Søjlediagram

Søjlediagram

Den relative ekspression af målsekvenser (targets) præsenteres i disse to visninger:

n Diagrammet Gene Expression (Genekspression) – viser real-time PCR-data som et af følgende:

o ΔΔCq – relativ normaliseret ekspression beregnet ved brug af kontrolprøver og
referencemålsekvenser (targets).

o ΔCq – relativ mængde af målsekvensgenet (targetgenet) i en prøve relativ til en kontrolprøve.

n Regneark – viser et regneark med genekspressionsdata.

Tip: Højreklik på et diagram eller regneark for at se valgmulighederne. Vælg View/Edit Plate
(Vis/rediger plade) i rullemenuen Plate Setup (Pladeopsætning) for at åbne Plate Editor
(Pladeeditor) og ændre brøndindholdet i pladen.

Tip: Vælg Sort (Sortér) i genvejsmenuen for at ændre rækkefølgen af navnene på
målsekvenser (targets) og prøver i diagrammet.

Normaliseret genekspression

For at normalisere data skal du bruge det målte ekspressionsniveau for et eller flere referencegener
som normaliseringsfaktor. Referencegener er målsekvenser (targets), som ikke er reguleret i det
biologiske system i studiet, f.eks. actin,GAPDH eller tubulin.
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Sådan opsættes normaliseret genekspressionsanalyse (ΔΔCq)

1. Åbn en datafil (med filtypenavn .pcrd).

2. Gennemgå dataene under Quantification (Kvantifikation) i vinduet Data Analysis (Dataanalyse).
Juster dataene, f.eks. ved at ændre tærsklen og analysetilstanden.

3. Vælg fanen Gene Expression (Genekspression).

4. Klik på Experiment Settings (Eksperimentindstillinger) på fanen Gene Expression
(Genekspression).

5. Gør følgende i dialogboksen Experiment Settings (Eksperimentindstillinger):

a. Vælg fanen Samples (Prøver), og vælg en kontrol. Når en kontrol er tildelt, normaliserer CFX
Manager Dx software de relative mængder for alle gener efter kontrolmængden, som er indstillet
til 1.

b. Vælg fanen Target (Målsekvens), og vælg referencegener. Genekspressionsanalyse kræver
én reference blandt målsekvenserne (targets) i prøverne.

6. Vælg Normalized Expression (Normaliseret ekspression) (ΔΔCq), hvis det ikke allerede er valgt,
og se derefter ekspressionsniveauerne på fanen Gene Expression (Genekspression).

Relativ mængde

Pr. definition er data for relativ mængde (ΔCq) ikke normaliserede. Denne metode anvendes til
kvantifikation af prøver, som ikke indeholder referencegener (målsekvenser (targets)). Normalt vil
forskere tage udgangspunkt i følgende ved opsætning af kørsler:

n Hver prøve indeholder den sammemængde RNA eller cDNA i hver brønd.

n Enhver varians i mængden af indlæst biologisk prøve vil blive normaliseret efter kørslen ved hjælp
af en metode i dataanalysen, som foregår uden for softwaren. En forsker kan f.eks. vælge at
dividere værdien for relativ mængde med normaliseringsfaktoren, muligvis massen af nukleinsyre
tilført for hver prøve, eller antallet af celler hvorfra nukleinsyren er isoleret.

Sådan køres en analyse af relativ mængde (ΔCq)

u Vælg Relative Quantity (Relativ mængde) (ΔCq) på rullelisten Mode (Tilstand) i højre rude på
fanen Gene Expression (Genekspression).

Tip: For at sammenligne resultaterne fra andre genekspressionskørsler skal du åbne et nyt
genstudie eller tilføje en datafil til et eksisterende genstudie.

Sortering af data for målsekvens (target) og prøve
Bemærk: Denne valgmulighed er kun tilgængelig på diagrammer for genekspression.
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Søjlediagram

Som standard vises listerne Targets (Målsekvenser) og Samples (Prøver) i alfabetisk rækkefølge.
Brug dialogboksen Sort (Sortér) til at sortere visningen i omvendt alfabetisk rækkefølge eller til
manuelt at flytte en term til en anden placering på listen.

Sådan sorteres data vedrørende målsekvens (target) og prøve

1. Klik på Sort (Sortér) i diagrammets genvejsmenu.

Dialogboksen Gene Expression Chart Sorting (Sortering af diagrammet Genekspression) åbnes.

2. Klik på Z-A i dialogboksen for at sortere listen i omvendt alfabetisk rækkefølge.

3. For at flytte en term manuelt skal du vælge den og klikke på den relevante knap mellem
diagrammerne:

n Klik på pil op eller pil ned for at flytte den valgte term én position.

n Klik på pil op med slutstreg eller pil ned med slutstreg for at flytte den valgte term til toppen
eller bunden af listen.

4. Klik på OK for at gemmeændringerne og gå tilbage til fanen Gene Expression (Genekspression).

Tilpasning af genekspressionsdata
Efter at have valgt analysetilstand – normaliseret ekspression (∆∆Cq) eller relativ mængde (∆Cq) –
skal du tilpasse de data, der vises på fanen Gene Expression (Genekspression), ved at ændre
valgmulighederne til højre for diagrammet.

Tip: Standardindstillingerne for genekspressionsdata i dialogboksen User Preferences
(Brugerpræferencer) (se Indstilling af standardparametre for genekspressionsdatafiler på side 70).

Grafdata

Indstil værdien på y-aksen til skalaen Linear (Lineær) for at aktivere valgmulighederne for grafdata.
Valgmulighederne for grafdata gør det muligt at præsentere data i grafen med en af disse
valgmuligheder:
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n Relative to control (I forhold til kontrol) – grafisk afbildning af data med aksen skaleret fra 0 til 1.
Aktivér denne valgmulighed, hvis du tildeler en kontrol i kørslen, for hurtigt at kunne visualisere
op- og nedregulering af målsekvensen (target).

n Relative to zero (I forhold til nul) – grafisk afbildning af data med startpunkt ved nul.

Kontrolprøve

Brug rullemenuen Control Sample (Kontrolprøve) til at vælge en prøve, der skal bruges til at
normalisere Relative Quantity (Relativ mængde):

Diagramindstillinger

De følgende valgmuligheder (beskrevet nedenfor) vises, når feltet Show Chart Settings (Vis
diagramindstillinger) er markeret: X-Axis (X-akse), Y-Axis (Y-akse), Scaling (Skalering), Error Type
(Fejltype) og Chart Error Multiplier (Multiplikator for diagramfejl).

Valgmuligheder for x-aksen

Valgmuligheden X-axis (X-akse) giver mulighed for at vælge x-aksedata i diagrammet Gene
Expression (Genekspression):

n Target (Målsekvens) – indtegner navnene på målsekvenserne (targets) på x-aksen.

n Sample (Prøve) – indtegner prøvenavnene på x-aksen.

Valgmuligheder for y-aksen

Valgmuligheden Y-axis (Y-akse) giver mulighed for at få vist diagrammet Gene Expression
(Genekspression) i en af disse tre skaleringer:

n Linear (Lineær) – vælg denne valgmulighed for at få vist en lineær graf.

Tip: Hvis y-aksen indstilles til Linear (Lineær), aktiveres rullelisten Graph Data (Grafdata),
hvor du kan vælge indtegning af data i forhold til kontrol eller i forhold til nul.

n Log 2 – vælg denne valgmulighed for at evaluere prøver på tværs af et stort dynamisk område.

n Log 10 – vælg denne valgmulighed for at evaluere prøver på tværs af et meget stort dynamisk
område.

Valgmuligheder for skalering

Vælg Normalized Gene Expression (Normaliseret genekspression) (ΔΔCq), og indstil Control Sample
(Kontrolprøve) til None (Ingen) for at aktivere valgmulighederne for skalering i diagrammet Gene
Expression (Genekspression). Vælg en af disse valgmuligheder for skalering for at beregne og
præsentere data på den måde, som passer bedst til dit kørselsdesign:
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Søjlediagram

n Unscaled (Ikke-skaleret) – viser ikke-skaleret normaliseret genekspression.

n Highest (Højest) – skalerer den normaliserede genekspression for hver målsekvens (target) ved
at dividere ekspressionsniveauet for hver prøve med det højeste ekspressionsniveau i alle
prøverne.

Denne valgmulighed for skalering anvender formlen for skaleret-til-højest.

n Lowest (Lavest) – skalerer den normaliserede genekspression for hver målsekvens (target) ved
at dividere ekspressionsniveauet for hver prøve med det laveste ekspressionsniveau i alle
prøverne.

Denne valgmulighed for skalering anvender formlen for skaleret-til-lavest.

n Average (Gennemsnit) – skalerer den normaliserede genekspression for hver målsekvens
(target) ved at dividere ekspressionsniveauet for hver prøve med den geometriske middelværdi
for ekspressionsniveauerne for alle prøverne.

Denne valgmulighed for skalering anvender formlen for skaleret-til-gennemsnit.

Error Type (Fejltype)

Vælg en mulighed for typen af fejlberegninger (fejllinjer) i diagrammet Gene Expression
(Genekspression):

n Standard error of the mean (Middelfejlen på middelværdien) (standard)

n Standard deviation (Standardafvigelse)

Multiplikator for fejllinjer i diagrammet

Vælg en multiplikator for fejllinjerne i diagrammet Gene Expression (Genekspression). Vælg et af
disse heltal:
+/- 1 (standard), 2 eller 3. Typen af multiplikator ændres, når du vælger fejltypen:

n SEMs for middelfejlen på middelværdien

n Std Devs for standardafvigelser

Eksperimentindstillinger
Tip: Denne dialogboks er også tilgængelig i Plate Editor (Pladeeditor). SeÆndring af
eksperimentindstillinger på side 131 for yderligere oplysninger.

I dialogboksen Experiment Settings (Eksperimentindstillinger) kan du se eller ændre listen over
målsekvenser (targets) eller prøver, vælge referencegener, vælge kontroller eller indstille den
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genekspressionsanalysegruppe, der skal analyseres, hvis der er tilføjet navne på biologiske sæt til
brøndene.

Sådan åbnes dialogboksen Experiment Settings (Eksperimentindstillinger)

u Klik på Experiment Settings (Eksperimentindstillinger) på fanen Bar Chart (Søjlediagram) nederst
i højre rude.

Dialogboksen Experiment Settings (Eksperimentindstillinger) åbnes og viser fanen Targets
(Målsekvenser).

Sådan justeres indstillinger for Targets (Målsekvenser)

u På fanen Targets (Målsekvenser) skal du gøre et af følgende:

n For at vælge en målsekvens (target) som reference for analyse af genekspressionsdata skal
du vælge dets navn i kolonnen Reference.

n For at ændre farven på målsekvensen (target) skal du klikke på dets celle i kolonnen Color
(Farve) og ændre farven i dialogboksen Color (Farve), der vises.

Farveændringen vises i diagrammerne for Gene Expression (Genekspression).

n For at bruge en tidligere fastlagt effektivitetsværdi skal du fjerne markeringen i
afkrydsningsfeltet for målsekvensen (target) i kolonnen Auto Efficiency (Automatisk
effektivitet) og indtaste et tal for målsekvensens (target) effektivitetsprocent.
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Søjlediagram

Softwaren beregner den relative effektivitet for en målsekvens (target) ved hjælp af Auto
Efficiency (Automatisk effektivitet), hvis dataene for målsekvensen omfatter en
standardkurve.

Sådan justeres indstillingerne for Sample (Prøve)

u På fanen Samples (Prøver) skal du gøre et af følgende:

n For at vælge en prøve som kontrol for analyse af genekspressionsdata skal du vælge dens
navn i kolonnen Control (Kontrol).

n For at ændre farven på prøven skal du klikke på den relevante celle i kolonnen Color (Farve)
og ændre farven i dialogboksen Color (Farve), der vises.

Farveændringen vises i diagrammerne for Gene Expression (Genekspression).

n For at vise prøven i diagrammerne for Gene Expression (Genekspression) skal du vælge
dette i kolonnen Show Chart (Vis diagram).

n For at fjerne prøven fra diagrammerne for Gene Expression (Genekspression) skal du fjerne
markeringen i kolonnen Show Chart (Vis diagram).

Tip: Prøvens data forbliver i tabellen Results (Resultater).

Sådan ændres valget af Biological Set Analysis (Valgmuligheder for analyse af biologisk
sæt)

u Hvis du har tildelt ét eller flere biologiske sæt til brøndene på pladen (se Tildeling af biologiske sæt
til brønde på side 124), vises listen Biological Set Analysis Options (Indstillinger for analyse af
biologisk sæt) i dialogboksen Experiment Settings (Eksperimentindstillinger) og giver dig
mulighed for at ændre indstillingerne efter behov.

n Target vs. Sample (Målsekvens kontra prøve) – kun brøndens prøvenavn bruges i
beregningerne af genekspression.

n Target vs. Biological Set (Målsekvens kontra biologisk sæt) – kun navnet på det biologiske
sæt bruges i beregningerne.

n Target vs. Sample_Biological Set (Målsekvens kontra prøve_biologisk sæt) –
prøvenavnet og navnet på det biologiske sæt kombineres for at oprette et enkelt navn, der
bruges i beregningerne.
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n Target vs. Biological Set_Sample (Målsekvens kontra biologisk sæt_prøve) – navnet på
det biologiske sæt og prøvenavnet kombineres for at oprette et enkelt navn, der bruges i
beregningerne.

Sådan udelades en prøvetype fra analyseberegninger

u Markér det relevante afkrydsningsfelt nederst i dialogboksen Experiment Settings
(Eksperimentindstillinger).

Bemærk: Dette udelader kontroller og/eller standarder fra genekspressionsanalyse.

Stabilitetsværdi for målsekvens (target)
Der beregnes stabilitetsværdier for målsekvenser (targets), hvis der anvendes mere end ét
referencegen. CFX Manager Dx softwaren beregner to kvalitetsparametre for referencegenerne:

n Coefficient Variance (CV) (Variationskoefficient (CV)) for normaliserede relative mængder
for referencegenet. En lavere CV-værdi angiver højere stabilitet.

n M Value (M) (M-værdi (M)), som er en måling af stabiliteten af referencegenets ekspression.

Anbefalede CV- og M-værdier vises nederst i dialogboksen Stability Value (Stabilitetsværdi).

Sådan vises stabilitetsværdien for målsekvensen (target)

u Klik på Target Stability Value (Stabilitetsværdi for målsekvens (target)) nederst i højre rude på
fanen Gene Expression Bar Chart (Søjlediagram for genekspression).

Dialogboksen Stability Value (Stabilitetsværdi) vises.

Genvejsmenupunkter
Højreklik på genekspressionsdiagrammet for at vælge de elementer, der er vist i Tabel 34.

Element Funktion

Copy (Kopiér) Kopierer diagrammet til udklipsholderen.

Save Image As (Gem billede
som)

Gemmer diagrammet som en billedfil. Indstil billedets opløsning og
dimensioner, og vælg derefter filtypen (PNG, GIF, JPG, TIF eller
BMP).

Page Setup (Sideopsætning) Vælger en sideopsætning til udskrift.

Tabel 34. Genvejsmenupunkter for genekspression
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Søjlediagram

Element Funktion

Print (Udskriv) Udskriver diagrammet.

Set Scale to Default (Indstil
skala til standard)

Show All (Vis alle) viser samtlige data i søjlediagrammet. Scroll Bar
(Rullepanel) viser et rullepanel, hvis der er for mange prøver til, at
de kan vises i rammen med grafen, men opretholder en
minimumsbredde for søjlerne.

Chart Options (Valgmuligheder
for diagrammer)

Åbner vinduet Chart Options (Valgmuligheder for diagrammer) til
justering af grafen.

Sort (Sortér) Sorterer rækkefølgen af prøver og målsekvenser (targets), som
vises på diagrammets x-akse.

Use Corrected Std Devs
(Anvend korrigerede
standardafvigelser)

Beregner fejllinjerne ved hjælp af formlen for korrigeret
standardafvigelse.

Use Solid Bar Colors (Brug
dækkende farver)

Viser søjlerne i diagrammet med dækkende farver.

X-Axis Labels (X-aksens
betegnelser)

Viser x-aksens betegnelser vandret eller skråt.

Tabel 34. Genvejsmenupunkter for genekspression, fortsat

Dataregneark
Tabel 35 definerer de data, der vises i tabellen Gene Expression Data (Genekspressionsdata).

Bemærk: Værdierne i tabellen beregnes ud fra graftype og præferencer, som er valgt i højre
rude.

Oplysninger Beskrivelse

Target (Målsekvens) Navn på målsekvens (target) (amplificeret gen), som er valgt i
vinduet Experiment Settings (Eksperimentindstillinger).

Sample (Prøve) Navn på prøven, som er valgt i vinduet Experiment Settings
(Eksperimentindstillinger).

Ctrl (Kontrol) Navn på kontrollen, som er valgt i vinduet Experiment Settings
(Eksperimentindstillinger).

Tabel 35. Beskrivelse af oplysninger i regnearket på fanen Bar Chart (Søjlediagram)
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Oplysninger Beskrivelse

Relative Quantity (Relativ
mængde) eller
Expression (Ekspression)

Relativ mængde (ΔCq) eller normaliseret genekspression (ΔΔCq),
afhængigt af den valgte tilstand.

Relative Quantity (Relativ
mængde) eller Expression
SEM (Ekspression SEM) (eller
SD)

Middelfejlen på middeltallet (SEM) eller standardafvigelse (SD) for
den relative mængde eller normaliseret ekspression, afhængigt af
den valgte valgmulighed.

Corrected Relative Quantity
(Korrigeret relativ mængde)
eller Expression SEM
(Ekspression SEM) (eller SD)

Korrigeret værdiberegning for SEM eller SD af relativ mængde eller
normaliseret ekspression, afhængigt af den valgte valgmulighed.

Mean Cq (Middelværdi for Cq) Middelværdien for kvantifikationscyklussen.

Cq SEM (eller SD) SEM eller SD af kvantifikationscyklussen afhængigt af den valgte
valgmulighed.

Tabel 35. Beskrivelse af oplysninger i regnearket på fanen Bar Chart (Søjlediagram), fortsat

Valgmuligheden Show Details (Vis detaljerede oplysninger)
Tabel 36 definerer, hvilke data der vises, når du vælger Show Details (Vis detaljerede oplysninger) fra
genvejsmenuen i søjlediagrammets regneark.

Oplysninger Beskrivelse

Data Set (Datasæt) Fluorescensdata fra en enkelt fluorofor i datafilen

Relative Quantity (Relativ
mængde)

Beregnet relativ mængde af prøver

Relative Quantity SD (SD for
relativ mængde)

Standardafvigelse for beregning af relativ mængde

Corrected Relative Quantity SD
(SD for korrigeret relativ
mængde)

Beregnet standardafvigelse for den korrigerede relative mængde

Tabel 36. Information i søjlediagrammets regneark, hvor der er valgt Show Details (Vis
detaljerede oplysninger)
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Oplysninger Beskrivelse

Relative Quantity SEM (SEM
for relativ mængde)

Middelfejlen på middelværdien for beregning af relativ mængde

Corrected Relative Quantity
SEM (SEM for korrigeret relativ
mængde)

Beregnet middelfejl på middelværdien for den korrigerede relative
mængde

Relative Quantity(lg) (Relativ
mængde (lg))

Log2 for den relative mængde, der bruges til statistisk analyse

SD RQ(lg) Standardafvigelse for den relative mængde (log2)

SEM Expression(lg) (SEM for
ekspression (lg))

Middelfejlen på middelværdien for ekspressionen (log2)

Unscaled Expression (Ikke-
skaleret ekspression)

Beregnet ikke-skaleret ekspression

Unscaled Expression SD (SD
for ikke-skaleret ekspression)

Beregnet standardafvigelse for den ikke-skalerede ekspression

Corrected Unscaled Expression
SD (SD for korrigeret ikke-
skaleret ekspression)

Beregnet standardafvigelse for den korrigerede ikke-skalerede
ekspression

Unscaled Expression SEM
(SEM for ikke-skaleret
ekspression)

Beregnet middelfejl på middelværdien for den ikke-skalerede
ekspression

Corrected Unscaled Expression
SEM (SEM for korrigeret ikke-
skaleret ekspression)

Beregnet middelfejl på middelværdien for den korrigerede ikke-
skalerede ekspression

Unscaled Expression(lg) (Ikke-
skaleret ekspression (lg))

Log2 for den ikke-skalerede ekspression

SD Unscaled Expression(lg)
(SD for ikke-skaleret
ekspression (lg))

Standardafvigelse for den ikke-skalerede ekspression (log2)

Tabel 36. Information i søjlediagrammets regneark, hvor der er valgt Show Details (Vis
detaljerede oplysninger), fortsat
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Oplysninger Beskrivelse

SEM Unscaled Expression(lg)
(SEM for ikke-skaleret
ekspression (lg))

Middelfejlen på middelværdien for den ikke-skalerede ekspression
(log2)

Expression (Ekspression) Normaliseret genekspression

Corrected Expression SD (SD
for korrigeret ekspression)

Beregnet standardafvigelse

Expression SEM (SEM for
ekspression)

Middelfejlen på middelværdien

Corrected Expression SEM
(SEM for korrigeret
ekspression)

Beregnet middelfejl på middelværdien

Expression(lg) (Ekspression
(lg))

Log2 for ekspressionen (normaliseret ekspression), der bruges til
statistisk analyse

SD Expression(lg) (SD
ekspression (lg))

Standardafvigelse for ekspressionen (log2)

SEM Expression(lg) (SEM for
ekspression (lg))

Middelfejlen på middelværdien for ekspressionen (log2)

Mean Cq (Middelværdi for Cq) Middelværdien for kvantifikationscyklussen

Cq SD Standardafvigelse for kvantifikationscyklussen

Cq SEM Middelfejlen på middelværdien for kvantifikationscyklussen

Tabel 36. Information i søjlediagrammets regneark, hvor der er valgt Show Details (Vis
detaljerede oplysninger), fortsat
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Klyngeoversigt

Klyngeoversigt
Klyngeoversigten viser dataene i et hierarki, baseret på graden af lighed i ekspression for forskellige
målsekvenser (targets) og prøver.

Bemærk: Du skal vælge en reference målsekvens (target) for at kunne vise andre dataplots end
relativ ekspression for søjlediagrammer.

Klyngeoversigtsbilledet viser relativ ekspression for en prøve eller en målsekvens (target) som følger:

n Opregulering (rød) – højere ekspression

n Nedregulering (grøn eller blå) – lavere ekspression

n Ingen regulering (sort)

n Ingen værdi beregnet (sort med et hvidt X)

Jo lysere farven er, desto større er forskellen i relativ ekspression. Hvis der ikke kan beregnes en
normaliseret Cq-værdi, vil firkanten være sort med et hvidt X.

Der findes et dendogram på yderkanten af dataplotningen, der angiver klyngehierarkiet. Målsekvenser
(targets) eller prøver, der har ens ekspressionsmønstre, har tilstødende grene, mens dem der har
mønstre, der ikke ligner hinanden, har større afstand mellem dem.

Indstillinger
Du kan indstille følgende:

n Cluster By (Saml i klynger) – vælg mellem Targets (Målsekvenser), Samples (Prøver), Both
(Begge) eller None (Ingen).

n Size (Størrelse) – justerer billedstørrelsen og ændrer forstørrelsesgraden for diagrammet.

n Split Out Replicates (Opdel replikater) – viser værdier for hvert af de individuelle replikater.

Tip: Du kan ændre farveskemaet for klyngeoversigt og punktdiagram fra standardindstillingen rød/grøn
til rød/blå ved at vælge dette genvejsmenupunkt på et af disse diagrammer.

Genvejsmenupunkter
Genvejsmenupunkterne for klyngeoversigten er de samme som for søjlediagrammerne. Se Tabel 34
på side 236 for de tilgængelige valgmuligheder. Desuden er det muligt at vælge Color Scheme
(Farveskema) for at ændre den nedregulerede ekspression fra standardindstillingen rød/grøn til
rød/blå på diagrammet.
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Dataregneark
Regnearket viser værdier for målsekvens (target), prøve og normaliseret ekspression. Klik på
afkrydsningsfeltet ud for en målsekvens (target) for at medtage eller udelade det i plottet.
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Punktdiagram

Punktdiagram
Punktdiagrammet viser den normaliserede ekspression af målsekvenser (targets) for en kontrol kontra en
eksperimentel prøve. Linjerne i plottet indikerer reguleringstærsklen. Datapunkter mellem linjerne indikerer,
at differencen i ekspression for målsekvensen (target) (genet) er ubetydelig mellem prøverne. Datapunkter
uden for linjerne overskrider reguleringstærsklen og kan være interessante.

Plotbilledet viser følgende ændringer i ekspression af målsekvensen (target) baseret på
reguleringstærsklen:

n Opregulering (rød cirkel) – relativt højere ekspression

n Nedregulering (grøn eller blå cirkel) – relativt lavere ekspression

n Ingen ændring (sort cirkel)

Klik og træk i tærskellinjen for at justere værdien for reguleringstærsklen.

Indstillinger
Du kan indstille følgende:

n Control Sample (Kontrolprøve)

n Experimental Sample (Eksperimentel prøve)

n Regulation Threshold (Reguleringstærskel). Når værdien for regulering forøges eller
formindskes, flytter tærskellinjerne i plottet sig tilsvarende.

Genvejsmenupunkter
Genvejsmenupunkterne for punktdiagrammer er de samme som for søjlediagrammet. Se Tabel 34 på
side 236 for de tilgængelige valgmuligheder. Vælg desuden Symbol for at ændre det symbol, der
anvendes i plottet fra standardcirklen til et af følgende:

n Triangle (Trekant)

n Cross (Kryds)

n Square (Firkant)

n Diamond (Rombe)
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Dataregneark
Regnearket viser værdierne for målsekvensen (target) og normaliseret ekspression for kontrol og
eksperimentelle prøver. Det angiver også, ommålsekvenser (targets) er op- eller nedregulerede,
sammenlignet med reguleringstærsklen. Klik på afkrydsningsfeltet ud for en målsekvens (target) for at
medtage eller udelade den i plottet.
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Resultater

Resultater
Fanen Results (Resultater) indeholder et regneark, som giver en oversigt over data fra alle
diagrammerne. Tabel 37 definerer de data, der vises i regnearket Results (Resultater).

Oplysninger Beskrivelse

Target (Målsekvens) Navnet på målsekvensen (target) (amplificeret gen)

Sample (Prøve) Prøvens navn

Mean Cq (Middelværdi for Cq) Middelværdien for kvantifikationscyklussen

Mean Efficiency Corrected Cq
(Middelværdi for
effektivitetskorrigeret Cq)

Middelværdien for kvantifikationscyklussen efter justering af
reaktionseffektivitet

Normalized Expression
(Normaliseret ekspression)

Ekspression af målsekvens (target) normaliseret til en
referencemålsekvens (target) (ΔΔCq)

Relative Normalized Expression
(Relativ normaliseret
ekspression)

Normaliseret ekspression i forhold til en kontrolprøve, også kaldet
Fold Change (Foldændring)

Regulation (Regulering) Ændring i ekspressionen i forhold til en kontrolprøve

Compared to Regulation
Threshold (Sammenlignet med
reguleringstærskel)

Op- eller nedregulering af en eksperimentel prøve baseret på
tærskelindstillingen

Tabel 37. Oplysninger på fanen Results (Resultater)

Bemærk: Data for replikater findes kun i regnearket på dataanalysefanerne, for hvilke Split Out
Replicates (Opdel replikater) er markeret (dvs. Clustergram (Klyngeoversigt)). Der kan være
uoverensstemmelser i ekspressionsdata i genekspressionsanalyseregnearkene, hvis “none”
(ingen) vælges som kontrolprøve på søjlediagrammet.
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Genstudie
Opret et genstudie for at sammenligne genekspressionsdata fra et eller flere real-time PCR-
eksperimenter ved brug af en kalibrator mellem kørsler for at normalisere eksperimenterne i forhold til
hinanden. Opret et genstudie ved at tilføje data fra en eller flere datafiler (.pcrd-filtypenavn) til
genstudiet. Softwaren grupperer dem i en enkelt fil (.mgxd-filtypenavn).

Bemærk: Det maksimale antal prøver, som kan analyseres i et genstudie, er begrænset af
computerens RAM-størrelse og virtuelle hukommelse.

Kalibrering mellem kørsler
Kalibreringer mellem kørsler forsøges kørt automatisk i hvert enkelt genstudie for hver enkelt
målsekvens (target) med henblik på normalisering af variationer mellem kørsler mellem målsekvens
er(targets), der analyseres i separate real-time PCR-kørsler (dvs. forskellige .pcrd-filer, der genereres
fra forskellige plader).

For at softwaren skal kunne genkende en prøve som en kalibrator mellem kørsler skal den have
samme navn på målsekvens (target), prøvenavn og, hvis det anvendes, navn på biologisk sæt på alle
plader, der sammenlignes.

Bemærk: Genstudiet skal indeholde mindst én kalibratorprøve, der kan bruges til at udføre
kalibrering mellem kørsler. Målsekvenser (targets) uden relevante kalibratorprøver behandles
uden korrektion i genstudiet (anbefales ikke).

Kalibratorer mellem kørsler kan anvendes på to måder:

n Per target (Pr. målsekvens) – forskellige PCR-primere kan have forskellige effektiviteter. Som
standard anvendes kalibratoren mellem kørsler på alle brønde på samme plade, som har samme
navn på målsekvens (target), for eksempel Cq genereret med samme analyse.

n Entire study (Hele studiet) – brugeren vælger én kalibrator mellem kørsler, som anvendes på hele
genstudiet.

Dialogboksen Gene Study (Genstudie)
Dialogboksen Gene Study (Genstudie) indeholder to faner:

n Fanen Study Setup (Studieopsætning) – administrerer kørslerne i genstudiet.

Vigtigt: Dataene i den oprindelige fil bliver ikke ændret af, at der tilføjes eller fjernes datafiler
fra genstudiet.

n Fanen Study Analysis (Studieanalyse) – viser genekspressionsdataene for de kombinerede
kørsler.
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Genstudie

Fanen Study Setup (Studieopsætning)
Tabel 38 definerer de data, som vises på fanen Study Setup (Studieopsætning).

Kolonnetitel Beskrivelse

File Name (Filnavn) Navn på kørselsdatafilen (.pcrd-filtypenavn)

File Folder (Filmappe) Mappe som lagrer datafilen for hver kørsel i genstudiet

Date Created (Dato for
oprettelse)

Dato hvor kørselsdataene blev indsamlet

Well Group Name
(Brøndgruppenavn)

Navn på den brøndgruppe, som blev valgt, da filen blev tilføjet til
genstudiet

Tip: For at analysere én brøndgruppe i genstudiet skal du vælge
den pågældende brøndgruppe i vinduet Data Analysis
(Dataanalyse), inden dataene importeres til genstudiet.

Step (Trin) Protokoltrin som omfatter den plade, der blev læst for at indsamle real-
time PCR-data

Run Type (Kørselstype) Enten brugerdefineret eller PrimePCR™ kørsel

Protocol Edited (Protokol
redigeret)

Angiver, hvis det er valgt, at protokollen, der blev brugt til en
PrimePCR-kørsel, blev redigeret

View Plate (Vis plade) Åbner et pladekort over pladen med dataene i hver af de kørsler, som
er medtaget i genstudiet

Tabel 38. Fanen Study Setup (Studieopsætning) i dialogboksen Gene Study (Genstudie)

Klargøring af et genstudie
Sådan klargøres et genstudie

1. Før du importerer data til et genstudie, skal følgende udføres i vinduet Data Analysis
(Dataanalyse):

n Kontrollér, at prøver med samme indhold har samme navn. I et genstudie forudsætter
softwaren, at brønde med samme Target Name (Navn på målsekvens) eller Sample Name
(Prøvenavn) indeholder de samme prøver.

n Tilpas baseline og tærskel (Cq) på fanen Quantification (Kvantifikation) for at optimere
dataene i hver kørsel.

n Vælg den brøndgruppe, der skal medtages i genstudiet.
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For at få vist data fra én brøndgruppe i genstudiet, skal den relevante gruppe vælges, før
datafilen importeres.

Fanen Study Setup (Studieopsætning) viser en liste over alle kørslerne i genstudiet.

2. Vælg fanen Study Setup (Studieopsætning) i dialogboksen Gene Study (Genstudie).

3. Klik på Add Data Files (Tilføj datafiler) for at vælge en fil fra et browservindue.

Tip: For hurtigt at tilføje kørsler i et genstudie skal du trække datafilerne (med filtypenavnet
.pcrd) til dialogboksen Study Setup (Studieopsætning).

4. CFX Manager Dx software udfører automatisk genstudieanalysen, når du tilføjer datafiler. Vælg
fanen Study Analysis (Studieanalyse) for at se resultaterne.

Sådan fjernes kørsler fra genstudiet

u Vælg én eller flere filer på listen, og klik på Remove (Fjern).

Sådan tilføjes bemærkninger om genstudiet

u Skriv bemærkninger om filer og analyser i tekstboksen Notes (Bemærkninger).

Fanen Study Analysis (Studieanalyse)
Fanen Study Analysis (Studieanalyse) viser data fra alle kørslerne i genstudiet. Valgmulighederne for
dataanalyse i forbindelse med genekspression er de samme som dem, der gælder for en enkelt
datafil, med følgende undtagelse:

n For søjlediagrammer vises kalibreringsværdierne mellem kørsler (hvis de beregnes), når der
klikkes på Inter-run Calibration (Kalibrering mellem kørsler).

Bemærk: Det er kun følgende prøvetyper, der kan anvendes som kalibrator mellem kørsler:

o Unknown (Ukendt)

o Standard

o Positive Control (Positiv kontrol)

Prøvetyperne Negative control (Negativ kontrol), NTC (ingen skabelonkontrol) og NRT (ingen
revers transkriptasekontrol) kan ikke anvendes som kalibrator mellem kørsler.
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Genstudie

Oprettelse af en genstudierapport
Sådan oprettes en genstudierapport

1. Tilpas genstudierapportens data og diagrammer efter behov, inden rapporten oprettes.

2. Vælg Tools > Reports (Værktøjer > Rapporter) i menuen Gene Study (Genstudie) for at åbne
dialogboksen Report (Rapport).

3. Vælg, hvad der skal medtages i rapporten. Rapporten åbnes med standardvalgmulighederne
valgt. Markér eller fjern markering i afkrydsningsfelterne for at ændre hele kategorier eller
individuelle valgmuligheder i en kategori.

Kategorier af genstudierapporter på side 249 angiver de tilgængelige valgmuligheder for visning.

4. Ændring af rækkefølgen af kategorier og elementer i en rapport. Træk valgmulighederne til den
ønskede position. Elementers rækkefølge kan kun ændres i den kategori, de tilhører.

5. Klik på Update Report (Opdater rapport) for at opdatere Report Preview (Vis rapport) med
eventuelle ændringer.

6. Udskriv eller gem rapporten. Klik på knappen Print Report (Udskriv rapport) i værktøjslinjen for at
udskrive den aktuelle rapport. Vælg File > Save (Fil > Gem) for at gemme rapporten i et af
formaterne PDF (Adobe Acrobat Reader)-fil og vælg en placering, hvor filen skal gemmes. Vælg
File > Save As (Fil > Gem som) for at gemme rapporten med et nyt navn eller på en ny placering.

7. (Valgfrit) Opret en skabelonrapport med den information, du ønsker. For at gemme de aktuelle
rapportindstillinger i en skabelon skal du vælge Template > Save (Skabelon > Gem) eller Save As
(Gem som). Indlæs rapportskabelonen, næste gang der skal oprettes en ny rapport.

Kategorier af genstudierapporter
Brug dialogboksen Gene Study Report (Genstudierapport) til at arrangere data fra et genstudie i en
rapport. Tabel 39 indeholder en liste over alle de tilgængelige valgmuligheder for en genstudierapport.

Kategori Valgmulighed Beskrivelse

Sidehoved

Rapportens titel, undertitel og logo

Report Information
(Rapportoplysninger)

Dato, brugernavn, datafilens navn, sti til datafilen
og den valgte brøndgruppe

Tabel 39. Kategorier til brug i genstudierapporter
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Kategori Valgmulighed Beskrivelse

Gene Study File List (Liste
over filer til genstudiet)

Liste over alle datafiler i genstudiet

Notes (Bemærkninger) Bemærkninger til datarapporten

Study Analysis (Studieanalyse): Bar Chart (Søjlediagram)

Analysis Settings
(Analyseindstillinger)

Liste over de valgte analyseparametre

Chart (Diagram) Genekspressionssøjlediagram, der viser
dataene

Target Names (Navne på
målsekvenser)

Liste over målsekvenserne (targets) i genstudiet

Sample Names
(Prøvenavne)

Liste over prøverne i genstudiet

Data Regneark, der viser dataene

Target Stability
(Målsekvensens stabilitet)

Stabilitetsdata for målsekvens (target)

Inter-run Calibration
(Kalibrering mellem
kørsler)

Data vedr. kalibrering mellem kørsler

Study Analysis (Studieanalyse): Clustergram (Klyngeoversigt) og Scatter Plot
(Punktdiagram)

Analysis Settings
(Analyseindstillinger)

Indstillinger for hver diagramtype

Chart (Diagram) Genekspressionsdiagram, der viser dataene

Data Regneark, der oplister data i hver målsekvens
(target)

Tabel 39. Kategorier til brug i genstudierapporter, fortsat
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Appendiks A Dataanalyseberegninger
CFXManager™ Dx softwaren beregner formler automatisk og viser resultaterne på fanerne Data
Analysis (Dataanalyse). Dette appendiks forklarer i detaljer, hvordan CFX Manager Dx softwaren
beregner formlerne.

Reaktionseffektivitet
Evidens tyder på, at brug af en nøjagtig måling af effektivitet for hver primer og probe vil give mere
nøjagtige resultater, når genekspressionsdata analyseres. Standardværdien for effektivitet anvendt i
beregninger af genekspression er 100 %. For at evaluere reaktionseffektiviteten skal der genereres en
standardkurve ved brug af serielle fortyndinger af en repræsentativ prøve over et relevant dynamisk
område, hvorefter effektiviteten for efterfølgende genekspressionsanalyse registreres. Hvis kørslen
omfatter en standardkurve, beregner softwaren automatisk effektiviteten og viser den under Standard
Curve (Standardkurve) på fanen Quantification (Kvantifikation), når Auto Efficiency (Automatisk
effektivitet) er markeret på fanen Targets (Målsekvenser) i vinduet Experiment Settings
(Eksperimentindstillinger).

Effektiviteten (E) i effektivitetsformlen henviser til “effektiviteter” som beskrevet af Pfaffl (2001) og
Vandesompele et al. (2002). I disse publikationer svarer en effektivitet på 2 (perfekt fordobling for hver
cyklus) til 100 % effektivitet i denne software. Du kan vælge at konvertere effektivitetsberegningerne til
dem, der anvendes i softwaren, ved at anvende følgende matematiske forhold:

n E = (% effektivitet * 0,01) + 1

n % effektivitet = (E – 1) * 100

Relativ mængde
Formlen for relativ mængde (ΔCq) for enhver prøve (GOI) er:

Bemærk: Denne formel anvendes til at beregne den relative mængde, når der ikke er nogen
defineret kontrolprøve .
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Hvor:

n E = Effektivitet af primer og probesæt. Denne effektivitet beregnes med formlen
(% effektivitet * 0,01) + 1, hvor 100 % effektivitet = 2

n C q (min) = gennemsnitlig Cq for prøven med det laveste gennemsnitlige Cq for GOI

n C q (sample) = gennemsnitligt Cq for prøven

n GOI = Interessegen (én målsekvens (target))

Relativ mængde når der er valgt en kontrol
Når der tildeles en kontrolprøve, beregnes den relative mængde (RQ) for enhver prøve med et
interessegen (GOI) med denne formel:

Hvor:

n E = Effektivitet af primer og probesæt. Denne effektivitet beregnes med formlen
(% effektivitet * 0,01) + 1, hvor 100 % effektivitet = 2

n Cq (control) = gennemsnitligt Cq for kontrolprøven

n Cq (sample) = gennemsnitligt Cq for alle prøver med et GOI

n GOI = Interessegen (én målsekvens (target))

Standardafvigelse for relativ mængde
Formlen for standardafvigelse for relativ mængde er

Hvor:

n SD Relative Quantity = Standardafvigelse for relativ mængde

n SD CqGOI prøve = Standardafvigelse for Cq for prøven (GOI)

n Relative Quantity = Relativ mængde af prøven

n E = Effektivitet af primer og probesæt. Denne effektivitet beregnes med formlen
(% effektivitet * 0,01) + 1, hvor 100 % effektivitet = 2

n GOI = Interessegen (én målsekvens (target))
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Effektivitetskorrigeret Cq (CqE)

Effektivitetskorrigeret Cq (CqE)
Formlen for effektivitetskorrigeret Cq er

Hvor:

n E = Effektivitet

Middelværdi for effektivitetskorrigeret Cq (MCqE)
Formlen for middelværdi for effektivitetskorrigeret Cq er

Hvor:

n CqE = effektivitetskorrigeret Cq

n n = Antallet af replikater

Normaliseringsfaktor
Nævneren i ligningen for normaliseret ekspression omtales som normaliseringsfaktoren.
Normaliseringsfaktoren er den geometriske middelværdi af de relative mængder af alle
referencemålsekvenser (targets) (gener) for en given prøve, som beskrevet i denne formel:

Hvor:

n RQ = Relativ mængde

n n = Antallet af referencemålsekvenser (targets)

n GOI = Interessegen (én målsekvens (target))
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Normaliseret ekspression
Normaliseret ekspression (ΔΔCq) er den relative mængde af målsekvensen (target) (genet)
normaliseret til mængderne af referencemålsekvenserne (gener eller sekvenser) i det biologiske
system. For at vælge referencemålsekvenser (targets) skal du åbne vinduet Experiment Settings
(Eksperimentindstillinger) og klikke på referencekolonnen for hver målsekvens (target), som tjener
som et referencegen.

Formlen for normaliseret ekspression, som bruger den beregnede relative mængde (RQ), er

Hvor:

n RQ = Relativ mængde af en prøve

n Ref = Referencemålsekvens (target) i en kørsel, som omfatter en eller flere
referencemålsekvenser i hver prøve

n GOI = Interessegen (én målsekvens (target))

Under forudsætning af at referencemålsekvenserne (targets) ikke ændrer deres
ekspressionsniveauer i det biologiske system, tager beregningen af normaliseret ekspression højde
for isætningsforskelle eller variationer i celletal, der måtte forekomme i prøverne.

Normaliseret ekspression når der er valgt en kontrol
Når du vælger en kontrolprøve i vinduet Experiment Settings (Eksperimentindstillinger), indstiller
softwaren ekspressionsniveauet for kontrolprøven til 1. I denne situation normaliserer softwaren de
relative mængder for al ekspression af målsekvens (target) (gen) til kontrolmængden (en værdi på 1).
Denne normaliserede ekspression svarer til den ikke-skalerede normaliserede ekspressionsanalyse,
når der er valgt en kontrol.

Bemærk: Dette kaldes også relativ normaliseret ekspression (RNE) og foldændring.
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Standardafvigelse for normaliseret ekspression
Genskalering af værdien for normaliseret ekspression sker ved at dividere standardafvigelsen for den
normaliserede ekspression med den normaliserede ekspresionsværdi for det højeste eller laveste
individuelle ekspressionsniveau, afhængigt af den valgte skalering. Formlen for standardafvigelse
(SD) for normaliseringsfaktoren er

Hvor:

n RQ = Relativ mængde af en prøve

n SD = Standardafvigelse

n NF = Normaliseringsfaktor

n Ref = Referencemålsekvens (target)

n n = Antallet af referencemålsekvenser (targets)

Når en kontrolprøve tildeles, er det ikke nødvendigt at køre denne genskaleringsfunktion på
standardafvigelsen, som vist i nedenstående formel:

Hvor:

n NE = Normaliseret ekspression

n RQ = Relativ mængde af en prøve

n SD = Standardafvigelse

n GOI = Interessegen (én målsekvens (target))
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Normaliseret ekspression skaleret til højeste
ekspressionsniveau

Når kørslen ikke omfatter kontroller, skaleres den normaliserede ekspression (NE) for hver
målsekvens (target) (gen) ved at dividere ekspressionsniveauet for hver prøve med det højeste
ekspressionsniveau i alle prøverne. Softwaren indstiller det højeste ekspressionsniveau til en værdi
på 1 og omskalerer alle prøveekspressionsniveauerne. Formlen for højeste skalering er

Hvor:

n GOI = Interessegen (målsekvens (target))

Normaliseret ekspression skaleret til laveste
ekspressionsniveau

Når kørslen ikke omfatter kontroller, skaleres den normaliserede ekspression (NE) for hver
målsekvens (target) (gen) ved at dividere ekspressionsniveauet for hver prøve med det laveste
ekspressionsniveau i alle prøverne. Softwaren indstiller det laveste ekspressionsniveau til en værdi
på 1 og omskalerer alle prøveekspressionsniveauerne. Formlen for den laveste skalering er

Hvor:

n GOI = Interessegen (målsekvens (target))
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Normaliseret ekspression skaleret til gennemsnitligt
ekspressionsniveau

Når kørslen ikke omfatter kontroller, skaleres den normaliserede ekspression (NE) for hver
målsekvens (target) (gen) ved at dividere ekspressionsniveauet for hver prøve med geometriske
middelværdi for ekspressionsniveau for alle prøverne. Softwaren indstiller det gennemsnitlige
ekspressionsniveau til en værdi på 1 og omskalerer alle prøveekspressionsniveauerne. Formlen for
gennemsnitlig skalering er

Hvor:

n GOI = Interessegen (målsekvens (target))

n GM = Geometrisk middelværdi for normaliseret ekspression i alle prøver

Driftsvejledning | 257



Appendiks A Dataanalyseberegninger

Standardafvigelse for skaleret normaliseret ekspression
Genskalering af værdien for skaleret normaliseret ekspression (NE) sker ved at dividere
standardafvigelsen (SD) for den normaliserede ekspression med den normaliserede
ekspressionsværdi for det højeste (MAX) eller laveste (MIN) ekspressionsniveau, afhængigt af den
valgte skalering.

Bemærk: Når en kontrolprøve tildeles, er det ikke nødvendigt at køre denne
genskaleringsfunktion på standardafvigelsen.

Beregningen for denne formel er

Hvor:

n NE = Normaliseret ekspression

n SD = Standardafvigelse

n GOI = Interessegen (målsekvens (target))

n MAX = Højeste ekspressionsniveau

n MIN = Laveste ekspressionsniveau

Regulering
Regulering er et mål af stigning eller fald i ekspressionen af en målsekvens (target) for en
eksperimentprøve kontra en kontrolprøve og bestemmes som følger:

Hvis ekspression (eksperimentel) > Ekspression (kontrol):

Hvis ekspression (eksperimentel) < Ekspression (kontrol):

Bemærk: For søjlediagram er ekspression baseret på enten den relative mængde eller
normaliseret ekspression, afhængigt af den valgte tilstand (se Søjlediagram på side 229). For
Scatter Plot (Punktdiagram) og Clustergram (Klyngeoversigt) beregnes regulering altid fra den
normaliserede ekspression.
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Formler til korrigerede værdier
Der ses kun en forskel mellem de korrigerede værdier og de ikke-korrigerede værdier, hvis
standardkurven oprettes som en del af real-time PCR-kørslen. Softwaren anvender tre ligninger til at
bestemme propageringen af fejl:

n Standardfejl

n Standardfejl for normaliseret ekspression

n Standardfejl for normaliseret interessegen (målsekvens (target))

Formlen for standardfejl er

Hvor:

n n = Antallet af referencemålsekvenser (targets) (gener)

n SD = Standardafvigelse

Formlen for standardfejl for normaliseringsfaktoren i normaliseret ekspression er

Hvor:

n n = Antallet af referencemålsekvenser (targets)

n SE = Standardfejl

n NF = Normaliseringsfaktor

n RQ = Relativ mængde

Formlen for standardfejl for normaliseret interessegen (GOI) er

Hvor:

n SE = Standardfejl

n GOI = Interessegen (en målsekvens (target))

n NF = Normaliseringsfaktor

n n = Antallet af referencemålsekvenser (targets)
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Appendiks B Administration af brugere og roller
på CFX Manager Dx

I CFX Manager™ Dx softwaren er det muligt at oprette brugere og tildele en rolle til de pågældende
brugere. Roller begrænser adgangen til funktionerne i CFX Manager Dx. En bruger kan kun være
tildelt én rolle ad gangen. En CFX Manager Dx softwareadministrator kan imidlertid til enhver tid
ændre brugerens rolle.

Tip: Det er ikke nødvendigt at oprette brugere for at anvende CFX Manager Dx. Hvis der ikke
oprettes brugere, udføres al aktivitet af standardbrugerkontoen admin.

Vigtigt: Brugeren admin er standard-administratorkontoen, som indledningsvist anvendes til at
logge på CFX Manager Dx. Det anbefales, at der oprettes en specifik bruger til administration af
CFX Manager Dx. Tildel den pågældende bruger rollen som Administrator, og udfør alle
administrationsopgaver med denne bruger.

Vigtigt: CFXManager Dx softwaren har ikke en timeout-funktion for inaktivitet. Det anbefales
derfor, at der implementeres sikkerhedsforanstaltninger fra Windows eller tredjepartssoftware
(implementer for eksempel en pauseskærm, der kræver login).

Administration af brugere
I standardudgaven af CFX Manager Dx software kan brugerkonti have et hvilket som helst navn og en
hvilken som helst adgangskode.

For at tildele en rolle til en bruger skal du vælge den på listen over roller i vinduet User Administration
(Brugeradministration). I dette eksempel får brugeren Guest (Gæst) tildelt rettigheden til at gemme
filer.

Tilføjelse og fjernelse af brugere
Bemærk: Kun CFX Manager Dx administratoren kan tilføje eller fjerne brugere.

Sådan tilføjes brugerkonti til CFX Manager Dx

1. Vælg User > User Administration (Bruger > Brugeradministration) i startvinduet.

Dialogboksen User Administration (Brugeradministration) åbner.
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2. Skriv et User Name (Brugernavn) til brugeren i ruden Manage Users (Administrer brugere).

3. Vælg en Role (Rolle) til brugeren.

Roller begrænser brugerens rettigheder. Standardrollen er Principal (Hovedbruger).

Tip: Rettighederne for hver rolle kan ændres. Når rollens rettigheder ændres, påvirker det
alle brugere, som er tildelt den pågældende rolle. Der findes flere oplysninger i
Administration af rettigheder for roller på side 263.

4. (Valgfrit) Skriv brugerens fulde navn og adgangskode.

5. Klik på OK for at åbne en dialogboks og bekræfte, at vinduet skal lukkes.

6. Klik på Yes (Ja) for at lukke dialogboksen og vinduet.

Sådan fjernes en bruger

1. Vælg Remove (Fjern) i ruden Manage Users (Administrer brugere) for hver bruger, som skal
fjernes.

2. Klik på OK for at åbne en dialogboks og bekræfte, at vinduet skal lukkes.

3. Klik på Yes (Ja) for at lukke dialogboksen og vinduet.

Bemærk: Listen over softwarebrugere skal altid omfatte en Administrator.
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Administration af rettigheder for roller
CFXManager Dx omfatter disse fire roller:

n Administrator (påkrævet) – administratorer har alle rettigheder, og disse rettigheder kan ikke
ændres. Administratorer kan desuden tilføje og fjerne brugere og ændre rettighederne for hver
rolle.

Bemærk: Kun en administrator kan ændre rettighederne for en rolle.

n Principal (Hovedbruger) – hovedbrugeren har som standard alle rettigheder

n Operator (Operatør) – operatøren har som standard alle rettigheder undtagen overspringning af
cyklusser

n Guest (Gæst) – gæstebrugeren kan som standard udelukkende læse filer

Vigtigt:Ændring af rettighederne for en rolle påvirker alle brugere, som er tildelt den pågældende
rolle. Du kan ikke tilpasse en rolle til en specifik bruger. Vær forsigtig, når du ændrer rettigheder
for roller.

Sådan angives rettighederne for hver rolle

1. Vælg User > User Administration (Bruger > Brugeradministration) i startvinduet.

2. Gør et af følgende i ruden Manage Rights (Administrer rettigheder):

n For at fjerne en rettighed fra en rolle skal du fjerne markeringen i det tilhørende
afkrydsningsfelt.

n For at tilføje en rettighed til en rolle skal du markere det tilhørende afkrydsningsfelt.

3. Klik på OK for at åbne en dialogboks og bekræfte, at vinduet skal lukkes.

4. Klik på Yes (Ja) for at lukke dialogboksen og vinduet.

Sådan nulstilles alle rettigheder for alle roller

u Klik på Restore Default Rights (Gendan standardrettigheder) i dialogboksen User Administration
(Brugeradministration).
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Indlogning på CFX Manager Dx softwaren
CFXManager Dx softwaren styrer, hvem der kan logge ind på softwaren, ved hjælp af dialogboksen
Login. Når softwaren startes, viser CFX Manager Dx automatisk dialogboksen Login, hvis der findes to
eller flere brugere på listen i vinduet User Administration (Brugeradministration).

CFX Manager Dx viser navnet på den bruger, der er logget på, øverst i startvinduet.

Sådan logges der på CFX Manager Dx

1. Vælg dit navn på rullelisten User Name (Brugernavn) i dialogboksen Login.

2. Indtast din adgangskode.

3. Klik på OK for at lukke dialogboksen Login og åbne softwaren.

Skift af bruger
Du kan skifte bruger, mens softwaren kører.

Sådan skiftes der bruger

1. Vælg User > Select User (Bruger > Vælg bruger) i startvinduet for at åbne dialogboksen Login.

2. Vælg et navn fra rullelisten User Name (Brugernavn).

3. Indtast den nye brugers adgangskode.

4. Klik på OK for at lukke dialogboksen Login og åbne softwaren.
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Ændring af brugeradgangskoder
Brugere af CFX Manager Dx kan når som helst ændre deres egen adgangskode.

Sådan ændres brugeradgangskoder

1. Vælg User > Change Password (Bruger > Skift adgangskode) i startvinduet for at åbne
dialogboksen Change Password (Skift adgangskode).

2. Skriv din nuværende adgangskode i feltet Old Password (Gammel adgangskode).

3. Skriv en ny adgangskode i New Password (Ny adgangskode), og indtast den igen i Confirm New
Password (Bekræft ny adgangskode).

4. Klik på OK for at bekræfte ændringen.

Visning af roller og rettigheder
Tip: Brugere, som er tildelt brugerrollerne Principal (Hovedbruger), Operator (Operatør) eller
Guest (Gæst), kan kun se deres egne brugerindstillinger, rettigheder og roller.

Sådan vises den aktuelle brugerrolle og de aktuelle rettigheder

u Vælg User > User Administration (Bruger > Brugeradministration) i startvinduet.

Kontakt CFX Manager Dx administratoren for at modificere de brugerindstillinger, -rettigheder og -
roller, som er angivet i vinduet User Administration (Brugeradministration).
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Appendiks C LIMS-integration
CFXManager™ Dx softwaren kan konfigureres til brug med et laboratorieinformationsstyringssystem
(LIMS). LIMS-integration kræver CFX Manager Dx pladeopsætningsoplysninger genereret af LIMS-
platformen (en LIMS-fil, *.plrn), en protokolfil oprettet ved brug af CFX Manager Dx software (*.prcl),
en defineret dataeksportdestination samt et defineret eksportformat.

Når kørslen er afsluttet, genererer CFX Manager Dx en datafil (.pcrd) og gemmer den på en defineret
mappeplacering til dataeksport. CFX Manager Dx kan desuden oprette en LIMS-kompatibel datafil i
.csv-format og gemme den på den samme placering.

Oprettelse af LIMS-kompatible datafiler
Dette appendiks indeholder oplysninger om installation af CFX Manager Dx softwaren til oprettelse,
lagring og eksport af LIMS-kompatible datafiler.

Opsætning af valgmuligheder for LIMS-mappen og for
dataeksport
Som standard gemmer CFX Manager Dx LIMS-protokollerne, -filerne og -dataeksportfilerne i denne
mappe:
_ C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Du kan konfigurere CFX Manager Dx til at gemme filerne i en anden mappe, og du kan ændre
eksportindstillingerne for LIMS-data.

Sådan opsættes en LIMS-mappe og valgmuligheder for dataeksport

1. Vælg Tools > Options (Værktøjer > Valgmuligheder) i startvinduet.

2. I dialogboksen Options (Valgmuligheder) skal du vælge Data Export Settings (Indstillinger for
dataeksport).
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3. (Valgfrit) Vælg Automatically export LIMS data at end of run (Eksportér LIMS-data automatisk ved
afslutning af kørslen).

Softwaren eksporter automatisk LIMS-data efter hver kørsel og gemmer dem på den
specificerede placering.

4. For at ændre standardindstillingerne for eksport af LIMS-data skal du klikke på LIMS Data Export
Settings (Indstillinger for eksport af LIMS-data).

Vigtigt: Det er kun LIMS-data, der er eksporteret som en .csv-fil, der kan importeres tilbage i
CFX Manager Dx.

5. I dialogboksen LIMS Data Export Format Settings (Indstillinger for eksportformat for LIMS-data)
skal du vælge de ønskede eksportindstillinger og klikke på OK.

6. I dialogboksen Options (Valgmuligheder) skal du navigere til og vælge en standardmappe, hvor
LIMS-datafilerne skal gemmes. Du kan vælge en forskellig placering for hver filtype:

n Protocol (Protokol)

n LIMS file (LIMS-fil)

n Data export (Dataeksport)

7. Klik på OK for at gemmeændringerne og lukke dialogboksen Options (Valgmuligheder).

Oprettelse af en LIMS-protokol
For at starte en LIMS-kørsel skal du oprette en CFX Manager Dx protokolfil (*.prcl) og gemme den i
LIMS-protokolmappen.

Se Kapitel 6, Oprettelse af protokoller for yderligere oplysninger.
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Oprettelse af en LIMS-fil
En LIMS-fil (*.plrn) indeholder detaljerede oplysninger om opsætning af pladen og protokollens
filnavn. Filen genereres af det interne LIMS. CFX Manager Dx bruger LIMS-filen til at oprette en
pladefil til brug med en protokolfil.

CFX Manager Dx har skabelonfiler til pladeimport, der kan redigeres for at oprette tilpassede LIMS-
pladefiler.

Tip: Denne opgave skal udføres af en LIMS-specialist.

Sådan oprettes en LIMS-fil

1. I startvinduet skal du vælge View > Show > LIMS File Folder (Vis > Vis > LIMS-filmappe).

2. Åbn LIMS-skabelonmappen, og vælg en .cvs-fil, der skal importeres til det interne LIMS.

3. Rediger skabelonfilen i LIMS ved at udfylde de påkrævede felter i Tabel 40.

4. Gem skabelonen med filtypenavnet .plrn i LIMS-filmappen.

Vigtigt: CFXManager Dx kan kun åbne .plrn-filen. Du skal gemme .csv-filen som .plrn, før
du kan starte LIMS-kørslen.

Kolonne Række Beskrivelse Indhold Formål

A 1 Plate Header
(Pladetitel)

Må ikke redigeres Foruddefineret

A,B,C 2 Field/Data/Instruction
(Felt/data/instruktion)

Må ikke redigeres Foruddefineret

B 3 Version Må ikke redigeres Foruddefineret

Tabel 40. Definition indholdet i LIMS .csv-filen
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Kolonne Række Beskrivelse Indhold Formål

B 4 Plate Size
(Pladestørrelse)

Må ikke redigeres Foruddefineret

B 5 Plate Type (Pladetype) Indtast “BRWhite”
(BR hvid), “BR Clear”
(BR klar) eller anden
kalibreret pladetype

Påkrævet

B 6 Scan Mode
(Scanningstilstand)

Indtast “SYBR/FAM
Only:” (Kun
SYBR/FAM:), “All
Channels” (Alle
kanaler) eller “FRET”

Påkrævet

Tabel 40. Definition indholdet i LIMS .csv-filen, fortsat
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Kolonne Række Beskrivelse Indhold Formål

B 7 Units (Enheder) Indtast et af følgende:
“copy number”
(kopinummer), “fold
dilution” (fold-
fortynding),
“micromoles”
(mikromol),
“nanomoles”
(nanomol),
“picomoles” (pikomol),
“femtomoles”
(femtomol),
“attomoles” (attomol),
“milligrams”
(milligram),
“micrograms”
(mikrogram),
“nanograms”
(nanogram),
“picograms”
(pikogram),
“femtograms”
(femtogram),
“attograms” (attogram)
eller “percent”
(procent)

Påkrævet

B 8 Run ID (Kørsels-id) Indtast en kort
beskrivelse, eller
indlæs en stregkode,
der identificerer denne
kørsel (maks. 30 tegn;
kommaer er ikke
tilladt)

Valgfrit

B 9 Run Note
(Kørselsbemærkning)

Indtast beskrivelsen af
kørslen

Valgfrit

Tabel 40. Definition indholdet i LIMS .csv-filen, fortsat
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Kolonne Række Beskrivelse Indhold Formål

B 10 Run Protocol
(Kørselsprotokol)

Indtast protokollens
filnavn, nøjagtigt som
angivet.

Påkrævet

A 11 Data File (Datafil) Indtast datafilens navn Valgfrit

A 12-15 TBD/Empty (Til
fremtidig brug/tom)

Må ikke redigeres Foruddefineret

A 16 Plate Data (Pladedata) Må ikke redigeres Foruddefineret

A 17-113 Well Position
(Brøndposition)

Må ikke redigeres Foruddefineret

B-G Ch1 Dye (Kanal 1-
farve), Ch2 Dye (Kanal
2-farve), Ch3 Dye
(Kanal 3-farve), Ch4
Dye (Kanal 4-farve),
Ch5 Dye (Kanal 5-
farve), FRET

Indtast et kalibreret
farvenavn (for
eksempel "FAM") for
hver kanal, der er i
brug

Påkrævet

H Sample Type
(Prøvetype)

Indtast et af de
følgende prøvetyper:
“Unknown” (Ukendt),
“Standard”, “Positive
Control” (Positiv
kontrol), “Negative
Control” (Negativ
kontrol), “NTC” eller
“NRT”

Påkrævet

I Sample Name
(Prøvenavn)

Indtast prøvenavn Valgfrit

Tabel 40. Definition indholdet i LIMS .csv-filen, fortsat
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Kolonne Række Beskrivelse Indhold Formål

J-O CH1 Target (Kanal 1-
målsekvens), CH2
Target (Kanal 2-
målsekvens), CH3
Target (Kanal 3-
målsekvens), CH4
Target (Kanal 4-
målsekvens), CH5
Target (Kanal 5-
målsekvens), FRET
Target (FRET-
målsekvens)

Indtast navnet på
målsekvensen (target)
for hver kanal, der er i
brug

Valgfrit

P Biological Set Name
(Navn på biologisk sæt)

Indtast navnet på det
biologiske sæt

Valgfrit

Q Replicate (Replikat) Indtast et positivt
heltal for hvert sæt
replikater. Værdien
må ikke være nul.

Valgfrit

R-W CH1 Quantity (Kanal 1-
mængde), CH2
Quantity (Kanal 2-
mængde), CH3
Quantity (Kanal 3-
mængde), CH4
Quantity (Kanal 4-
mængde), CH5
Quantity (Kanal 5-
mængde), FRET
Quantity (FRET
kvantitet)

Indtast
mængdeværdier for
eventuelle standarder.
Indtast koncentration i
decimalformat.

Påkrævet for alle
standarder

X Well Note
(Brøndbemærkning)

Indtast en
brøndbemærkning
(maks. 20 tegn)

Valgfrit

Tabel 40. Definition indholdet i LIMS .csv-filen, fortsat
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Kolonne Række Beskrivelse Indhold Formål

Y-AD Ch1Well Color (Kanal
1-brøndfarve), Ch2
Well Color (Kanal 2-
brøndfarve), Ch3Well
Color (Kanal 3-
brøndfarve), Ch4Well
Color (Kanal 4-
brøndfarve), Ch5Well
Color (Kanal 5-
brøndfarve), FRET
Well Color (FRET-
brøndfarve)

Indtast en
brugerdefineret farve
for kurvelinjelayout i et
32 bit (argb)
heltalsdecimalformat

Valgfrit

Tabel 40. Definition indholdet i LIMS .csv-filen, fortsat

Start af en LIMS-kørsel
Sådan startes en LIMS-kørsel

1. Gør et af følgende for at åbne en LIMS .plrn-fil:

n Vælg View > Show > LIMS File Folder (Vis > Vis > LIMS-filmappe) i startvinduet.

n Vælg File > Open > LIMS File (Fil > Åbn > LIMS-fil) i startvinduet, og åbn den ønskede .plrn-
fil.

Filen åbner på fanen Start Run (Start kørsel) i Run Setup wizard (Guiden Kørselsopsætning).
Fanen Start Run (Start kørsel) viser oplysninger om eksperimentet, der skal køres. Den viser
også den eller de tilsluttede instrumentblokke, som eksperimentet kan køres på.

2. Vælg et instrument på fanen Start Run (Start kørsel), og klik på Start Run (Start kørsel).
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Eksport af data til et LIMS
Når kørslen afsluttes, genererer CFX Manager Dx en datafil (.pcrd) og gemmer den på den definerede
mappeplacering til dataeksport.

Sådan eksporteres datafilen til et LIMS

u Åbn .pcrd-filen og vælg Export > Export to LIMS Folder (Eksportér > Eksportér til LIMS-mappe).

Tip: Hvis Automatically Export Data after Run (Eksportér automatisk data efter kørsel) vælges i
LIMS-valgmulighederne, genererer CFX Manager Dx en LIMS-kompatibel datafil i .csv-format og
gemmer den i den sammemappe.
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Appendiks D Fejlfinding af CFX Manager Dx
softwaretilslutningsproblemer

Applikationslogfil
Før start af en ny kørsel initierer CFX96™ og CFX96 DeepWell instrumenter en
selvdiagnosticeringstest for at kontrollere, at kørslen foregår inden for specifikationerne. Resultaterne
af denne softwaretest kan ses i Run Log (Kørselslog) og i Application Log (Applikationslogfil). Hvis du
bemærker et problem i et eller flere eksperimenter, skal du åbne og køre applikationslogfilen for at
finde frem til, hvor problemet er opstået.

CFX Manager™ Dx sporer oplysninger om et instruments tilstand under en kørsel i Application Log
(Applikationslogfil). Brug disse logfiler til at spore hændelser, som opstår på instrumenter og i
softwaren og i forbindelse med fejlfinding.

Sådan åbnes applikationslogfilen

u Vælg View > Application Log (Vis > Applikationslogfil) i startvinduet.
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Fejlfinding
Normalt kan kommunikationsproblemer mellem software og instrument løses ved at genstarte
computeren og systemet. Sørg for at gemme igangværende arbejde, før du genstarter.

Bemærk: Kontrollér, at computeren har tilstrækkeligt med RAM og ledig diskplads. Minimum
RAM er 4 GM, og minimum harddiskplads er 128 GB.

Strømsvigt
Hvis der opstår strømsvigt, lukker instrumentet og computeren ned. Hvis strømsvigtet er kortvarigt,
genoptager instrumentet kørsel af en protokol, men strømsvigtet noteres i applikationslogfilen.
Afhængigt af computerens indstillinger og varigheden af strømsvigtet vil instrumentet og softwaren
forsøge at fortsætte, afhængigt af protokoltrinnet:

n Hvis protokollen er i et trin uden pladeaflæsning, fortsætter protokollen kørslen, så snart
instrumentet igen tilføres strøm.

n Hvis protokollen er i et trin med en pladeaflæsning, venter instrumentet på, at softwaren
genstarter og genoptager kommunikationen for at indsamle dataene. I denne situation fortsætter
protokollen kun, hvis softwaren ikke blev lukket ned af computeren. Protokollen starter igen, når
computeren og softwaren starter igen.

Fjernelse af prøver fra reaktionsmodulet under strømsvigt

Du kan åbne et låst motoriseret låg på et reaktionsmodul for at fjerne dine prøver under et strømsvigt.

Sådan fjernes låsepladen

1. Skub låsearmen ned for at fjerne reaktionsmodulet fra C1000™Dx termocykleren.

2. Stil reaktionsmodulet forsigtigt på et bord eller en bænk.

3. Anbring modulet, så modulets forside går 5 cm ud over kanten.
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4. Brug en svensknøgle til at fjerne de to store skruer under reaktionsmodulets forreste kant (under
knappen til åbning af låget).

Du bør kunne høre låsearmen udløses inde i modulet.

Vigtigt: Undlad at fjerne de to små skruer på modulets forreste kant.

5. Skub låget på reaktionsmodulet op. Bemærk, at låsen (mørk plastik) ikke længere sidder fast.
Fjern prøverne fra blokken.

6. Sæt låsearmen på igen, og fastgør den med store skruer for at samle reaktionsmodulet med låget
åbent.
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Overførsel af filer til CFX Manager Dx computeren
Du kan hente data og logfiler, der findes på instrumentet, og overføre dem til harddisken på en tilsluttet
computer.

Bemærk: Alle filer i real-time-datamappen på instrumentbasen hentes over på computeren.

Sådan hentes filer fra instrumentet

1. Højreklik på det ønskede instrument i ruden Detected Instruments (Registrerede instrumenter) i
startvinduet, og vælg et af følgende:

n Retrieve Log Files (Hent logfiler)

n Retrieve Data Files (Hent datafiler)

2. Vælg en mappeplacering, hvor de hentede filer skal gemmes.

3. Klik på OK.

Manuel installation af CFX Manager Dx softwaren
Sådan installeres CFX Manager Dx software manuelt

1. Om nødvendigt frakobles alle tilsluttede instrumenter fra computeren.

Find og frakobl instrumentets USB-kabel fra CFX Manager Dx computeren. Den ende, der er
tilsluttet til instrumentet, behøver ikke at blive frakoblet.

2. Log på CFX Manager Dx computeren med administratorrettigheder.

3. Indsæt installations-cd'en.

4. Naviger til cd’en i Windows Stifinder, højreklik på cd-ikonet, og vælg Explore (Gennemse) for at
åbne cd-vinduet.

5. Dobbeltklik på mappen CFX_Manager for at åbne mappen, og dobbeltklik derefter på setup.exe
for at starte installationsguiden.

6. Følg instruktionerne i guiden for at installere softwaren, og klik derefter på Finish (Udfør).
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Geninstallation af drivere
Sådan geninstalleres instrumentdriverne

u Vælg Tools > Reinstall Instrument Drivers (Værktøjer > Geninstaller instrumentdrivere) i
startvinduet.

Bemærk: Hvis der er problemer med softwarekommunikationen med et real-time-system, når
driverne er geninstalleret og USB-forbindelsen kontrolleret, skal du kontakte teknisk support hos
Bio-Rad.
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